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‘Pico’ projectors are tiny, but the MobileCinema i70 is tinier still. It’s 8.5cm wide and less than 2cm 
tall, so you can just pop it in a pocket and take it to a friend’s house. It connects to your iPhone via 
Bluetooth, but also has a Mini HDMI port to connect it to your Mac. In fact, thanks to that wireless 

connectivity and its internal battery, it’s both portable and cable-free. And you also get 
surprisingly good sound quality for such a small box. The visuals aren’t cinema quality, but 
the MobileCinema i70 is perfect if you need a mini projector that’s easy to carry around.

 £238  includes MobileCinema i70, HDMI cable, USB cable 
 website aiptek.de  works with iOS 7.1 or higher, OS X 10.10 or higher

MobileCinema i70

 iOpener
Game-changing tech from the world of Apple and beyond

A powerful projector in the palm of your hand

The MobileCinema i70 
is a hugely portable 

projector, so is great for 
office presentations and 

movies with friends.
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 We’ve had another change around 
here on MacFormat, this month. Our 
long-standing Production Editor, Alan 
Stonebridge is off to edit our US sister 
title, Mac|Life, while he’s being 
replaced by Mac|Life’s erstwhile 
Operations Editor, Jo Membery who 
now has to get used to subbing copy 
in UK English instead of US English 
again. So, I’d like to congratulate Al 
on his new editorship and extend a 
big two-gallon hat welcome to Jo!

This issue we take a deep dive into a subject that will be 
top of the list for many Mac users, especially if you’ve got an 
older machine – freeing up space and improving performance. 
We’ll show you all the little tricks you need to know to eke that 
last little bit of power from your processor.

Also this issue, we lift the lid on Apple AirPods and their 
rivals, reveal five unexpected ways that Apple changed the 
world, show you how to protect you home with Apple 
compatible security devices and bring you a great 
selection of tips for macOS Sierra.

Enjoy the issue and I’ll see you again on 9 May for more 
from the exciting world of Apple. It’s about time Apple 
released some new Macs, so here’s hoping…

GrAhAM BArLOW 
Editor-in-chiEf
editor@macformat.com

Jo Membery
Operations Editor 
 Fresh from subbing copy 

on our US title, Mac|Life, 
Jo has to adapt to life 
without apple pie, waffles 
and baseball. We think 
she’ll cope somehow.
 
Alex Blake
Commissioning Editor 
 An office refurb led to 

Alex unearthing an old 
iMac G3 external floppy 
drive. he still can’t believe 
files haven’t always been 
in the cloud.

Paul Blachford
Art Editor 
 Faced with (once again) 

having to photograph 
two objects that were 
completely different sizes 
for this month’s head-to-
head, Paul has decided 
perspective is his friend.

Meet the team

Instagram.com/MacFormatUKtwitter.com/macformat facebook.com/macformat  macformatuk.tumblr.com 
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EditEd by graham barlow 

aPPlE rUmoUr

 Recent patents have revealed that Apple is 
working on a MacBook Pro with a very special 
keyboard. The keyboard is actually a second 
display – just imagine that the current Touch 
Bar has been given growth hormones and 
has taken over the entire keyboard area. 
The second display could then be used as 
a virtual keyboard, sketch pad or simply 
as an extension of the screen. 

Details of the device are buried in the iPad 
Pro’s Smart Keyboard patent application, 
which shows Apple is considering a future 
version of the keyboard with a display 
instead of physical keys. Combined with 
haptic feedback, it could mark the end 
for physical keyboards, as we swap 
clicks for taps on a permanent basis.

8 | maCFormaT
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Apple’s shallow Macbook 
keyboard was divisive, and 
this will be even more so; 

Apple has to get it feeling right!

Paul says…

Virtual Mac 
keyboard
A Macbook Pro with a virtual 
keyboard is on the horizon

1

aPPlE PEN 
 The second display 

could also be used 
with the Apple Pen, 

so that you could 
use the area to jot 

down sketches, 
or create works 
of art and share 
them with ease.

2
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4K iPhoNES 
 Future iPhones could 

support 4K graphics and 
faster gaming with next 
generation PowerVR 
Furian GPU architecture.

rUmoUr
mill

ThE Poll

 Hot on the heels of the 
tech giant’s latest moves…

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

wE aSKEd… What was 
your favourite Apple 
mouse of all time?

iPhoNE EdiTioN
 Rumours are circulating that 

the upcoming iPhone 8 could 
be called the ‘iPhone Edition’, 
and launch well after the 
iPhone 7S and iPhone 7S 
Plus in September.

Magic 
Mouse (all 
models)

Hockey 
Puck

65% 13%

2%20%

2

glaSS layEr
 Imagine a smooth glass 

layer where the keyboard 
used to be, then imagine 

you can use it to display any 
sort of keyboard and you 

see the possibliities.
Mighty 
Mouse

Third 
party

3

haPTiC FEEdbaCK 
 A separate patent has been 
filed for a screen with haptic 
feedback, so the keys could 
vibrate. The lack of physical 
feedback is a drawback of  
current virtual keyboards.

4

virTUal hiSTory
 The idea of a virtual 

keyboard on a Mac is not 
new. It’s been kicking 

around sine 2012 when 
a patent relating to 

it was first filed. 

macoS 11
 We can expect the next 

major version of macOS to 
be announced at WWDC 2017  
on 5 June, but macOS 10.12.4 
should be out any day now.

1

3

4
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 Apple killed off the 
floppy drive in Macs 
with the iMac G3, but 

back in 1984 they were 
all the rage. The 
Macintosh 512K 

nickname: ‘Fat Mac’) 
came with a drive that 

could read 400KB 
floppy disks built in.

Macintosh 512K 
floppy disK 

capacity

launch price 
of Macintosh 

portable

total nuMber 
of apple pippin 
units produced

 Apple’s first battery-
powered portable 

laptop cost a mind-
boggling $7,300 in 

1989, around £11,500 
today. It was powerful, 

but didn’t sell well.

 Considered one of 
Apple’s worst mistakes, 

the Pippin games 
console (made in 

conjuntion with Bandai) 
was limited to a 

production run of just 
100,000 units. There 
were reportedly more 
accessories made for 
it than actual units.

$7,300

100,000

400KB

A
pple is well known for unveiling 
new products at flashy events, but 
it doesn’t always work that way. In 

early March it decided to quietly launch or 
update a number of products with a simple 
change to the Apple Store website.

Perhaps most noteworthy of the changes, 
at least visually, was the introduction of a 
PRODUCT(RED) iPhone 7 and 7 Plus. The 
phones come in a red finish and are available 
with 128GB or 256GB of storage, with prices 
ranging from £699 to £919. A portion of that 
cost will go towards fighting HIV/AIDS in 
Sub-Sarahan Africa.

Out of Air
The iPad range also got an important update. 
The iPad Air 2 has been phased out and 
replaced with a 9.7-inch device simply named 
‘iPad’. This features a brighter Retina display 
and a faster A9 chip (the Air 2 came equipped 
with an A8X chip). It’s also slightly thicker 
and heavier than the Air 2, and also lacks a 
laminated display.

That said, it has seen a price drop, costing 
£339 for a 32GB model and £429 for a 128GB 
version. That makes it the most affordable 
tablet Apple has released to date. Apple also 

unveiled Smart Covers for iPad in charcoal 
grey, white, midnight blue, pink sand and red 
to match the PRODUCT(RED) iPhone, plus 
a range of new iPhone 7, 7 Plus and Apple 
Watch straps in various colours and designs.

Apple hasn’t finished there. The iPhone 
SE has had a noticeable storage bump, with 
options being doubled to 32GB and 128GB, 
costing £379 and £479 respectively. The iPad 
mini 4 now has more capacity (128GB instead 
of 32GB) for the same price as before. Also, 
the iPad mini 2 has now been discontinued.

On the software side of things, Apple 
debuted Clips, a free iOS video creation app. 

This combines video, photos and music and 
‘lets users create animated captions 

and titles using just their voice’. 
There are also filters and various 
effects to create ‘expressive videos’ 

that can be quickly shared to social 
media and video websites.

Finally, Swift Playgrounds, the 
coding app for iPad, now supports five 

extra languages: Simplified Chinese, 
Japanese, French, German and Latin 

American Spanish.

A portion of the profits from the PRODUCT(RED) iPhones 
will go towards fighting HIV/AIDS in Sub-Saharan Africa.

The iPad Air has been 
phased out; in its place 
we have the ‘iPad’ with 
a brighter display and 
faster chip.

10 | MACFORMAT | MAy 2017

New video editing app, boosted 
iPhone SE and changes to Swift 
Playgrounds also released

apple launches red 
iphone, updates ipad



Apps & Games APPLE CORE

EuCLidEAn LAnds 
£2.99

 What do you get 
when you cross a 
beautiful puzzler 

with Medieval myths? You get 
this game, where you rotate 
and twist the world, Rubik's 
cube-style, shifting your hero 
into position to attack. It looks 
gorgeous too – think Hitman 
Go meets Monument Valley. 
Why you need it: Cube-based 
battles never looked so good!
What’s it best for: Casual 
brain-teasing fun.

ThE WiTnEss  
£38.99

 After releasing 
to rave reviews in 
2016, The Witness 

arrives on the Mac. Set on a 
mysterious island, your only 
hope of returning home and 
piecing together your badly 
fractured memories is to solve 
the puzzles dotted around the 
stunningly beautiful world.
Why you need it: Great design 
meet tricky puzzles.
What’s it best for: Making 
you think outside the box.

 Depeche Mode’s 
fourteenth studio 
album is a rabble-

rousing take on the age of 
Trump. From the frustration 
of Going Backwards to the 
despair of album-ending Fail, 
this is an anger-soaked, 
politically-charged record 
for an extraordinary time. 
Why you need it: Hearing 
the band returning to form.
What’s it best for: Raging 
against the state of the world.

 Finder is one of those parts of 
macOS we just live with. It’s not 
amazing, it’s just there. So if you 
want a better file manager, then 

Forklift is definitely worth a look.
For a start, it’s got a dual-pane window 

that makes it far easier and quicker to copy 
files between locations. If the dual-pane look 
isn’t for you, it has single-pane and tabbed 
views as well.

[ M O V I E ]

MOAnA £13.99
 Disney’s visually 

dazzling animation sees 
16-year-old Moana team 
up with demigod Maui 
to save her island home 
and return a mystic relic 
to its rightful owner.

[ P O d c a s t ]

ThE BugLE FREE
 This satirical news 

podcast from Andy 
Zaltzmann has been 
going strong since 
2007. With a “private 
militia” of co-hosts, it’s 
stupefyingly funny.

[ t V  s h O w ]

MARvEL’s iROn 
FisT nETFLix
 Danny Rand returns 

to New York City, using 
his superpowers and 
martial arts mastery 
to defeat the criminals 
bringing the city down.

It’s much more than a Finder alternative, 
though. It lets you connect to FTP, WebDAV 
and other connections, so you can upload files 
to a website or server quickly and easily.

You can mass rename files in one batch, 
and edit the content of text documents 
without opening them. There’s even a menu 
bar icon that lets you quickly drag and drop 
files to upload them to a server. It’s a great 
app that’s quick, simple and powerful.

sPiRiT dEPEChE 
MOdE £9.99
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Forklift 3 $29.95 (about £24)

APPLE 
Tv
 Our top picks 

of what’s worth 
watching and 
playing this month

[ M a c / i O s  a P P ]

[ i O s  G a M E ] [ i t u n E s  s t O r E ][ M a c  G a M E ]

A Finder alternative that does the heavy lifting

APP OF ThE MOnTh



APPLE CORE Facts & figures
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nExT issuE 
1976: We take a look 
at Apple’s first year 
in numbers. 

Apple’s current CEO, Tim Cook, is the company’s sixth 
big boss. But who helped to lay the foundations? We 
look at the numbers behind the numero unos…

Apple’s other CEOs
in nuMBERs

007

 Before taking charge of 
Apple in 1983, John Sculley had 
become Pepsi's youngest ever 
marketing vice-president at 
the age of 30. That marketing 
know-how helped him instantly 
click with Steve Jobs.

 Tim Cook is not one for lie-ins, waking up 
at 3:45am every morning. On the morning 
of Apple's 9th March 2015 event he got up 
at 4:30am, quipping that he had “slept in”.

3:45am

 CEO Michael Spindler 
introduced Japanese 
language support to 
the Macintosh in 1986, 
overseeing explosive 
growth in the country; 
this made it one of only 
two computers to support 
the language in Japan.

1

 Apple's first CEO, Michael 
Scott, was its fifth employee, 

but registered himself as 
employee number seven 

as a joking reference 
to James Bond. 500

 Gil Amelio was the final CEO 
before Steve Jobs' return, lasting 
roughly 500 days. His actions 
arguably saved the company, 
before Jobs ousted him in a 
boardroom coup.

3.5
 Mike Markkula, Apple's second 

CEO, was hands-on with Apple 

engineering. He persuaded 

Steve Wozniak to build a 3.5-inch 

floppy drive into the Apple II to 

differentiate it from its rivals.

2

12 111
210

39
4

57
8

6

198630





Reminiscences 
of macfoRmat
 I bought my first Mac, an SE/30, back in April 

1993 from a man in Orpington. Travelling back 
to Birmingham on the train, clutching my 
precious cargo, I bought a magazine for 
entertainment – MacFormat. The first issue 
for you, the first Mac for me, and also the 
first Mac magazine that I ever bought.

That issue kept me entertained for hours 
– Lemmings was on the cover disk! I bought 
the full version on the strength of that demo. 
£39, I think it cost!

I still have that SE/30 on my desk – in fact, 
I’m writing this email on it, although it will be 
sent via a Mac Pro (the old SE/30 can’t handle 
modern email systems). Since then though, I’ve 
become a software developer – and it’s a tough 
business these days. The world is awash with 
bad software, and it’s nigh on impossible for 
the good stuff to struggle to the surface, to get 
noticed – and hence get sales. Looking at that 
old MacFormat, software prices have dropped 
to junk levels – it seems that few people value 
software anymore, they expect it to be free.

My most popular app, MailRaider Pro, sells 
on its own merits – I just about make enough 
money for continued development to be 
worthwhile. Remarkably, it does so without 
ever having been reviewed by a magazine. 
My latest app, an addictive game for iOS and 
macOS, has taken over a year of my life to 

contacts Get in touch

 Contact us

 Email your queries  
and your questions to 
letters@macformat.com

MacFormat launched 
with a bang, and a 
Lemmings demo, all 
the way back in 1993.
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Where did ‘Bounce’ go?
 In Mac OS X Lion, whenever I received Junk 

mail or unwanted advertising, I used to bounce 
it back. This method got rid of it and did not 
tell the sender that their email had reached a 
valid address, or that the email had been 
opened. It worked, and gone really was gone.
  With the El Capitan upgrade, ‘Bounce’ has 
bounced off! Now we have to either drag the 

offending junk straight to the Trash (no problem there if you spot it in time), 
or, if I inadvertently do open it, there may be an ‘unsubscribe’ option which 
often does not work. On those occasions when it does work, it seems to 
generate more from the same sender or, just now, a phone call to my 
ex-directory number about the same subject. When I questioned the lady 
at the other end she admitted that unsubscribing sent my address to an 
international marketing database for follow up. However, she wouldn’t 
divulge how she got my number. I terminated the call.

Is there a hidden way of bouncing, or can Apple Almighty be persuaded 
to give it back to us?
b y  P e t e r  W h i c k m a n

gRaham says… When Apple removes a feature it usually has a good 
reason for doing so. Bounce was removed because a lot of the time 
spammers aren’t sending it from their actual email address, they’re 
spoofing the address of somebody else, and when you bounce the email 
back you end up either sending the bounce back to a false email address, 
or worse, to an innocent third party. There are Automator scripts you 
can find online for creating your own Bounce feature in Mail, but we’d 
recommend not doing it as this feature was removed for a reason. 

So, what to do? The easiest solution is to use a Gmail, Yahoo or iCloud 
email address, as these services have solid server-side spam filtering, so 
you’ll find that the offending emails are already in the Spam folder and 
don’t interfere with your regular inbox.

 LetteR of the month!

Have your say on all things Apple!

n STAR LETTER PRIZE!
Win a Creative NUNO
 The author of our Star Letter  

receive a prize each issue. This  
issue its the Creative NUNO, 
a portable, wireless speaker with  
high-performance speakers under 
its cloth covering. Find out more  
at: http://uk.creative.com



Get in touch contacts

finish – and, over the past three months, 
has made me less than seven quid. 
Which is a pity, because it’s a damn 
good game. If you still had a cover disk, 
I’d make you a demo version! 
by P a S c a L  h a r r i S 

aLeX says… Thanks for sharing 
your memories Pascal, I’m sure it will 
stir a few fond memories of getting their 
first Mac amongst other readers of 
MacFormat. How things get noticed on 
the App Store is one of those strange 
quirks of fate that can often not feel 
fair at all. Quite often it’s a combination 
of chance and timeliness. However, 
it’s worth remembering the amazing 
opportunity that the App Store 
presents and the app economy it 
created. See my feature on page 85 for 
details of the way it changed the world.

successfuL suppoRt
 So, knowing it was a risk, i bought 

a mid 2012 macbook Pro 13-inch from 
an auction, replaced the cracked 
screen, installed a 1tb hard drive and 
16Gb of ram. the result? a terrific 
laptop – fast as you like and my outlay 
was less than £550. a bargain!

  now updated to Sierra, the sole 
remaining issue was time machine – 

it just wouldn’t work. Self-help got me 
nowhere so eventually i went to apple 
Support, expecting “no, not any more, 
out of warranty”. expecting to be told 
to go away, my case was escalated to 
advanced support, and solved after 
a couple of tries (by removing a 
corrupted document). So, i am really 
writing to thank the apple Support 
team (and Stephanieb in particular). 
Great job, i’m a happy camper.
by a n d y  W i L S o n

gRaham says… Always nice to hear 
a story of good customer support from 
Apple, Andy. The strong after-sales 
support is one of the main reasons 
that people go the Apple route.

If you’ve got the skills then buying a broken Mac 
and repairing it is a cheap route to ownership.

Back in issue 
309 we extolled 
the virtues of 
Apple Music.
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When the music stops
 Your article in Issue 309 on Apple Music was 

informative, but was based – as is so often the case 
nowadays – on one huge assumption. That you have 
a good internet connection. Now I do at home, with 
fast WiFi, and 4G when out and about. But I’m writing 
to you at this moment from a cruise ship where 
internet connection is by satellite. It takes one back 
to those dial-up days, when you went online because 
you needed to, and then quickly logged off, except 
satellite is far more expensive as well. 

This cruise is when I realised that nearly all my 
hundreds of hours of bought and downloaded music 
have been migrated to iCloud, and I have had the 
disastrous realisation that I have hardly any music 
with me on my phone. The connection is far too slow 
and expensive to download this music now, so I’m left 
bereft. The same would be true – and worse – if I was 
on a camping holiday, etc. When I get home, I’ll 
re-download my music to my phone, and will very 
likely unsubscribe from Apple Music.

Your article only serves to look at the frills and 

benefits of Apple Music 
and completely ignores the 
major disadvantage, that you 
could well find you have no 
music on your phone when 
you actually have time 
to listen to it.
b y  m i k e  a r n o L d

aLeX says… It’s true, 
we live in a connected 
world, and many of the 
Mac’s core features are 
starting to depend on a 
decent internet connection. 
With an Apple Music subscription 
there’s nothing to stop you 
downloading tunes to your 
iPhone so they can be 
played offline before 
you go on a trip.

 this issue the team debated 
all the unexpected ways apple 
changed the world, but what do 
you think? Did we pick the right 
ones? Let us know your favourite 
world-changing apple moment 
and you could be featured in 
next issue’s contacts page! 
Missed it? Turn to p76

What Ways Do 
you think that 
appLe changeD 
the WoRLD?

What do
you think?
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With sales stumbles and innovative rivals, could the iPhone 
go the way of the BlackBerry?

The future of the iPhone

pple’s money-making ability 
is legendary. In 2016, the firm 
made a staggering $44.9 billion 
in profits, making it the most 

profitable company in the world. In fact, it 
took 79% of all smartphone profits in that 
time, despite only holding a 14.5% market 
share. If there’s a secret code to making 
money, Apple has cracked it.

And, as that market share figure indicates, 
Apple has achieved record financial successes 
despite selling fewer phones than some of its 
rivals. You would think this would be an 
indication of Apple’s rude health, but not 
everyone sees it that way. People have been 
predicting the downfall of Apple in the 
smartphone world for some time now – 
do they indeed have a point? We dived 
in to see if Apple’s iPhone dominance 
could be about to falter.

No Steve Jobs
For all of Apple’s record profit-making in 
the Tim Cook era, there are still grumbles 
– some of them quite loud – about his 
leadership. He’s no Steve Jobs, they say. 
They compare the removal of the iPhone’s 
headphone jack to the advances under Jobs’ 
watch (slightly unfairly, perhaps) as a sign 
that Apple doesn’t innovate any more.

Long-time Apple watcher Joe Wilcox put 
it this way: “Much of the ‘Ah-ha!’ moments 
during a Jobs’ One More Thing unveiling – 

and user experience that followed – 
sparked the ‘you didn’t know you needed 
[it]’ realization. Is that really the emotional 
reaction to an over-sized tablet or new 
features like 3D Touch? Honestly?”

He’s not the only one who has concerns 
about the iPhone’s future direction. 
Renowned developer Marco Arment 
famously suggested that Apple could go the 
way of BlackBerry if its rivals’ gambles on 
artificial intelligence (AI) proved successful.

Smart and intelligent
Google, Facebook, Amazon and more are 
pouring money into AI, while Apple – though 
not totally absent – hasn’t made headlines in 
quite the same way. But Arment highlights 
Google as being particularly strong in this 
field when it comes to things like “search, 
relevance, classification, and complex 
natural-language queries” that he feels will 
be hugely important in the coming years. In 
his words, Apple’s competitors are “far ahead 
of them, and the gap is only widening.”

Arment says that BlackBerry didn’t fail 
because it made bad phones, but because the 
purpose of a smartphone changed when 
Apple released the iPhone. Similarly, if AI 
suddenly becomes integral to smartphones, 
Apple might find itself too far behind its 
rivals to be able to catch up, despite being very 
good at making smartphones at the moment.

Of course, for the time being this is 

A

For our latest 
subscription offer 

see page 46!

WritteN By ALEX BLAKE 

Apple might 
find itself too 
far behind its 

rivals to be able 
to catch up
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Apple’s iPhone launch had a major 
impact on BlackBerry sales.
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speculation on 
Arment’s part, but it 
highlights the recurring 
fear among Apple watchers 
that the company isn’t 
innovating enough under 
Cook’s tenure as CEO.

An Indian summer?
Also of note is the iPhone’s recent sales 
stumble. Revenues from iPhone sales fell for 
the first time ever in 2016, where sales in 
quarters 2, 3 and 4 were all lower than their 
2015 counterparts. Of course, we’re not 
talking dramatic slumps or freefall losses, but 
it was a striking turn for a product that has 
known nothing but growth since it launched.

Sales have since recovered well, but the 
incident indicated that the iPhone is perhaps 
not as resilient as was first thought, and that 
sales – at least in Apple’s key markets – will 
not always be so strong. That’s potentially 
a worrying sign for Apple, as iPhone sales 
make up around two-thirds of its revenue 
at present. If the iPhone falters further, the 
company’s dominant financial position 
could come under threat.

Apple’s rivals have already begun to 
look elsewhere for growth opportunities, 
and Apple is no different. The consensus 
among many smartphone pundits is that 
India is the prime location for expansion. 

The country recently outstripped the 

US to become the world’s second largest 
market for smartphone sales, sitting only 
behind China. However, the average price of 
a phone in India is expected to be around $102 
in 2018; most iPhones sell for many times that. 
With its expensive, premium products, Apple 
may be poorly positioned to take advantage 
of India’s huge potential for growth.

In order to boost sales in India, Apple 
may be forced to introduce lower-priced 
iPhones like the iPhone SE. That could eat 
into its huge profit figures, eroding the 
advantage it currently has despite not selling 
as many smartphone units as its rivals.

It’s already tried importing and selling 
refurbished iPhones in India, but that was 
rejected due to an Indian law that requires 
products to source 30% of their materials 
locally. That law was relaxed in June, and 
Apple will start making iPhones in India 
this year, according to The Hindu newspaper.

But is it too late? Apple only ships around 
2% of Indian phone sales at present. In a 
country deemed to be the next explosive 
market for smartphones, that could spell 

Apple only 
ships around 
2% of Indian 
phone sales 
at present

The iPhone SE is 
Apple’s budget offering, 

but it still costs almosts 
three times the price of 

a budget Samsung model.
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Apple makes premium 
products at premium prices. 
But should the smartphone 

giant be increasing its 
sales by offering more 

budget options?

The budget-friendly Galaxy J 
range is hugely popular in India.

Tim Cook 
helped to 

forge Apple’s 
legendary 

profitability
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trouble. Even if everything falls into place – 
it starts making iPhones in India and opens 
its first Apple Store in the country – its 
premium price tag and refusal to lower 
it may still work against it.

Crucially, the Indian phone market is 
led by Samsung, Apple’s bitter rival. Market 
analyst Tarun Pathak at Counterpoint 
Technology Market Research estimates that 
of the 85 million phones Samsung has sold 
in India, 25 million – almost a third – are 
from its budget-friendly Galaxy J range. 
Apple has no comparable device; its iPhone 
SE sells for almost three times the price.

And if Apple can’t take advantage of the 
Indian market in the way its rivals are, its 
smartphone dominance may start to slip.

Cook’s recipe for success
Still, while Apple hasn’t yet cracked India, 
it has a lot going for it. For one thing, it has at 
its helm a man whose flair for supply chain 
management has led to him being labelled 
an operations “guru” and a “genius”.

While Jobs was the company 
visionary, Tim Cook (as Chief 
Operations Officer under Jobs) helped 
to forge Apple’s legendary profitability. 
“Cook’s control over day-to-day operations 
shaped what would become the financially 
ginormous tech titan that marvels the 
industry today,” states Wilcox. 
So even though it has 
barely any presence 
at all in India, Apple 

has the supply chain clout and experience 
to potentially overturn this deficit.

It’s strong in other areas, too. In the 
words of International Business Times writer 
Rishabh Jain, “With its own operating 
system, an app store, its own manufacturing 
supply chain and most importantly, a huge 
and loyal customer base, Apple easily trumps 
every other smartphone company in terms 
of profit. Apple’s image as a premium device 
maker and the desirability of its devices has 
gone a long way to put the company at the 
top.” That won’t change any time soon.

One positive indicator of Apple’s iPhone 
fortunes is the app economy. As we show 
on page 82, this has been an unprecedented 
success story for Apple, generating as much 
as $5.4 billion in Q4 2016 alone.

All in the numbers
As well as its huge financial payouts, the 
App Store serves to tie users in to the iOS 
ecosystem. If you’ve paid for a load of apps 
and are used to working with them, that 
might make you reluctant to switch over to 
Android. If Apple can keep people in its iOS 
ecosystem and buying new iPhones, that can 
only be a good thing for the company.

And let’s not forget China, the world’s 
biggest market for smartphones. Apple sold 
44.9 million iPhones in China in 2016 – that’s 
down from 2015 sales of 58.4 million, but, 
given Apple’s phenomenal profit margins, 
would still have brought in a huge amount 
of money. The sheer number of smartphone 
consumers in China means that even if Apple 
finishes in fifth place in terms of sales (as it 

did in 2016), it can still make huge profits – 
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Apple is hardly 
operating from 

a position of 
weakness… 

but it needs to 
be working on 
AI right now

the economy of scale means it doesn’t even 
need to be number one.

Money-making machine
Speaking of huge numbers, there’s also the 
scale of how much money Apple makes from 
iPhones globally, which we alluded to earlier. 
According to Bloomgberg’s Shira Ovide, 
Apple and Samsung have been dominant for 
a long time. She cites Mike Walkley, market 
analyst at Canaccord: 
“According to his data, since 
early 2012 – practically an 
eternity in the smartphone 
business – Apple and 
Samsung together have 
generated 100% or more of 
all operating profits among 
makers of premium-priced 
smartphones.” That figure 
works out because all other 
smartphone manufacturers 
have either just broken even 
or lost money.

Apple is hardly operating 
from a position of weakness. 
It may have some significant 
challenges on the horizon, but 
if there’s one thing it ‘gets’, 
it’s selling smartphones.

There are reasons to be 
concerned when looking in 
from the outside, but Apple 
has always been a company that 
keeps its cards close to its chest. It’s 
working to make up its shortfall in 
India, and may well be cooking up 
something that changes the smartphone 
industry in the way the iPhone did in 2007.

Perhaps the only significant concern 
when it comes to smartphones 
is AI. Marco Arment makes 
the point that “Becoming a 
major big-data AI services 
company doesn’t happen 
completely in secret and 
suddenly get released to 
the world, completed, in a 
keynote.” Apple needs to be 
working on this right now, 
and that’s hard to conceal; 
we’ve seen no major signs yet.

If the AI gamble Google 
and others are taking proves 
lucrative, Apple’s smartphone 
dominance may be at risk. 
But the thing about gambles 
is that they don’t always pay 
off – if this doesn’t, Apple 
has little to worry about.

The iOS  
ecosystem is 
a significant factor 
in consumers 
staying loyal to 
the Apple brand.

Though not well known in 
the West, Oppo outsold all 
other smartphones in China 
over the course of 2016.

Apple is remaining surprisingly 
quiet on the subject of AI. As 
other smartphone manufacturers 
continue to make developments, 
is Apple at risk of falling behind?



MATT BOLTON…

T
he iPhone has led the pack ever since its 
introduction. When it was announced in January 
2007, Steve Jobs called it a “revolutionary and 

magical  product that is literally five years ahead of any other 
mobile phone.” In fact, Apple wasn’t just ahead of the 
competition in terms of design, but in thought process too. 
Even upon its release, the likes of RIM and Nokia still saw it as 
a novelty for a small market, not likely to eat into their customer 
bases. But the iPhone devoured all. Only Google saw the 
Independence Day-like shadow coming from the iPhone as the 
danger it was, and immediately changed development of its 
nascent Android OS to ape the iPhone (rather than the 
BlackBerry-alike it was until then).

Since then, every time the others have caught up to the 
iPhone, Apple has pulled away again. The quality of plastic 
cases was improved, then Apple moved to metal and glass. 

Resolutions increased, then Apple 
showcased 300+dpi Retina 
displays. Cameras got better, then 
Apple included a DSLR-level image 
processor. Processors got faster, 
then Apple made its own that 
crushed the competition.

Except last year. The iPhone 7 is 
Apple’s best iPhone ever, no doubt, 
with improvements all over the 

place, but it wasn’t a big design leap forward. Whereas normally 
after its September event, competitors look through the cloud 
of dust to see the iPhone streaking over the horizon, here they 
saw it sauntering down the street at a leisurely pace.

No matter how waterproof or Jet Black it became, or how 
many cool internal features were added, there was no denying 

that the iPhone 7 was essentially 
the same design as the iPhone 6, 
released two years before – and 
we knew this design would be 
around for at least a year.

The result is that the 
competition has not only caught 
up, but is starting to stride ahead. 
The new wave of phones come 
with striking designsand really 

APPLE CORE Opinion

The iPhone 7 was hardly a jaw-dropping 
reincarnation. Let’s hope for more 
significant steps forward in 2017…

With other manufacturers upping the ante and making 
impressive technological advances, Apple needs to start 
calling the shots again with its next iPhone release.

 macformat.com  @macformat16 | MACFOR

ABOUT MATT BOLTON
 Matt is the editor of Future’s flagship 

technology magazine T3 and has been 
charting changes at Apple since his 
student days. He’s sceptical of tech 
industry hyperbole, but still gets warm 
and fuzzy on hearing “one more thing”.

When a product 
stagnates in its 
design, it stagnates 
at its core, too

On The eve Of iTs 10Th 
anniversary, The iphOne 
is in danger Of falling 
behind fOr The firsT Time  

cool features. Near edge-to-edge displays that 
offer high dynamic range and even 4K. Slo-
mo recording at 960fps (though I bet you’ll 
see this in the next iPhone). 20-megapixel 
dual Leica-engineered cameras. And that’s 
before Samsung announces its next flagship. 

The simple truth is that, if we get an 
iPhone 7S this September rather than a full-
on iPhone 8, Apple not only won’t pull away 
from the pack, it won’t even be at the front 
when it comes to design. Of course, the overall 
experience will still be great, but I’d be 
concerned about an Apple that doesn’t lead 
on experience and design. As Steve Jobs said, 
“Design is how it works.” Any Apple product 
that stagnates in its design is stagnating at its 
core. And looking at Apple’s line-up across 
the board in the last year or more, this could 
apply to way too many products for comfort.

I hope that 2017 is the year Apple reveals 
it’s been saving energy for a sprint, and it 
retakes its place at the front.
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 The MacFormat team debates the hot apple  
issues of the day, using their iPhones of course!

“DO yOu Think 4k wiLL jusTiFy 
buying A FiFTh-gEn APPLE Tv?”

sPLiT viEw

Jo says…

Paul says…

“I can’t see the wood for 
the trees, can you help?”

‘You can adjust many  
of the vision settings.’

Siri...ously? tap to edit

sTEvE jObs
apple.com

“I’ve never met 
someone who 

knows technology 
who knows 

how to connect 
with people.”

Jobs thought Genius Bars 
would never work, but 
later changed his mind

jOnAThAn 
ZDZiARski
zdziarski.com

“Privacy is 
sacred; our 
digital lives 

can reveal so 
much about us.”

Security expert joins Apple 
to work on privacy issues

TOny ChRisTOPhER
landmarkusa.com

“Steve Jobs… was 
looking for a way 
to connect Apple 
to its customers.”
Designer recounts Jobs’ 
‘Apple Café’ idea – later 

replaced by Apple Stores

LuCA MAEsTRi
apple.com

“The App Store is 
doing incredibly 
well, the quality 
and quantity of 

content continues 
to improve…”

Apple Chief Financial 
Officer is pleased with the 
App Store’s performance

I’d have to know what kind of price point it’ll 
come in at – you know, Amazon’s Fire TV 
supports 4K, and that’s just £80.

But the last incarnation was not much of a 
leap. The Apple TV needs 4K support as a 
bare minimum offering in the next upgrade.  
You can shoot 4K on your iPhone 6s     , but 
you can’t play it in 4K through Apple TV!

Personally, I don’t think I’d upgrade for the 
4K feature alone, especially if we’re still 
talking over £100.  Apple still needs to think 
where the Apple TV sits when it comes to 
gaming too… 

Yeah, but the storage doesn’t really 
compare, and you get all the benefits of 
Apple compatibility – being able to play 
stuff I’ve bought on iTunes is great.

Granted, that’s a frustration, but I haven’t 
actually made the upgrade to a 4K TV      
yet, so that’s a moot point!

Turn to page 46

SuBSCriBe 
tODAy! 

 sAvE
83%!

I’ve heard rumours of more storage options, 
so the entry level one might turn out to be 
pretty affordable. If the next Apple TV 
comes with an A10 chip and 4K, then I’ll 
definitely be tempted.  

UP 
TO
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EditEd by cliff joseph 

ast month we looked at the 
huge explosion in sales of 
security cameras, which 
are now far and away the 

most popular products in the entire 
smart home category.

But for many people a camera is just 
the starting point from which they can 
build a more extensive home security 
system. You can extend your security 
coverage with additional sensors that can 
detect movement in darkened rooms, or 

someone opening a door or window when 
you’re away from home. You can buy 
sirens to scare off intruders, or provide 
additional protection for your home with 
water and smoke sensors that can warn 
you of fires or floods.

 These sensors aren’t all that 
expensive either, so you can mix and 
match devices to build your own personal 
security system, or buy an affordable 
starter kit that includes everything you 
need in a single box.

Cameras aren’t the only option  
for protecting your home; there’s a 
range of devices that you can use to 
create your own diy security system

L

MAy 2017 | macformat | 25

The smart home is 
here – live the Apple 

dream today!

live 
smarter

You can buy complete 
security kits, or go for 
a hub that works with 
various accessories.
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security camera is the ideal 
starting point for your home 
security system, but even the 
most advanced cameras have 

their limitations. A camera can only look 
out for activity in one specific room or 
location, and even cameras that have a 
night vision mode can only see things a few 
metres away once it gets really dark. You 
could buy additional cameras to cover other 
areas – but with high-quality cameras 
costing £120-£200 each that can quickly 
turn out to be very expensive.

But cameras aren’t the only security 
option available for the smart home. Once 
you’ve got a camera you can also purchase 
a number of other security devices, such as 
motion sensors that can detect movement 
even in dark rooms, or contact sensors that 
can tell when a door or window has been 
opened. As well as helping to monitor areas 
that might not be easily visible to a camera, 
these sensors are generally a lot cheaper, 
so you can buy several to cover different 
rooms around your home.

Security matters
Like a security camera, a motion sensor or 
contact sensor can connect to your home 
Wi-Fi network and send an alert to an app 
on your iPhone if it detects any suspicious 
activity. But while you can generally buy 
any camera and quickly set it up to work 
with your iPhone, these other types of 

A
What is a  

contact sensor?
 A contact sensor is 

actually two sensors 
that work together to 

protect doors and 
windows. One sensor 

is attached to the 
door/window, while 

the second sensor is 
attached to the frame. 

When the door/
window is closed, the 

two sensors are in 
contact – but if the 

door/window opens 
the contact is broken 
and the sensor sends 

you an alarm.

What about locks?
 Old-fashioned locks 

are obvious candidates 
for smart tech. 

However, August 
Home – a leader in the 
smart lock field – tells 

us that US locks aren’t 
always suitable for the 
European market. The 

best bet here in the UK 
is Yale, with its Keyfree 

and Conexis range of 
locks (yale.co.uk).

apple home Security accessories

security sensors rarely just work on their 
own. In most cases they are specifically 
designed to work in conjunction with other 
devices made by the same manufacturer.

If you own Netatmo’s popular Welcome 
camera (£199) then you can use the 
Welcome to control additional ‘tags’ that 
monitor doors and windows (and also the 
company’s forthcoming Security Siren). 
The tags are well priced – just £90 for a 
pack of three – but they don’t work on 
their own, so do you have to budget for 
the Welcome camera as well. 

When you’re starting from scratch, the 
cheapest option is probably to buy a starter 
kit that includes a number of different 
security devices. If you don’t already own a 
camera, you could consider D-Link’s Smart 
Home Security Kit, which costs £215, but 
includes a security camera along with an 
ear-splitting siren, and one contact sensor 
for a door or window. Panasonic really goes 
to town here, offering a range of kits that 
contain different combinations of security 
cameras, sensors and sirens. Prices start 

Security cameras are increasingly popular, but you 
can expand your home security system with these 
affordable sensors and starter kits

 macformat.com  @macformat

security
Get 

started 
withHome

Once you’ve got 
a camera, you can 
purchase motion or 
contact sensors, too
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Explained
pir
 Some motion sensors can detect sound and 

vibrations, but most affordable home sensors 
tend to use PIR technology (Passive Infrared), 
which can detect infrared light emitted from 
the warm bodies of people or animals. This 
allows them to monitor darkened rooms where 
ordinary cameras may not work very well.
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Are there any 
hidden costs?

 Many motion sensors 
and contact sensors are 

sold on their own – but 
will often require a 

control hub in order to 
work properly. That’s 

why it’s often better to 
buy a starter kit that 
already includes the 

control hub. And, as we 
discovered last month, 

some security cameras 
require a monthly 

subscription if you want 
to store your video 
recordings online.

Mix and match?
 Apple’s HomeKit 
software, and the 

Home app in iOS 10, 
can allow products 

from different 
manufacturers to 

work together – so 
your D-Link Omna 

camera can see you 
arrive home and 

automatically turn 
on your Philips Hue 

lights. Unfortunately, 
there aren’t many 
security products 

that currently support 
HomeKit, so it’s 

probably best to stick 
with products from a 
single manufacturer 

when you’re first 
getting started.
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The Netatmo Welcome 
camera is quite costly, 
but you can get three 
additional tags for £90.

at £129 for a basic kit with one motion 
sensor and one contact sensor, and go 
right up to £380 for a comprehensive 
Home Monitoring Kit Twin Camera Kit that 
includes two cameras – one for indoors, 
and a weatherproof camera for outdoors 
– along with two contact sensors, a motion 
sensor, and a smart plug that you can use 
to turn your lights on to deter intruders.

Samsung takes a different approach 
with its SmartThings Starter Kit (£199). 
The SmartThings kit doesn’t include a 
camera, opting instead for a motion 
sensor, a contact sensor, smart plug, and 
a ‘presence sensor’ that you can attach to 
a key ring or an item of clothing so that it 
can tell you when a child or other family 
member arrives or leaves home. If you do 
want a camera, the SmartThings kit can 
be used to control Samsung’s separate 
SmartCam HD Pro (£129), and Samsung 
has done a good job of working with other 
companies – pay attention, Apple! – to 
make their products compatible with 
SmartThings. There are security cameras 
from both Netgear and D-Link that will 
work with the SmartThings kit, along with 
some of the latest smart locks from Yale, 
Philips’ Hue lights, and even multiroom 
speaker systems from Bose.

Regardless of manufacturer, one thing 
these kits have in common is the inclusion 
of a central control hub that connects to 
your home router and links the different 
security devices together. Once you have 
the hub set up you can extend your home 
security system by purchasing additional 
sensors – typically for £30-50 each – and 

Samsung, D-Link and Panasonic all provide 
a good selection of add-on sensors, including 
motion and contact sensors, sirens, and also 
smoke and water detectors that can provide 
additional protection against floods and fire.

Devolo sells a starter kit, although this 
isn’t entirely focused on security. However, 
you can buy its hub – called the Home Control 
Central Unit – for £110, and then build your 
own mix-and-match security system by 
choosing from the company’s selection 
of standalone components and sensors.

The odd man out here is Elgato, with its 
Eve Motion (£45) and Eve Door And Window 
(£35) sensors. These are affordably priced 
and – unlike most of their rivals – they don’t 
require you to buy a separate control hub 
from Elgato in order to use them. The catch 
here is that they use Apple’s HomeKit 
software, so you do need to have an AppleTV 
or iPad set up at home, which effectively acts 
as the control hub for the sensors instead. So 
while a security camera is still the best place 
to start, there are plenty of options available 
that allow you to extend your security system 
to cover key rooms and locations around 
your home even on a quite modest budget.
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five of the best

Panasonic Home 
Monitoring Twin 
Camera Kit £380
panasonic.com
> This kit includes two 

cameras – one for indoor 

use, one for outdoor use 

– along with two contact 

sensors, a motion sensor, 

smart plug and control 

hub. There’s an iOS app, 

but the kit also includes a 

‘remote control’ handset.

Samsung 
SmartThings 
Starter Kit £199
samsung.com
> Samsung’s starter pack 

provides motion, contact 

and presence sensors, 

and a smart plug. There’s 

no camera, but the kit is 

compatible with other 

manufacturers’ products, 

so it’s a good option for 

mix-and-match security.

Netatmo Tags 
£90
netatmo.com
> These contact sensors 

provide a quick and easy 

way of extending the 

Netatmo Welcome 

security system. You 

need the Welcome to 

control the tags, but 

three tags for £90 

means you can cover 

a number of locations.

Yale Conexis L1 
£270
yale.co.uk
> There aren’t many smart 

locks available in the UK 

just yet, but Yale’s Conexis 

range is a good start. You 

can unlock the L1 just by 

turning your iPhone like a 

key, and the Yale app also 

allows you to send digital 

keys to other family 

members too.
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D-Link Omna 180 
£200
dlink.com
> D-Link supports Apple’s 

HomeKit software. As 

well as providing 1080p 

resolution, night vision, 

and a 180-degree wide 

angle lens, the Omna can 

be used to control other 

HomeKit-compatible 

devices, such as Philips 

Hue or Elgato sensors.

198,706
Burglaries recorded by 
police in the UK, for the 
year to September 2016. 
(UK Office For National 
Statistics)

3%
That 198,706 total is 
actually an increase of 
3% from the previous 
year. (ONS)

79%
The good news is that 
the majority of crimes 
in the UK result in ‘minor 
or no injury’. (ONS)

34%
Home owners in the US 
still think a dog is the 
best security option. 
(August Home)

iFacts…

Once you have a 
central control hub 

set up, you can 
extend your home 
security by adding 
additional sensors
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Nate Drake shows us how to 
cleanse our operating systems and 

revitalise slow-performing Macs

Mac
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nlike certain other operating 
systems, macOS is built 
extremely efficiently and does 
not need to be ‘defragmented’ 
to keep ticking over nicely.

However, as with every machine, Macs 
sometimes experience performance issues. 
In this guide, we will explore some common 
problems along with ways to clean out 
unnecessary files to speed up macOS.

If you’re reading this guide, congratulate 
yourself on deciding to investigate further rather 
than assuming that there must be a hardware 
defect with your Mac or that you have a virus.

Hardware faults and malware can cause 
your system to perform poorly but it is much 
more likely that this is a problem you can solve 
from the comfort of your own home without 
installing any additional software.

Before following any of the steps in this 
guide, try to focus on the issues you’ve been 
experiencing. Does the system perform slowly, 
for instance, only when you open a particular 
video game but work fine when you’re playing 

videos in QuickTime? If so, the issue may relate 
only to that particular application.

If your issues relate to apps using the internet 
such as FaceTime, try to test with another device 
to see if the problem lies with your home internet 
connection rather than the Mac itself.

Once you’re satisfied that the issue relates 
to macOS as a whole, feel free to follow 
the steps in this guide. If at all possible, we 
recommend that you back up your data first.

U

With this guide, you can make sure your Mac is as clean and 
tidy as your workspace. (Piles of paperwork just out of shot.)
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lthough macOS is very 
efficient in terms of using 
files, over time temporary 
data and third-party 
software can affect 

the speed of your system. These are the 
most common culprits when it comes to 
poor system performance. You may wonder 
how you can fix such issues if the files and 
apps causing the problems are still being 
accessed in macOS? The answer is safe mode 
– a special way of starting up your Mac 
whereby macOS will only load software 
which was originally installed.

The safety of safe mode
In addition to preventing third-party apps 
from launching, safe mode will check your 
hard drive and try to repair corrupted files. 
It will also try to delete unnecessary system 
and kernel caches.

This guide assumes you are running the 
most recent version of macOS Sierra which 
has special options for configuring file 
storage. If you have not yet upgraded to 
Sierra, you can do so from the Mac App 
Store. To get started, shut down your Mac. 
When the Mac is fully powered off, press 
and hold down ß until you see the login 
window. Log in as normal. Note that if you 
have used FileVault to encrypt your disk, 
you may have to do this twice.

You will see a small, grey loading bar 
inching across the screen. This shows that 
the system is entering safe mode. If macOS 
needs to repair your disk or there are a large 

amount of cache files to clear, this can take 
some time, so be patient.

When the login screen appears, you 
will see the words ‘Safe Boot’ in the menu 
bar. (Safe mode and safe boot are different 
names for the same thing). Log in to your 
own account as you would normally. Safe 
mode only uses very basic graphics drivers, 
so don’t worry if you see flickering on your 
screen. Once you’re on the desktop, click 
the  and choose About this Mac from the 
menu bar. Next, click on the Storage tab, 
then the Manage button. The options in 
this window presents several ways to save 
storage space.

Click the button next to Store in iCloud. 
You’ll see an option here to optimise your 
files in the Desktop and Documents folders, 
meaning it’ll put those folders and their 
contents in iCloud Drive. This makes them 
accessible on all devices on which you can 
access that storage area. This will save space 
on your hard drive, but will only improve 
performance if you have a reliable, fast 
internet connection. Remember that your 
iCloud account only comes with 5GB of free 
storage, and it could take a long time to 
upload everything.

Click Optimise Storage to remove 
watched films and TV shows; you can 

cleaning
Safely remove the clutter of  
redundant files from your Mac

Spring

Click on Storage 
then Manage – 
the options here 
help you to 
streamline your 
file storage to 
free up space

The grey loading bar will appear 
when you start safe mode. It may 
take some time for macOS to load.
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always download movies again. You can 
also choose only to download recent email 
attachments or better yet, only download 
attachments when you click on them. 
Click on the third option, Empty Trash 
Automatically, to delete files that have been 
in the Trash for over 30 days. Remember to 

keeping regular Time Machine backups.
The final option, Reduce Clutter, 

identifies large files you may no longer need. 
Click Review Files to see an itemised list of 
files. You can hover over files either to delete 
them or show them in the Finder. While this 
is a quick and easy way to delete large 
amounts of data, be careful not to remove 
anything important. Run a Time Machine 
backup before removing files. Some files 
will have an X next to their name – click 
this to send them to the Trash. Other files 
may be part of an app, so may need to be 
deleted from there.

If a file or folder is taking up large 
amounts of space but you need it, such 
as your iTunes Library, you may be able 
to store it online or on an external drive. 

Another culprit for hogging space is your 
Downloads folder. Items in here have been 
downloaded from the internet so are almost 
certainly replaceable. Click the Downloads 
tab to view and delete items.

On the subject of apps, take a look at the 
items in the Optimised Storage window’s 
sidebar that have data that’s taking up lots 
of space. If you back up your iOS device to 
the Mac, click iOS Files to see if any large 
backups are taking up space. You may prefer 
to remove these and switch to using iCloud.

Go to System Preferences and click Users 
and Groups on the Login Items. Click on the 
padlock (bottom left of the window) and 
enter your password to allow you to make 
changes. This window details which apps 
start when you first log in to your account. 
Click on an app to highlight it and click the 
‘–’ button to remove unnecessary files. This 
doesn’t remove the application, it just won’t 
start up as soon as the desktop appears, 
which can improve system performance.

Your Mac stores temporary files 
in cache folders. Apps can perform 
poorly while trying to access a 
corrupt or non-existent cache file. 
If so, you can manually clear cache 
folders. Doing so will not remove 
applications or cause you to lose 
personal data, but you should still 
make a Time Machine backup first. 
Open Finder and choose Go, then 
Go to Folder. Enter ‘/Users/
yourusername/Library’. Open 
Caches; choose Edit > Select All. Delete the files. If the Mac has 
more than one user account, log in to each and repeat the steps. 
Choose Go again and then Computer. Double-click your startup 
disk then open Library and the Caches folder. Delete files there, 
too. Restart, then in Finder, choose File > Empty Trash.

Cache in and clear up

The options in 
Optimised Storage 
free up space by 
removing old files 
and storing others 
in iCloud.

The caches folders contain only 
temporary data so you can delete 
these files safely. 
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Mac healthy
Keep your

Examine your apps and remove 
anything you don’t need
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n the previous section, we 
explored ways to optimise 
file storage on your Mac by 
increasing the amount of free 
space available. This included 

reviewing which apps are set to start up when 
you first log in to the macOS desktop.

There are applications which are available 
both from the Mac App Store and the internet 
at large which claim to automate the process of 
speeding up your Mac. Some of these simply 
automatically search for large files to delete 
and free up your caches, which we already 
did in the previous section.

People who make malware often prey on 
people’s insecurities by disguising malicious 
apps that pretend to clean up your Mac but 
instead bog it down with junk. Even reputable 
apps, such as virus scanners, will sometimes 
cripple your machine with multiple ‘threat 

detection’ warnings about harmless files.
In view of the above, we do not recommend 

any third-party software to fix a slow Mac. You 
should examine the apps you already have 
installed to make sure that they’re necessary 
– too many applications running at once is a 
common cause of poor system performance.

Back to safe mode
You cannot remove an application while it’s 
running so, as in the previous section, make 
sure you start up your Mac in safe mode. If 
you’re unsure if your Mac is still in safe mode, 
check System Information.

Removing an app doesn’t necessarily 
remove all related files. For instance, removing 
GarageBand will not delete the sound library. 
This said, make sure to run a Time Machine 
backup before proceeding further in case you 
accidentally remove something of importance. 
Open your Mac’s Applications folder. Carefully 
read through the list of apps. In general, the 
system will not let you delete any apps which 
are built in, such as Safari, but you can remove 
third-party ones.

Remove an application by clicking on it 
once to select it, then choosing File > Move to 
Trash. You should do this for any apps you 
don’t recognise, or no longer use. You will be 
asked to enter your Administrator password 
when removing apps. Simply type it in, then 
press Return. When removing an app, head 
over to System Preferences to see if it has an 
entry there. If so, ≈-click and choose 
Remove <name> Preference Pane.

Watch out in particular for multiple 
applications that do the same thing. Some 
inexperienced users believe, for instance, that 
installing two antivirus apps makes you twice 
as safe. In reality, this offers no extra security 
and, in fact, can make your Mac go haywire as 

I

≈-click any app you no longer use 
and then choose Move to Trash. 



Removing a 
legitimate app is 
fine, but malicious 
apps can reside 
elsewhere on 
your Mac

Click on any process to select it, 
then the X button to kill it. 
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the two apps interfere with one another.
Removing an application works like a 

charm as far as legitimate applications go 
but sometimes malicious apps can 
reside elsewhere on your Mac.

Sort startup apps
Although you previously checked the 
Login Items in System Preferences for apps 
which start up on boot, there are also several 
folders on the Mac hard drive which list startup 
apps. Go through the steps in the tutorial above 
to review and remove these if necessary. Doing 
so will not remove the applications themselves 
but simply make sure you have to launch them 
yourself from the Dock or from the Applications 
menu after log in. 

After following these steps you may find 
that if you had antivirus software on your 
Mac, it no longer launches automatically.

This is not really a cause for concern. 
Although it’s not entirely true to say “Macs 
don’t get viruses”, most malware and viruses 
are written for Microsoft Windows.

While your Mac is unlikely to be infected, 
the antivirus software itself will take up large 
amounts of system resources when performing 
routine scans. Consider only launching 
antivirus when you need to scan individual 
files or uninstall it altogether. Remember that 

provided you’re keeping regular backups with 
Time Machine, even if you do accidentally 
download a virus, you can restore your 
system to a point before it was infected.

Using Activity Monitor
Once you have restarted your Mac, if your 
system is still running slowly. Click on the 
magnifying glass at the top right of the screen, 
type ‘Activity Monitor’, then press Return.

Activity Monitor lists all currently running 
processes. Click the Memory tab at the top of 
the window then the Memory column below 
to list apps, from those that consume the most 
memory, to the least. You can click on a 
running process to select it and click the 
X at the top left to stop it altogether.

Naturally, video conferencing with a friend 
over FaceTime will be more resource hungry 
than simply opening Calendar, so do not 
be surprised if certain apps hog more memory. 
However, if you believe an application is taking 
up too much memory, make a note of it so you 
can troubleshoot it further later on.

If the application is part of macOS, such as 
FaceTime, you may need to reinstall macOS 
to fix the problem, which we will cover later. 
If it is a third-party application, try removing 
it and reinstalling it. If this fails to speed up 
your system, try to find an alternative app.

1Clear the  
LaunchAgents Folder

In Finder, choose Go > Go to Folder then 
type ‘/Users/yourusername/Library’. If 
there’s a folder named LaunchAgents, 
delete anything you don’t recognise 
inside it. Repeat this step for each user 
account on your Mac.

2Clear System 
LaunchAgents folder

In Finder, choose Go once again, then 
Computer. Double-click on your startup 
disk and then open the Library folder. 
Find the folder named LaunchAgents 
here and once again delete any 
unrecognised files inside it.

3System 
LaunchDaemons 

& StartupItems folder
Click the back arrow (top left of Finder 
window); open the LaunchDaemons 
folder. Delete any unrecognised files; 
do the same for the StartupItems folder. 
Restart your Mac and empty the Trash.

HOW TO Prevent malware by clearing LaunchAgents  



media
Move your

Consider keeping large files 
on an external hard drive
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o, in general, the more free 
space you have on your Mac, 
the faster it will run. This is 
fine in theory but the Mac is 
made to be used. What if you 

have a large music and video collection or 
thousands of family photos?

If you have a reliable internet connection, 
some of your data can be stored in iCloud. You 
have already seen how iTunes content you 
purchase can be removed after you play it.

If you are an Apple Music subscriber, you 
can also enable iCloud Music Library, whereby 
all your iTunes music can be uploaded and 
streamed over other devices. This is handy 
in terms of saving space as you can delete files 
locally from your Mac and redownload them 
as and when you want to listen to them. 
However, beware of doing this if the original on 
your Mac is of a higher quality than 256Kbps in 
AAC format; the copy stored in iCloud will be 
more compressed. This feature, however, is not 
always ideal. It doesn’t work well with Family 
Sharing and certain content, such as home 
videos, can’t be stored in iCloud this way.

A simpler solution is to store your entire 
iTunes library on an external drive. This gives 
you access to every single kind of media file 
even when internet is patchy. Follow the steps in 
the tutorial to do this. Only delete your original 
iTunes Media folder on your Mac once you’re 
happy everything is working correctly.

In order to proceed, you’re going to need 
an external hard drive. The online Apple 
Store sells external drives that have been 
formatted for macOS but, in practice, 

any USB 3.0 compatible external drive is fine, 
although you may need to format it first. See 
page 44 for help with this.

Do not be tempted to use the same external 
drive both for backing up with Time Machine 
and for storing your media. Time Machine 
deletes older backups as space runs out, so you 
don’t want it to be vying for storage with your 
music collection. If you can afford it, purchase 
a drive which supports connecting via 
Thunderbolt, which is much faster than USB. 

Once your iTunes collection has been 
moved, consider transferring other libraries 
to the drive as well. Your Photos library, which 
is found in your Pictures folder can be quickly 
and easily moved to an external drive by 
selecting Edit > Copy and Edit > Paste. Once the 
transfer is complete, double-click the new copy 

S

Open the Photo library from 
the external drive then select 
it permanently from Photos 
Preferences.

macOSSafe file removals
Since 2001



The Safari 
browser saves 
downloaded 
content in your 
home folder; over 
time this will slow 
down your system

Click File Download Location > Other 
to move future downloads onto an 
external drive.
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of the library then choose Photos > Preferences. 
The new photo library will be listed beside 
Library Location. Click on Use as System Photo 
Library to make this change permanent. As 
with iTunes, only delete the original library on 
your Mac once you’re sure your photos are safe.

iMovie and Safari
The iMovie app, which is used for editing home 
videos can also take up huge amounts of space. 
Moving the library is very simple but first open 
the app itself and select your library from the 
Libraries list. Next Click File > Consolidate 
Library Media. This should make sure that 
any video clips, images and so on are stored 
within the library itself.

Next, quit iMovie and, in Finder, go to your 
account’s Movies folder. Move the library in the 
same way as for the Photos app by using Edit 
> Copy, navigating to the external drive and 
choosing Edit > Paste, then double-clicking to 
open. Bear in mind that the original copies of 
any videos or images you imported into iMovie 
will still be in their original location, so you may 
need to delete these manually, along with the 
original iMovie library. As before, only do this 
once you’re sure your media is safe.

By default, the Safari web browser on 
your Mac saves any downloaded content to your 
user account’s Downloads folder. Over time 
this folder will grow in size, slowing down 

your system. Fortunately you can change 
the location of your Downloads folder. Open 
Finder and navigate to your external drive. 
Choose File > New Folder. Name your new 
folder and press Return.

Open Safari and click Safari > Preferences. 
In the General tab, find File Download Location. 
Click Downloads, then Other. You can now 
select the new folder you created on the external 
drive. Click Open to select it. From now on 
Safari will store all downloads on the drive.

If you do choose to store content on the 
external drive, while this may speed up your 
system, remember that the drive must be 
connected at all times for you to access your 
content. This may sound obvious but if certain 
apps like Photos cannot access your library 
on the external drive they may create a local 
one in your account’s folder with none of your 
personal data. If this happens, open the 
library on your external drive once again 
by double-clicking.

Remember that Time Machine does not, 
by default, back up external drives. You can 
change this by opening System Preferences, 
clicking Time Machine, then on Options at the 
bottom right. Highlight your external drive in 
the list and click the ‘–’ button to include it in 
backups to your Time Machine drive. This may 
take up a lot of space so make sure your Time 
Machine drive has plenty available.

1 Consolidate iTunes files
Open iTunes and click iTunes > 

Preferences. Click on the Advanced tab 
and make sure ‘Copy Files to iTunes 
Media folder when adding to library’ 
is checked. Click OK, then click on File 
> Library > Consolidate files.

2 Move your iTunes folder
In Finder, navigate to Music/iTunes in 

your account’s folder. Click once to select 
the iTunes folder then ≈-click to copy it. 
Navigate to your external drive and 
choose Edit > Paste. Don’t delete the 
original iTunes folder just yet.

3 Update iTunes
Open iTunes and click Preferences. 

In the Advanced Tab click on the Change 
button besides ‘iTunes Media Folder 
location’. Navigate to the new iTunes 
Media folder on your external drive, 
and click Open.

HOW TO Store your iTunes library on an external drive  



ith unnecessary files and 
apps removed and large 
files moved to an external 
drive, if there’s still no 
noticeable improvement in 

system performance, there are further 
modifications you can make.

First, check for new system updates. 
You can usually do this by opening the 
App Store and clicking Updates. If you’re 
having trouble with the Mac App Store, 
consider downloading a Combo Update 
directly from the Apple Support website.

In the Spotlight
The Spotlight search feature – accessed by 
clicking on the magnifying glass at the top 
right – functions as a system-wide search 
engine. Each time you create or modify 
content, Spotlight ‘indexes’ it so you can find 
it later on. As handy as this indexing is, it can 
sometimes go awry. You also may not want 
to index certain folders for privacy reasons.

If macOS gets stuck reindexing files, 
this can slow down your system. Go to the 
Spotlight pane in System Preferences. Click 
on the Privacy tab to see locations which are 
excluded from indexing. Click the ‘+’ button 
and choose your startup disk, which is 
usually named Macintosh HD. You will see 
a warning message stating that this will 
disable the search feature. Click OK.

Select on your Mac hard drive in the 
Privacy tab and remove it from the list using 
the ‘–’ button. These steps force the Mac to 
‘reindex’ your data, which can improve 

search speeds. If you do not 
want to index certain folders 
such as your personal 
Documents folder, take this 
opportunity to add them 
now using the ‘+’ button once again.

Leave the Mac on for a few hours to allow 
reindexing to complete. You can check the 
progress by clicking the Spotlight icon again.

Fixing Finder
By default, when you open Finder, it will 
display every file in your account. If you 
have a large number of files this can take a 
long time to load. You can change the default 
view from All My Files to something else 
by opening Finder’s Preferences. In the 
General tab, find ‘New Finder Windows 
Show’ and click on the pop-up menu to 
change to another location, such as your 
home folder. If Finder is still sluggish, click 
Go and Go to Folder. Type ‘~/Library/
Preferences/’ and press Return. Choose 
View > As List. Find the file named ‘com.
apple.finder.plist’ and move it onto your 
desktop. Restart your Mac, then delete 
that file from the desktop.

Dig a bit deeper for more 
system-sapping culprits

Add the Macintosh HD, then remove 
with the ‘–‘ button reindex Spotlight.

tweaks
Further

tips and

If it’s been a while since 
you updated, use a combo 
update to download all 
files in one go.
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Delete GarageBand Loops
GarageBand stores files in several 
locations, which can take up large 
amounts of space. Consider removing 
unncessary audio loops. Open Finder 

and click Go, then Go to Folder. Type 
‘Macintosh HD/Library/Audio/Apple Loops’ 
and press ®. Delete loops you no longer 
require and empty the Trash.

Disabling FileVault
Thanks to FileVault 2 and the recent trend 
towards SSDs in MacBooks, encrypting your 
system should not reduce performance 
noticeably. There are many online guides 
which recommend disabling FileVault to 
increase system performance. While it is true 
that using FileVault requires slightly more 
resources, as data has to pass through an 
‘encryption layer’, disabling the feature is 
unlikely to make much difference and leaves 
data vulnerable. If you have already enabled 
FileVault, we recommend you leave it as it is.

Purge virtual memory
Previously, we used Activity Monitor to see 
which processes were running and check the 

available amount of memory. As the system 
runs out of ‘virtual memory’, it will start to 
use your hard drive temporarily to free up 
memory for other tasks. You can tell the 
system to purge its virtual memory by 
clicking Spotlight and typing ‘Terminal’. 
Open Terminal and type sudo purge, then 
®. Enter your password and press ® again. 
The system's virtual memory will be cleared. 
More recent versions of macOS try to use 
memory efficiently, so this will probably not 
hugely speed up your system on newer Macs.

Reset SMC
Resetting the SMC (System Management 
Controller) is usually done to fix problems 
with starting up your Mac in the first place 
but it can help to remedy a sluggish system.

If you have a desktop machine, resetting 
the SMC is as simple as unplugging it from 
the wall, waiting 15 seconds, then plugging 
it back in. Wait five seconds then power on.

If you have a MacBook, shut it down fully 
and disconnect the charger. Next, with your 
left hand, hold ß, ≈ and å together while 
holding down the power button with your 
right hand. If you have a 2016 MacBook Pro 
with Touch a Touch Bar, the Touch ID button 
is also the power button. Keep all these keys 
pressed for 10 seconds, then release.

If the SMC reset fails to improve the 
Mac’s performance, there’s likely a hardware 
fault or your system files have been damaged. 
Read the next section for tips on attempting 
to repair damaged files and reinstall macOS.

Forcing your Mac 
to ‘reindex’ your 
data can improve 
search speeds

Delete the com.apple.finder.plist 
file, then restart your Mac to fix 
a sluggish Finder. 
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Most browsers support extensions 
– software add-ons, such as allowing 
you to save passwords. Sometimes 
clicking on the wrong link results in 
malicious extensions being installed. 
Usually these are designed to show 
adware – pop-up advertisements 
which are annoying and can slow 
down your system. While in Safe 
Mode, open Safari, then click Safari > Preferences. In the new 
window, click Extensions to see what you have installed. If you 
don’t recognise an extension, clear the checkbox to disable it. 
Click More Extensions to browse legitimate extensions for Safari. 
Install both Adblock Plus (adblockplus.org) and Ghostery 
(ghostery.com) to avoid harmful links and prevent websites from 
tracking you easily. Log out and repeat for each user on your Mac.

Excruciating extensions

Click Uninstall to remove extensions 
you don’t recognise.



Don’t back out of backing 
up – it’s so easy to set up

backups
Time

 Machine
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aving run through all the 
previous potential fixes, 
if your Mac is still running 
slowly, you’ll need to take 
more drastic steps. While  

your Mac may be experiencing hardware 
failure, if it is still functioning, however slowly, 
it’s more likely the problem has to do with your 
system software. If this is the case, try to run a 
backup of your Mac before doing anything else.

Time Machine
Your Mac has a built-in app for running 
backups named Time Machine. Time Machine 
makes daily backups of your data which it can 
then save either to an external hard drive or to 
an AirPort Time Capsule. The latter can create a 
fast wireless network and are useful for backing 
up several Macs, but an external USB hard 
drive is the simplest and cheapest option.  

The first time you connect an external hard 
drive, macOS will ask if you wish to use the 
drive for backing up. Click Use as Backup Disk 
to have Time Machine automatically format the 
drive to be compatible with your Mac and begin 
transferring files. This process will erase any 
data already on the drive, so try to have a 
dedicated one just for backing up. The capacity 
of the drive should be at least equal to the hard 
drive inside your Mac. For instance, if you 
have a 500GB hard drive in your Mac, use 
a 1TB external drive for backups.

All the data on your Mac will 
be backed up. You can go to System Preferences’ 
Time Machine pane to view the status of 
your backups at any time.

From here you can click ‘Show Time 
Machine in Menu Bar’ to display a Time 
Machine icon at the top right of the screen. 
Click this once to quickly view the status of 
backups. If you have already been using Time 
Machine, click this and choose Backup Now 
before proceeding further.

System Restore
Time Machine performs a complete initial 
backup, and subsequently keeps incremental 
backups of only files that have changed since 
the previous backup. It can display backups 
in chronologial order so you can, for instance, 
easily retrieve a three-month-old version 
of a Pages document.

The Recovery feature of macOS even allows 
you to restore your system to exactly how it was 
on the date a backup was previously run. This 

H

The first time you connect a new 
hard drive, choose ‘Use as Backup 
Disk’. The Mac will do the rest.



Time Machine 
backups are 
cumulative, so 
it only saves 
files that have 
changed since the 
previous backup

Technically, you could choose the 
first option – Reinstall macOS – to 
restore your system but it may not 
improve performance.
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can be useful if, for instance, your computer 
has some form of malware and you backed 
up just before it took hold of your system.

This feature, however, isn’t very useful if 
your system is running poorly due to corrupted 
system files. The reason for this is quite simple 
– if any of your system files were damaged at 
the time the backup was made, your Mac will 
simply be replacing files with older versions 
of themselves which may also be damaged. 
You’re likely to have more success by erasing 
the hard drive and restoring data from the 
backup manually. 

Target Disk Mode
The above steps assume that your system 
is running to the extent that you can actually 
run Time Machine. If this isn’t the case and you 
don’t have a recent backup, you still may be able 
to retrieve your personal files before wiping 
your machine and reinstalling macOS.

If you have access to two Macs with 
FireWire or Thunderbolt ports and the right 
cable, you may be able to use your Mac in 
Target Disk Mode. This is extremely simple 
to do. First connect the FireWire/Thunderbolt 
cable between the two Macs, then switch on 
your own Mac while holding down T.

A picture of a disk should appear on your 
screen. On the other Mac, your computer’s 

hard drive should then be accessible under 
Devices in Finder’s sidebar. Your personal 
data should be stored in the Users folder. It’s 
easiest to copy the folder named after your 
user account to the new computer. You can 
copy your own files back over to the old Mac 
once you’ve erased and reinstalled macOS by 
putting that computer into Target Disk Mode.

Last resorts
If you cannot use Target Disk Mode, you may 
be able to create an ‘image’ of your Mac’s hard 
drive using Disk Utility in macOS Recovery 
(go to apple.co/2nPc4bW for further advice 
on this). Once the copy process is complete, 
you’ll need to connect the drive to another 
Mac – you may want to do this at your local 
Genius Bar – to check that the files have 
been copied over properly.

This process doesn’t always work if files 
are corrupted. Your best bet in this scenario 
is to purchase an external hard drive and 
install macOS to it. You can then start up 
your Mac from that drive and try to access 
your files on the Mac’s internal hard drive. 

This won’t help you recover applications 
but you can copy and paste over any data you 
created in your home folder, located in /Users. 
The simplest way to do this is to copy the 
entire home folder to the desktop.

1Launch Disk Utility
Power on your Mac and hold down 

ç+R to start up in macOS Recovery. 
Choose Disk Utility. Next, click on your 
Macintosh hard drive on the left-hand 
side. If you’re using FileVault, choose 
File > Mount and enter your password.

2Create Image
Choose File > New Image > Image 

from Macintosh HD. In the panel that 
appears, open the Where pop-up menu 
and select your external drive. Under 
Format choose Compressed. Now 
choose Save.

3Verify Image
The image creation process can 

take several hours. Once complete, eject 
your external drive and connect it to a 
working Mac. Double-click on the .dmg 
file to open it on the new Mac to verify 
it can be mounted like a real disk.

HOW TO Create an image of your Mac’s hard drive  



nce you have backed up 
your data, you can eliminate 
any corrupted files by 
erasing the Mac’s hard drive 
and reinstalling macOS.

This is done in the macOS Recovery 
system. This is a separate area of your hard 
drive which contains tools to diagnose and 
fix problems such as the system running 
slowly or failing to start up.

Access the Recovery system by powering 
on your Mac and holding down ç+R. With 
luck you’ll see a welcome screen in various 
languages and an arrow button you can 
click to continue.

If for any reason Recovery fails to load, 
restart your Mac, start up with ç+å+R 

held instead. You’ll see a message stating 
‘Starting Internet Recovery’. If you see 
the Choose Network option, select your 
Wi-Fi network and enter its password 
to download Recovery.

Once the Recovery system has loaded, 
double-click on the fourth option, Disk 
Utility. Disconnect your back-up drive 
before going further, so you don’t 
accidentally wipe it.

Inside Disk Utility
Erasing is a scary word, so it helps to think 
of resetting your Mac back to its factory 
settings. Once Disk Utility has loaded, you 
can select your hard drive in the left pane 
and run First Aid to try to fix damaged 
sectors. Note, though, that this process 
also runs when you start the Mac in Safe 

Mode, as you did in the previous section, 
so it may not make a difference.

It’s also possible to reinstall macOS 
‘in place’ which replaces only system files 
and leaves your personal files untouched. 
However, this is time consuming and not 
guaranteed to fix the issues you’ve been 
experiencing. Ensure your Mac’s usual 
startup disk drive is selected on the left. 
This is usually named ‘Macintosh HD’. 
Next, click the Erase button in the toolbar.

Make sure that the format of the drive is 
‘Mac OS Extended (Journaled)’, then click 
the Erase button, bottom right. You’ll be 
asked to confirm then the drive will be 
erased. This should only take a few seconds.

Quit Disk Utility and you’ll be returned to 
the macOS Utilities window. If you connect 
to the internet via Wi-Fi, look at the top right 
corner of the screen and click on the Wi-Fi 
icon. Check that there is a black tick next to 
your own Wi-Fi network. If not, click it and 
enter your password.

Next, click Continue to begin reinstalling 
macOS. Click Continue again on the setup 
page and then on the blue Continue button.
macOS Recovery will check which system 

Fix your faulty system 
files by reinstalling the OS

Choose your Mac’s usual startup disk 
to begin downloading and installing 
macOS to it. 

macOS
Reinstalling

Run First Aid on the disk 
before reinstalling if you 
wish. If performance 
doesn’t improve continue 
with the reinstall.
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your Mac is eligible to run. Click to agree to 
the terms and conditions. You’ll now be 
asked where you wish to install macOS. 
Choose the drive you erased moments ago, 
unless you want to install macOS on an 
external drive (see above), then click Install.

The Recovery system will download the 
version of macOS you had installed to your 
hard drive; the time taken will vary 
depending on your connection speed.

Setup Assistant
Once the reinstall has completed, the Mac 
will go through the Setup Assistant, just as 
it did the day you first bought it. The options 
here are fairly self-explanatory and you can 
change any of these after the process is 
complete. If you have a recent Time Machine 
backup, you can quickly restore your user 
account using Migration Assistant. This 
only copies across personal files, such as 
Documents and Pictures and Application 
settings, without affecting the system files 
themselves. Connect your Time Machine 
drive to the Mac before proceeding.

In the Transfer Information section 
of the Setup Assistant, the system will ask 

if you want to transfer information ‘From 
another Mac, Time Machine Backup or 
Startup Disk’. Select this and then click on 
your Time Machine drive when it appears, 
then click Continue at the bottom of the 
screen. If your backups were encrypted, 
the system will ask for their password. The 
next page asks which info to transfer. It’s 
best only to select your home folder – leave 
Applications, Other Files, and Computer & 
Network Settings unchecked. You can 
reinstall Applications from the Mac App 
Store or download them from the internet.

The Setup Assistant will begin ‘migrating’ 
(copying) data from your most recent Time 
Machine backup to the computer. Once it’s 
complete you’ll be able to log in with your 
previous password. If you use your Apple 
ID to log in and have since changed your 
password, it will be the same password you 
used at the time you ran the backup; after 
logging in it’ll update to your new one.

If you have erased your hard drive 
and reinstalled macOS, this should have 
eliminated any software issues. If the system 
is still slow and you chose to migrate your 
data from a previous backup, try repeating 
the above steps and set up an entirely new 
user account without any of your data. This 
will help you know for sure whether the 
problem is with your Mac’s hardware. 

If you’re still experiencing issues, then 
it’s best to have your device examined at 
a Genius Bar or an Authorised Service 
Provider (locate.apple.com). 

If you have 
a recent Time 
Machine backup, 
you can restore 
your user account 
using Migration 
Assistant

You can choose to bring back all 
your data but it’s best just to tick 
your user account and download 
applications later.
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The macOS Recovery system can 
install the OS to an external drive, 
then boot from it. If you use an SSD, 
you may find the speed of your Mac 
improves considerably, as these 
drives have no moving parts and use 
‘flash’ memory. Your best option is 
to replace your Mac’s hard drive 
with an SSD, but this can be tricky 
compared to plugging in an external 
device, and could invalidate your warranty. To proceed, connect 
the external drive and follow the steps detailed in this section, 
but choose your SSD (under External in Disk Utility’s left pane) 
instead of the Mac’s internal hard drive. Select the SSD itself, 
not a volume on it. Once complete, hold down å as the Mac 
starts up and select the SSD to start up from it.

Installing to an external drive

Hold down å at startup and select 
the external drive to start up from it.
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 Understand iOS gestures

EditEd by jo membery 

What’s inside 

50-52 
create a book in 

ibooks author  
 Create textbooks or pen 
a novel with this free app

53
in your pocket 

 View saved web content 
at any time on any device 

54-55 
convert old 
video to mp4

 Get old video files 
working again   

56-57 
find your way 

with maps
 Get directions, and 

more, from iOS 10 Maps 

58-59 
get the news 

you want
 Create a personal news 

service with Reeder

 When you see a shortcut like 
ç+å+C, hold all but the 
last key, then press that one.

 ç is the Command key, 
which is also labelled cmd.

 å means the Option key, 
labelled alt or opt.

 ≈  means the Control key, 
labelled ctrl, and shown as ^ 
in shortcuts in the menu bar.

 ß  is the Shift key, which is 
typically just labelled shift.

 ∫  means the Delete key, 
which deletes to the left of the 

insertion point. Press ƒ+∫ 

to delete to the right.

 † is the Tab key, which shifts 
the focus between some 
controls in windows and web 
forms. Turn on Full Keyboard 
Access in System Preferences 
to jump between all controls.
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 master mac keyboard shortcuts

 A tap is a brief contact of 
(usually) one finger on your 
device’s screen.

 To drag is to move a finger 
across the screen to scroll 
or pan around content.

 Swipe means move one or 
more fingers across an item 
or the screen, then let go. 
 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.

 Pinch means move two 
fingers together or apart, 
usually to zoom in or out.

 Touch and hold means lightly 
rest your finger on an item 
and wait for a reaction.

Your new-look guide to 
getting more from 

your Apple kit

new 
ideas

convert 
old video 

to mp4
p54
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1

2Choose template and layout
You will now be asked to choose a template. These are 

grouped into Portrait and Landscape layouts. Landscape is 
best for photo albums and cookbooks. Portraits are better 
for novels. Click Choose when you’re done.

1 Install iBooks Author
Open the Mac App Store and type ‘iBooks Author’ in the 

top right. Click Install under the name of the app, which is 
around 405MB and sign in with your Apple ID when 
prompted. Finally click Open to launch. 

 How to Create your book 

1

Book pane
 Click here to 

navigate between 
individual pages 
which will then 
load into the 
preview pane.
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Create a book in 
iBooks Author 
Create snazzy textbooks or pen your next 
novel with this free app

IT wILL TAKE
 30 minutes

yOu wILL LEARn
 How to create, modify 
then export your book

yOu’LL nEEd
 OS X 10.11 or 

later, an iTunes 
Connect Account, 

iTunes Producer

Are you a budding author? 
Perhaps you want to pen the 
next great British novel or 
have an idea for a textbook. 

The iBooks Author app allows you to easily 
create your own book from scratch, using 
a variety of fonts and multimedia.

Start by choosing your template and page 
layout, then add text, pictures, videos and 
more. The app is tech savvy, allowing you to 
add interactive content, such as surveys and 
animated images too. The interface is very 
much drag and drop; you can move content 
from Finder such as images and text will flow 
around it.  If you decide not to sell exclusively 
through iTunes U, you can also export your 
book in PDF or ePub format. With over 
one billion Apple devices in use around the 
world, there’s no reason not to get started. 
You retain the copyright on any original 
content in your work. nate drake



iBooks Author APPLE SKILLS

Genius Tip!
 Project Gutenberg 

(www.gutenberg.org) 
has thousands of free 
books you can use to 
practise with iBooks 
Author before writing 
your own.

Jargon Buster
 template The initial 

settings of your book, 
such as the layout and 
basic fonts. 
 widgets Advanced 

features for ebooks like 
adding a YouTube video.

2

4

3 5

4Choose intro media
Click Intro Media in the Book pane. You can drag 

in an image or movie here just as you did with the cover. 
Any video content will be ‘optimised’ for use with iBooks 
but will still increase the size of the file.

3 Create your book cover
Click Book Title in the Book pane. Click on Book Title 

and ‘Lorem ipsum’ and write the title and author. Right-click 
on the stock image and choose Delete. Open Finder and 
drag in your own cover image.

2

Preview pane
 You can work on 

individual pages 
here by modifying 
objects or adding 
new content using 
the buttons above.

4

Format bar
 This can be used 

to change the 
size, font, colour, 
alignment and 
line spacing of 
your text.

5

Preview 
and Publish
 Click Preview to 

open your book in 
iBooks. The Publish 
button exports the 
book in .ibooks or 
.pdf format.

3

Add content 
buttons
 Add simple 

text boxes, 
shapes, tables 
and charts as 
well as advanced 
‘Widgets’ via drag 
and drop.

 macformat.com  @macformat MAY 2017 | MACFORMAT | 51



APPLE SKILLS iBooks Author

10Preview and export
Once you’re finished, click Preview at the top to open 

the book in iBooks. If you want to publish through iTunes, visit 
support.apple.com/en-gb/HT201183 to register as an author. 
Alternatively, choose File > Export to save the book as a PDF. 

8Add pages
Click on Chapter where you wish to add pages, then click 

the Add Pages button. Hover over Pages. Click on the page 
type, eg Two Column, and it will appear. Jump to the page 
by clicking on it in the Book pane.

6Modify content
Click on the ‘Lorem ipsum’ box. Use ç+a to select 

all text. Either type or paste in your own text for the preface. 
You can also delete the stock image on the left and drag in 
one of your own as you did before.

9 Insert widgets
The easiest way to add new content to pages is simply 

to drag and drop it into the page. Click the Widgets button 
at the top for more advanced features, eg an HTML page 
with an embedded Youtube video. 

7Add chapters
Click the Add Pages button and choose Chapter > Chapter. 

Click Untitled in the Book pane to name this chapter, then 
modify the ‘Lorem ipsum’ text. Change the size/font using 
the format bar at the top.

5Add preface
Right-click Chapter 1 in the Book pane, then click Delete 

Chapter. Click the ‘+’ (Add Pages) button at the top left, then 
Chapter > Preface. Click on Untitled in the Book pane to give 
the Preface a name. 

 How to Create your book 
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Save content for later
View your saved web content at any time on any device with Pocket

IT wILL TAKE
  5 minutes

yOu wILL LEARn
  How to use Pocket 

with Safari to manage 
your websites

yOu’LL nEEd
  A Mac with Safari 

5.0.1 or later

Students and researchers 
rejoice! The basic version of the 
Pocket extension is now available 
free for Safari and allows you to 

tag and search through previously saved web 
content. Once added, the Pocket button 
appears to the left of your address bar. Click 
this any time or right-click on media to save 
to your Pocket list. Life is made even simpler 
with Pocket List’s features including adding 
tags and favouriting content to allow you to 
search for it more easily. 

iOS users can take Pocket with them by 
installing the app from the iTunes Store, then 
saving content to their Pocket List via the 
Share menu. Simply sign in with your Pocket 
account to sync content between your iOS 
device and the Mac.

This guide focuses on the Pocket extension 
for Safari but it’s also available for other major 
browsers. There’s even a dedicated Pocket 
app in the Mac App Store if you prefer 
working offline. Juggling web pages has 
never been so simple! nate drake

How to Install Pocket and manage websites 

1 Install Pocket
In Safari, go to getpocket.com/safari. 

Click Download to go to the Safari 
Extensions Gallery. Click Install Now. 
Sign up for Pocket and log in. Pocket will 
now install. Click Start Saving to begin.

2Save your content
Click the Pocket button to the 

left of the address bar on any page. 
A confirmation will appear. For videos/
images, right-click then Save to Pocket. 
Click Open Pocket to see saved pages.

3 Favourites and Tags
Hover over any item to view the 

options at the bottom right. Click the star 
to favourite an item. Click Edit tags to add 
keywords. Click Tags on the left-hand side 
to search content by keyword.
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Convert 
old video 
to MP4
Get old video files 
working again with 
all your Apple devices

IT wILL TAKE
  15 minutes

yOu wILL LEARn
  Convert video to 

MP4/H.264 format; 
tweak quality settings

yOu’LL nEED
  Handbrake  

(www.handbrake.fr), 
a collection of 
old video files

Ever struggled to get video 
to play on your Mac, iPad or 
other device (such as your 
Apple TV)? That’s because 

video is made up of multiple components: 
the file itself (known as the ‘container’), plus 
its content in the form of its video and audio 
(known as ‘codecs’). It’s possible to mix and 
match these to the extent that two seemingly 
identical files with the same file extension 
behave in different ways – as in, one will 
play, the other won’t.

These days, the safest solution is to ensure 

all your video files conform to a standard that 
will work across all your devices. But if you’ve 
got a collection of videos – particularly older 
files – that don’t conform, what can you do?

The answer lies with a free, open-source 
tool called Handbrake (handbrake.fr). This 
miracle worker can convert just about any 
video file into a standard format, which 
basically translates into a MP4 container (in 
other words, a file with a .mp4 or .m4v file 
extension) and H.264 video codec and AAC 
audio codec. Read on to discover how.  
nick Peers

1

Source
 Select your file, 

plus limit your 
selection by 

angle, chapters, 
seconds or 

frames if 
applicable.

3

Quality
 Increase the RF 

for greater 
compression, 
but lesser 
quality. Aim 
for 20 (HD) 
or 21-22 (SD).

2

Encoder
 Choose H.264 
(x264) for max 

compatibility. 
Set FPS to ‘same 

as source’, 
constant 

framerate.

4

Encoder 
options
 Set the type of 

video using the 
Tune dropdown 
menu, nudge the 
preset slider up 
to Very Fast.

explained… Handbrake basic settings 

1

2 3

4
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1Select source
When Handbrake opens, select the 

video file (or folder containing multiple 
files) that you wish to convert. If you 
select a folder full of files, select the 
first video you wish to convert via 
the Title drop-down.

2Choose clip length
You can trim unwanted parts from 

the video file using the Chapters drop-
down menu to select Seconds or even 
Frames to choose exactly what to keep  
– simply set your start and end times, 
frames or chapters.

3Select a preset
Click Toggle Presets if necessary 

to reveal a set of optimised presets for 
different devices. To make your video 
play on any Apple device, choose one 
of the Apple settings, such as 540p30 
for non-HD movies.

4Set basic settings
The default Video tab is where 

you tweak basic quality settings. See 
the annotation for a guide to doing so. 
Tick Fast Decode to ensure your video 
plays without stuttering on all devices, 
even low powered ones.

5Tweak Picture settings
Switch to the Picture tab. The 

default settings should be fine here – 
however, if your finished movie suffers 
from motion judder or a ‘combing’ effect, 
experiment with different Decomb and 
Detelecine filter settings.

6Select audio stream
Click Tracks > Add All Tracks if no 

audio track has been added on the Audio 
tab. Select AAC (CoreAudio) as your 
codec, and use the Mixdown drop-down 
menu to choose between stereo, mono 
or surround (if offered).

7Add subtitle track
If your original video has embedded 

subtitles, select it under Subtitles. If the 
video contains subtitled content (such 
as foreign speech), choose Foreign 
Audio Search and tick both Forced 
Only and Burned In.

8Convert video
Click Browse… next to Destination 

to choose where to save your converted 
file. Click Start to convert the video now. 
Once complete, play the video – if it’s 
not the desired quality, change the 
settings and try again.

9More tips
Click Add to Queue to set up 

multiple videos for conversion. When 
done, click Start to process them in 
sequence. If experimenting with 
different settings, click Preview to 
see their effect on a 30-second clip.

 How to Convert video in Handbrake 
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Find your 
way with 
Maps
Find points of interest  
and get directions in 
iOS 10’s Maps app

IT wILL TAKE
  5 minutes

yOu wILL LEARn
  How to search for 

places, get turn- 
by-turn directions 
and take a detour

yOu’LL nEEd
  An iPhone with 

internet and 
GPS connections

Apple’s Maps app has come 
along leaps and bounds since 
its rather poor debut in 2012. 
As well as plotting directions to 

get from A to B by car or on foot, it now offers 
public transport directions in the UK, and it 
can tell if a ride booking service that serves 
where you are has its own app, and provides 
links to download and use them.

You may still find Maps doesn’t know as 
much about businesses as Google Maps, so 
the more info you provide the better. ‘Pickwick 
Lodge Farm B&B’, say, might not be enough – 

a town, a street, or especially a postcode will 
help. The app stores some recently viewed 
maps on your iPhone, but you need an 
internet connection to access these.

For turn-by-turn navigation, it’s a good 
idea to get a windscreen mount for your 
iPhone. GPS drains the battery faster than 
usual, so an in-car charger is advisable.

In Settings > Maps, if Show Parked 
Location is on and your car has Bluetooth or 
CarPlay tech, Maps marks your car’s location 
when you park to help you find it again. 
Rob Mead-Green

1

Info panel
 This initially shows a 

search bar and places 
nearby. It changes as you 

search or tap the map.

3

Mark location
 Drop a pin by holding a 
finger on the map. The 

info panel shows the 
address and distance.

2

Search bar
 Enter a place name, 

address or postcode. 
Enter a Contact’s name 

for their address info.

4

Your location
 Tap the arrow to 

recentre on location. Tap 
again to reorient to the 
direction you’re facing.

5

More options
 Tap the ‘i’ for more 

options, such as switching 
between map and 
satellite views.

6

Weather conditions
 This shows the weather 

and temperature right 
now at the location that 
the map is currently on.

explained… Navigating the Maps app 

1

5

6

2

3

4
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1Where to?
The app shows the map and the info 

panel. Swipe up on the panel to browse 
smart suggestions of where you might 
want to go, including any address on the 
Clipboard, the last pin you placed, past 
searches, and your favourite places.

2Specific destinations
To go elsewhere, tap the search bar 

and enter details if you have somewhere 
specific in mind, or tap the category icons 
below the bar to find nearby amenities; 
tap one on the map or panel for details 
and an option to get directions to it.

3Manually pinpoint
Alternatively, pinch and swipe the 

map to find where you want to go, then 
rest a finger on it to mark it with a pin. 
Swipe up on the panel to take an action 
– share the location, set it as a favourite, 
fine-tune the pin’s placement and more.

4Get route suggestions
With a destination set, tap the blue 

button on the panel for a route, starting 
where you are. At the foot of the screen, 
choose a mode of travel: driving, walking, 
public transport or a ride booking service 
(if there’s an app that covers your area).

5Overview and options
Tap the words ‘My Location’ to set 

a new starting point, then tap Route to 
refresh the route. For public transport, 
tap Leaving Soon to set a travel time. 
In the panel, tap the route for a list 
of directions, and to share them.

6Alternative routes
Alternative routes are shown as 

fainter lines; tap one to select it, or swipe 
up for a list. You’ll see Options below –
Driving Options enables you to avoid tolls 
and motorways; for public transport, 
Transport Options shows different types.

7Get a better view
Tap Go next to a route to start being 

guided. Tap the summary at the foot of 
the screen for options to divert for petrol 
or refreshments; tap one and you’ll see 
how much time it’ll add. An option at the 
screen’s top resumes your main journey.

8Changing a journey
To stop turn-by-turn navigation or 

alter the route, say to avoid traffic jams, 
tap End, then start again. You can press 
the Home button and use other apps 
during a journey – the status bar turns 
blue. Tap the bar to resume directions.

9Look ahead
When you’re following the app’s 

walking directions, the bar at the top 
of the screen, which shows the next 
instruction to follow, has a series of 
dots under it. Swipe horizontally on the 
bar to see later turns along the route.

 How to Use turn-by-turn directions 
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Get the news you want
Create your own personal news service with the powerful Reeder 3 app

IT wILL TAKE
  15 minutes

yOu wILL LEARn
  How to combine 

multiple RSS 
newsfeeds and 

aggregator services

yOu’LL nEEd
  iPhone/iPad, iOS 9 or 

later, Internet access

Apple’s news app is a handy 
way of gathering news stories 
from a wide range of 
newspapers and magazines, 

yet it barely scratches the surface of all the 
information that is available on the Internet 
every day. Another way of creating your own 
personal news service is to use RSS newsfeeds 
(Really Simple Syndication). 

Many companies and websites have 
their own individual RSS feeds – such as our 
colleagues at TechRadar (techradar.com) 

– and there are ‘aggregator’ services such as 
Feedly and Feedbin that work like Apple News 
by drawing together lots of newsfeeds from 
around the web. But if you’re a real news 
junkie, you can really take control by using 
Reeder, a newsreader app that can combine 
multiple newsfeeds and aggregator services. 
The new Reeder 3 iOS app costs £4.99, but it’ll 
earn its keep by making sure you’ve always 
got plenty of interesting reading material 
when you’re travelling or just chilling out 
at the weekend. Cliff Joseph

How to Manage your reading matter 

1Power to the people
Reeder is a power-user app for news 

junkies. It assumes that you already know 
how RSS services work, so when you 
launch Reeder for the first time it simply 
presents you with a blank screen and 
leaves you to get on with it.

2Pick and mix
Click the ‘+’ symbol at the top of the 

screen to see the services that Reeder 
supports. You can subscribe to RSS feeds 
from individual websites, or link Reeder 
to your account on an aggregator service 
such as Feedly.

3Read all about it
If you want some suggestions to 

get started, try Feedly, The Old Reader 
and TechRadar. Feedly does have its 
own app – as do most of its rivals – but 
using Reeder allows for multiple 
services within a single app.
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CoNtINUED… Manage your reading matter 

4Browsing the news
At the bottom of the screen, you’ll 

find icons for three ‘filter’ modes. The 
first icon displays ‘star’ news items that 
you want to keep for later. The second 
icon only displays unread items, while 
the third icon shows everything.

5On the slide
Reeder borrows a few tricks from 

Apple’s Mail app to help you manage the 
daily barrage of news. Sliding your finger 
to the right quickly marks an item as read 
or unread, while sliding left will ‘star’ it as 
an item to remember.

6Digging deeper
If you want to follow up a particular 

story, you can slide your finger left again 
while reading, and Reeder will open the 
original story in its built-in web browser, 
allowing you to explore the publisher’s 
website and related stories.

7Save it for later
If you want to keep a story for future 

reference then you can add it to your 
Safari reading list, or save it to an 
external service such as Instapaper or 
Evernote. And, of course, you can share 
stories on FaceBook and Twitter.

8News management
If you’ve fallen a bit behind with 

your reading, you can quickly mark 
multiple news items as ‘read’ to get them 
out of the way. Just tap-and-hold on any 
news item and you can mark all the 
stories above it or below as ‘read’.

9Easy on the eye
If you’re using Reeder on an iPhone 

with a relatively small screen then you 
can change the typeface and size to 
improve readability. People with poor 
eyesight can also change the colours 
used for both text and background.

10Controlling the news
By default, Reeder displays the 

newest items first, but its General 
Settings menu allows you to show the 
oldest items instead. You can change 
other settings too, such as the way that 
the left and right swipe commands work.

11 Information overload    
Although Feedly collects newsfeeds 

from around the web, you can manage 
those feeds within Reeder, rather than 
having to switch back to the Feedly app. 
You can unsubscribe feeds or, say, merge 
‘tennis’ into a more general ‘sporty’ list.

12Refreshing Reeder
The Refresh menu is a key option. 

Background refresh can drain your 
battery quickly, so it’s best to tell Reeder 
to check for new stories ‘On Start’. You 
can also refresh stories manually, by 
using the iOS pull-down gesture.
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 macOS Sierra requirements

EditEd by GRAHAM BARLOW 

What’s inside 

62-63 
MAsteR MissiOn 

cOntROL  
 Work more efficiently 
with multiple desktops

64-65
fAceBOOk 

inteGRAtiOn 
 Sierra keeps you in touch 

with Facebook contacts 

66-67 
RecOveR fROM 

MAjOR pROBLeMs
 What to do if macOS 

Sierra won’t start 

 macOS Sierra introduces 
Siri to the Mac.

 You can use Apple Pay on 
your Mac with macOS Sierra.

 Picture-in-picture – extract 
a video from a website and 
watch it from your desktop.

 By default, Desktop and 
Documents folders are 
uploaded to iCloud Drive.

 macOS offers the smartest 
continuity features to date.

 You can now start/pick up 
an iPhone call from your Mac.

 You can also send and 
receive SMS text messages 
from your desktop.

 Handoff works with a 
number of built-in apps, 
allowing you to start work  
on one device and finish 
off on another.

may 2017 | MAcfORMAt | 61

 the benefits of running macOS Sierra

 macOS Sierra works on 
Macs dating back to 2010, and 
MacBooks and iMacs to 2009.

 You need to be running 
Mac OS X 10.7 or later.

 You need 8.8GB of available 
storage.  

 Back up your Mac before 
upgrading; go to support.
apple.com/en-gb/HT201250 

for advice on using 
Time Machine.

 Go to the Mac App Store 
and download the free 
macOS Sierra upgrade.

sieRRA
Your new-look guide to 

getting more from 
macOS Sierra

neW 
sectiOn

Genius Tip!
 Optimise your 

storage Go to System 
Preferences > iCloud 

and click Options next 
to iCloud Drive. If you 
choose Optimise Mac 

Storage, files that you 
don’t use very often 

will be uploaded to 
iCloud. You’ll still see 

the file names on your 
Mac; simply click on a 

file name to download 
the file from iCloud 

again and open it. 

MAsteR 
MissiOn 
cOntROL 

p62
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Master Mission Control
Work more efficiently with multiple desktops in macOS Sierra

IT wILL TAKE
  15 minutes

yOu wILL LEARn
  How Mission Control 
can help organise your 
apps and your desktop

yOu’LL nEEd
  macOS Sierra 

(some features work 
in older versions)

Mission Control has been a 
feature of OS X (now macOS) 
since 2011, when it appeared 
as part of OS X 10.7 Lion, but 

its roots go back to Exposé, which made its 
debut back in 2003 with OS X 10.3 Panther. 
As the name implies, Mission Control can act 
as the control centre from which you run your 
Mac. In reality, you could use your Mac for 
years without ever activating it, but it’s handy 
when you need to find that one crucial app 
you’ve lost, or you simply need to get a handle 
on which apps you have running.

Apple refined Mission Control with the 
release of OS X El Capitan in 2015: the desktop 
background in Mission Control is not blurred 
like it was in previous versions, and thumbnails 
of virtual desktops don’t appear until you 
cursor moves over them.

Here we’re going to show you how to use 
the features of Mission Control in macOS 
Sierra, how to manage your apps and different 
desktop spaces, and how you can customise 
Mission Control in the Settings app. So, let’s 
take control of your Mac and get started!  
Alan Stonebridge

1

Running apps
 When you enter Mission 

Control, all the apps currently 
running minimise to their 
own well organised areas 
of the screen, so you can 
see what’s going on. 

3

Desktop spaces
 The desktop spaces 

you’ve created, like multiple 
monitors to swap between, 
can be accessed from the 
top bar. Click the + to open 
a new space.

2

Top bar
 Move the cursor to the 

top of the screen in Mission 
Control to reveal the top bar, 
where you can access all your 
desktop spaces.

4

The Dock
 The Dock stays visible 

throughout Mission Control, 
which means you can still 
launch your favourite 
apps at any time. 

explained… Stay in control 

1

2 3

4
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Mission Control SIERRA SKILLS

1Activate Mission Control
To activate Mission Control, swipe up 

with three fingers on your trackpad. All 
open applications will spread to corners 
of the desktop, showing exactly what’s 
running. To return to a standard desktop 
just swipe back down the same way.

2Switching apps
Your apps still run as normal in their 

minimised state, so videos keep playing 
and web pages update. To switch to a 
particular app, click on it. This returns 
you to a standard application view, but 
with the app selected in the foreground. 

3Adding a new desktop
With macOS, you can have many 

desktop spaces; in Mission Control, move 
your cursor to the top bar to reveal them. 
To add a new space, click the + in the 
right corner. To delete a space, hover 
the cursor over it and click the X. 

4Moving apps
To organise apps into different 

desktops, open Mission Control and drag 
and drop an app into a new desktop at 
the top of the screen. Drop it onto the + 
symbol at the top right and you’ll create 
a new desktop to drop the app into. 

5Adding app spaces
You can drag apps to the top bar and 

let them ‘float’. These apps don’t belong 
to a desktop – they can be accessed via 
Mission Control or the å+† app 
switcher. You can drop another app 
on them to enter Split View mode. 

6Mission Control settings
To customise Mission Control, open 

up System Preferences from the Dock 
and choose Mission Control in the top line 
of icons. Here you can choose a different 
way of launching Mission Control from 
the pop-up menu. Try it! 

7Dashboard settings
Dashboard is turned off by default 

in macOS Sierra. In Mission Control’s 
settings you can turn it back on and 
overlay Dashboard onto your desktop or 
give it its own space. Choose an option 
and hit ™ to launch Dashboard.

8Change shortcuts
You can change keyboard, trackpad 

or mouse shortcuts to Mission Control, 
Dashboard and Show Desktop in Mission 
Control settings, but if you press ß, ≈, 
å or ç while looking through, you’ll find 
you can add these keys to the choices. 

 How to Navigate Mission Control in Sierra 

Group by app
By default, thumbnails in Mission 
Control are displayed as a single 
layer in Sierra. To change this, check 
‘Group windows by application’ in 
the Mission Control settings. 
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macOS Sierra 
makes it easy 
to share pics 

or web pages 
on social 

media sites
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Facebook integration
IT wILL TAKE

  5 minutes

yOu wILL LEARn
  How to make social 

networking simpler 
from your Mac

yOu’LL nEEd
  macOS Sierra, 

a Facebook account 
 

macOS Sierra integrates well 
with social networks, making it 
easy to share pictures or web 
pages via Flickr or Vimeo, post 

to Twitter and more. Here we’ll focus on 
Facebook, but the principles are the same 
for the other supported social networks. 

Once you have Facebook configured, you 
can send things to it from a range of apps. 
Your Facebook friends are added to Contacts, 
complete with profile photos. Any changes 
they make to their details on Facebook are 
updated automatically in the Contacts app. 

Facebook notifications come straight to 
Notification Center. You can post to Facebook 
without needing to sign in through a browser, 
because you’re already signed in with your 
Mac’s OS. You can share photos, web pages 
and all kinds of other content directly from the 
Share button, which appears in a wide range 
of apps; simply select Facebook from the list, 
add a note, click Post and it’s done. 

Once you sign into Facebook in macOS 
Sierra, you can connect and share with friends 
directly from your desktop. If Location 
Services is switched on on your Mac and 
you’ve given Facebook access to it, you can 
share your location with your Facebook posts 

by clicking the location indicator at the foot 
of the Facebook Share Sheet. 

You can choose to share each post with 
a different group, rather than all your Friends, 
by selecting a group from the drop-down list 
at the top left of the Facebook Share Sheet. 

If you opt to share a photo to Facebook, 
you can choose which album to put it in. This 
option appears as a drop-down list at the top 
right corner of the Facebook Share Sheet; or 
you can simply add it to your Timeline. 

In these guides, we’ll explain how to link 
your Facebook account to macOS Sierra then 
show you some of the options this gives you 
in a range of different apps. Craig Grannell

How to Connect your account  

1Link your Mac
Open System Preferences and click 

Internet Accounts. This is where you 
manage online accounts for email, 
appointments and social networking for 
the likes of Facebook and Twitter. Click 
Facebook in the list of services to begin.

2Choose Facebook
In the right pane, you’ll see a range 

of online services that integrate directly 
with macOS Sierra, including social 
networks. Choose Facebook, then enter 
your Facebook username and password. 
Click Next to continue the process. 

3Permission summary
Sierra provides you with a summary 

of permissions that you’ll be granting, 
including access to Facebook contacts, 
the ability to post updates and photos 
and working with apps. When you’re 
done, click Sign In to finish. 

Sierra keeps you in touch with Facebook contacts all the time 

Once you sign into Facebook in macOS Sierra, you can 
connect and share with friends directly from your apps. 



Facebook integration SIERRA SKILLS

Sharing made easy
Open Notification Center, go to the 
Today view and click Edit at the 
bottom. Click the green + alongside 
Social and a Social widget will be 
added to the left-hand pane. 
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How to Master Facebook’s features within Sierra  

1Contacts
Sierra accesses Facebook contacts 

and imports them into local Contacts so 
you can use them from any application 
on your Mac. If you change your 
Facebook password, return here, click 
Details and provide your new password. 

2 Import friend photos
To import contact photos from 

Facebook avatars, select your Facebook 
account in the Internet Accounts pane 
in System Preferences. Click Get Profile 
Photos, then click Update Contacts to 
download the pics to your address book. 

3Share a page
Now you’re set up, sharing a web 

page via Facebook is easy. In Safari, 
browse to a web page. Click the Share 
button in the address bar and you’ll see a 
drop-down list of sharing options. Select 
Facebook from the list to share the link. 

4Add a message 
You‘ll see a Facebook Share Sheet. 

Click the drop-down list (top left) to set 
who to share the page with – by default, 
all friends, but you can choose a list (set 
up via the Facebook website). Type your 
status update, then click Post. 

5Use Location Services 
You can automatically add your 

location to a post. Click the Location 
Services arrowhead (bottom left of the 
Share Sheet), and you’ll be taken to the 
Privacy options to configure the service 
to allow Facebook to use your location. 

6Privacy options
You can select applications that you 

want to have access to your location. 
Ensure Facebook is ticked, return to 
the Share Sheet and click again to add 
location, then Post. For other privacy 
options, visit the Facebook website. 

7Post a photo
Sharing a photo via Facebook is just 

as easy as sharing a web page. In Finder, 
locate the picture, then right-click on it 
and select Share > Facebook. Now simply 
choose the people you want to share it 
with, and add a brief message.

8Choose an album
At the top right of the Share Sheet 

is a drop-down list that enables you to 
choose where to post the picture. Select 
an existing photo album, or Timeline to 
add it to your Facebook timeline. Click 
Post to publish it to your friends. 
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Recover from major problems
IT wILL TAKE

  15 minutes

yOu wILL LEARn
  How to get your Mac 

up and running again 
after a serious issue 

yOu’LL nEEd
  macOS Sierra 

(some features work 
in older versions)

Recovery is a built-in set of 
tools, hidden until you start up 
your Mac holding down ç+R 
when you hear the startup 

chime. You should only need to use it in a rare 
emergency – typically when some drastic 
glitch prevents macOS Sierra loading.

Recovery looks like macOS, but capabilities 
are limited to essential maintenance tools to 
help you get up and running after a critical 
problem. Apple has made restoring a Mac 
from a Time Machine backup almost as easy 
as turning on that feature in the first place. 
In fact, it’s even possible to download and 

reinstall the whole operating system. If you’re 
daunted by the prospect of fixing something 
you perhaps don’t understand, then there’s 
one feature of Recovery that you’ll find 
invaluable: its web browser. With it, you can 
search for solutions, go online to book a 
Genius Bar appointment, or look up the 
contact details of an authorised repair centre 
if there are no Apple stores close to you. 

Recovery’s other features include the 
ability to reset any user account’s password, 
should one be forgotten. Check out support.
apple.com/en-gb/HT202860 for more on this. 
Alan Stonebridge

1

Rescue options
 Recovery allows you to… roll 

back to an earlier state using 
Time Machine; install macOS 
over itself, or erase the 
internal disk first for a 
completely clean start.

2

Research a problem
 The Safari web browser is 

available in Recovery 
to research problems.

3

Disk Utility
 You can run diagnostic 

scans of your Mac’s storage, 
or erase it altogether.

4

Additional utilities
 Firmware Password Utility 

increases security; Network 
Utility tests connectivity; 
Terminal enables you to 
perform detailed diagnosis 
using various commands.

explained… Recovery mode 

Tools to get you out of a sticky situation if macOS Sierra won’t start

1

2

3

4
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1Start Recovery Mode
To start Recovery from your Mac’s 

internal storage, hold ç+R at the 
startup chime. To start it from an 
external drive, hold å instead; when a 
list of available startup volumes appears, 
choose the one with an external drive 
icon and ‘Recovery’ in its label.

2 Internet Recovery
If a Recovery partition isn’t available, 

holding ç+R will start Internet 
Recovery (on models released since OS X 
Lion, and some earlier models – see 
support.apple.com/en-gb/HT204904). 
This shows a globe and a progress bar 
while the software is downloaded.

3macOS Utilities
When Recovery has loaded, it 

displays a list of four commonly needed 
tasks. ‘Get Help Online’ opens the Safari 
web browser. If your Mac uses Wi-Fi to 
get online, click the Wi-Fi icon at the top 
right corner to ensure that it is connected 
to your usual network.

4Get help online
You can use this version of Safari 

to research your technical problem by 
visiting support.apple.com, to look more 
broadly with a search engine, and to 
browse to apple.com/uk/retail to book a 
Genius Bar appointment for professional 
help at an Apple retail store.

5Disk problems
If macOS won’t start, select Disk 

Utility before resorting to more drastic 
options and check that your Mac’s drive 
is shown under Internal on the left. Select 
the row that isn’t indented and click First 
Aid in the toolbar to verify and attempt 
to repair structural problems.

6Restore backups
If you haven’t excluded system 

folders from your backups, your Mac can 
be restored to an earlier state. Choose 
the Time Machine option, identify your 
backup disk, pick an earlier state from 
the list, and follow the prompts to restore 
your startup disk. This can take a while.

7Reinstall macOS Sierra
The Reinstall option downloads the 

same version of macOS (or OS X) you 
have and installs it over any existing copy, 
retaining your files and settings. This can 
fix some damage to the system. The 
download is several gigabytes, so it 
may take quite a while to download.

8Reset a password
If someone forgets their account 

password, choose Utilities > Terminal. 
Type resetpassword into that app and 
press ®. In the next window, select 
your startup disk, select the account 
from the list, type a new password 
into the boxes, and click Save.

 How to Use Recovery’s various options 

Check the connection
In Utilities > Network Utility, the Ping 
tab enables you to check that 
network traffic can reach other 
devices on your network and 
websites outside of it.
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Q
When I try to print from Adobe 
Acrobat Reader DC on my MacBook 
Pro Late 2011 running Sierra, I see a 

’There are no pages selected to print’ error 
message, although they print from my Mac 
mini, or using Foxit Reader or PDF Reader 
Pro Free. Unlike Acrobat, they can’t open 
some PDFs, so how can I print them?
by R i c h a R d  G e l l i n G

A
Some users find that disabling 
Enhanced Security within Acrobat 
Reader’s preferences fixes this error. 

Others work around it by printing to JPEG 
image files, then printing those using 
another app. But for some, no matter 
what they try, the error persists.

EditEd by howard oakley 

What’s inside 

69  
macoS

 Adobe Acrobat 
and macOS Sierra 

PDF-printing issues

70–71
networking

 Solving Wi-Fi woes and 
connection conundrums

72–73 
Software

 Sagacious solutions 
to software snags

74 
ioS Software

 Swipe away your 
touchscreen troubles 

and love iOS once again 

Contact us

 Email your queries 
and your questions to 

genius@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

 Get the latest 
subscription offers at 

macformat.com

Acrobat Reader not printing
It’s almost certainly a problem specific to 

Sierra, resulting from its new PDFKit library, 
which has broken many apps. Some bugs have 
been fixed in successive updates to the initial 
release of 10.12, but this particular one with 
Adobe Acrobat Reader DC seems to have 
persisted on certain models of Mac.

Until Apple and Adobe address the issue 
and deliver a fix, hopefully in the next update 
to Sierra, you’ll have to work around it by 
using a different app. Even the bundled 
Preview is worth trying, particularly as Apple 
has recently fixed at least some of its bugs. 
You could also consider upgrading to a paid 

version, such as Adobe Acrobat 
Pro, which doesn’t appear to 
suffer the same glitches.
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Our resident genius 
solves your Mac and  

iOS problems

eXPert 
adViCe

Can’t print from Acrobat 
Reader? You may have 
to try another app.



Networking 
We help to solve your Wi-Fi woes 
and connection conundrums

geniUS tiPS Networking

70 | MaCforMat | MAy 2017

How can I connect 
my studio, it’s 50m 

from the router?
> Over open ground, 

2.4GHz Wi-Fi can 
reach up to 90m, but 

signals weaken with any 
significant obstructions. 

A better bet may be 
outdoor grade Ethernet 

cabling, which can be 
up to 100m in length 

without performance 
loss. Cable is best run 

overhead, or buried 
in plastic piping.

Can I put my own 
RJ45 plugs onto 
Ethernet cable?

>  Yes, and it’s easier if 
you can buy or borrow 
two special tools: one 
for cutting the outer 

jacket, the other 
to crimp the plug 

on, available from 
electronics retailers. 

The process using those 
tools is illustrated at  

bit.ly/belden_modplug_
cat6 and numerous 

YouTube videos.

Networking  
quick-fire 

questions 
Q

My iMac and MacBook Pro already 
share access to my modem router, 
using an Ethernet wired connection 

and Wi-Fi, respectively. What’s the best way 
to share files regularly between them?
by i a n  d a v i e s

A
Macs have many methods of sharing 
files, from ad hoc AirDrop over Wi-Fi, 
to iCloud Drive, which is ideal when 

you’re connected to the internet in another 
location, but inefficient on a local network.

If they’re already accessing the same 
modem router, the simple way is to turn File 
Sharing on for your iMac as a ‘server’, then 
connect to it from the MacBook Pro. In the 
Sharing pane, select the File Sharing item at 
the left, and add a shared folder such as your 
whole Home folder. Ensure you have Read & 
Write access to that in the list of Users at the 

right, and check the box to turn file sharing on.
Note the Computer Name given there. On 

your MacBook Pro, open Finder’s preferences, 
and show Connected servers and Bonjour 
computers in the sidebar. Your iMac should 
then appear in the Finder sidebar. 

If it doesn’t, use the Connect to Server 
command in the Finder’s Go menu to bring 
up the connection dialog. You can connect 
there by typing in the IP address of the server, 
in a form similar to smb://192.163.1.4. This is 
simpler when using fixed IP addresses, and 
SMB is now preferred over AFP.

Then enter the iMac’s user name and 
password, not that for the MacBook Pro. 
When you’re done, just eject that shared 
item, and turn File Sharing off.

Reliable sharing

 macformat.com  @macformat

Share your whole Home folder, giving read 
and write access. Note that Macs now prefer 
SMB connections rather than AFP.
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Fallback internet connection

Can I turn Wi-Fi off 
on a BT Home Hub?
> Yes. Ensure your Mac 
is connected to it by 
wired Ethernet. Open  
admin service using 
your browser and, 
depending on the 
model, enter the 
Advanced Settings and 
turn 5GHz and 2.4GHz 
wireless options off.

Is there a free VPN 
service for Macs?
> Some like Total VPN 
have free options but 
impose usage caps or 
advertising, and may 
perform poorly. They 
might suit light and 
occasional users. With 
VPN there’s always 
the risk that your 
connection may not 
be fully secured.

Q
When we lose mains power, our 
broadband often goes down too. 
Is there any way to switch my 

MacBook Pro over to using my iPhone’s 
mobile connection?
by d a v e  W i l l i a m s

A
You can maintain power to a modem 
router from a UPS, which will keep 
your end working, but if local comms 

cabinets lose power and drop the connection, 
that won’t help. Provided that you can afford 

the data use on your mobile account, and get 
a decent connection speed, you can set your 
iPhone up to provide a Personal Hotspot, and 
a fallback internet connection for your Mac.

Switching to that setup is quicker and 
simpler if you save it in the Network pane 
as a Location. When your regular connection 
goes down, all you then have to do is turn 
the iPhone’s hotspot on, and switch location 
on your Mac. For more on setting up a 
Personal Hotspot, go to support.apple. 
com/en-gb/HT204023.
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AirPort Extreme as a bridge

Q
We have an AirPort Extreme 
802.11ac connected to our 
Uverse router. Since I set up 

the AirPort, it reports ’Setup over WAN’ 
and ’Double NAT’. Our old AirPort 
Extreme worked fine in Bridge mode, 
but when I try that with our new one, 
including turning DHCP off, it blocks 
Wi-Fi access. Are those status 
reports acceptable?
by J o h n  l e e

A
You’re correct: in your setup, a 
Wi-Fi base station should operate 
in Bridge mode, and shouldn’t serve 

DHCP, as your Uverse router does that. You 
can turn the DHCP server off and set it to use 
a fixed IP address from a static block allocated 

on your router, but that can be 
fiddly. The consumer solution is the 
’Double NAT’ scheme which your 
new AirPort Extreme uses to work 
around having two DHCP servers 
active. It only becomes a nuisance 
if you need to use IP addresses to 
trace a network problem.

You should also disable the 
feature to permit setup over WAN, 
as that could allow an intruder to 
take control of the network. 
However, as your AirPort base 

station lives inside your router’s firewall, 
provided that’s configured to block all 
incoming connections, there is no real risk.

The purist dislikes this approach, but 
if it works well, it’s wise to leave it alone.

Turn on Personal Hotspot in Settings on your iPhone. 
You can change the password to something easier to 
enter, but keep it secure.

Open the Network pane, and duplicate your current 
Location, naming the copy Fallback. Connect that to 
your iPhone’s Wi-Fi network.

The Airport Extreme uses the Double 
NAT scheme to work around having 
two DHCP servers active.



Software 
Shine a spotlight on sagacious solutions  
to your most maddening Mac maladies

Software 
quick-fire 

questions 
How secure are 

collaboration 
services like Slack?

> Slack and other 
collaborative working 
services are based on 

IRC, which can be 
secured, and can be run 
through a VPN service. 

However, your chats 
are stored on remote 
servers which may be 

vulnerable to attack and 
legal means of obtaining 
their content. For better 

privacy and security, 
use end-to-end 

encrypted group 
messaging instead.

Does Console have 
a memory leak?

> While Console is open, 
it collects all fresh log 
entries, and over time 

these grow to consume 
lots of memory. Quit the 
app when it’s not in use, 
as eventually it can even 

slow your Mac down. 
Instead use my free 

utility Consolation to 
browse past log entries.

geniUS tiPS Software
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number of folders, with their own indexing 
system and database, which are separated 
from the metadata that provides information 
about the images. Trying a manual recovery 
isn’t really feasible. 

Your best prospect is to return to the most 
recent backup from before this occurred, and 
use that to migrate to Photos or, if you prefer, 
to Adobe Photoshop Lightroom.

To migrate to Photos, you’ll need to have 
been using iPhoto 9.6.1, as earlier versions are 
less successful in the migration process. Work 
with a copy of the iPhoto library, and keep 
the original in a safe archive. You’ll also find 
it better to migrate a locally-stored library, 
rather than one held on your NAS. Once you’re 
happy that each library has been converted 
fully and works properly, you should be able 
to move them back onto the NAS again.

Q
I’m running macOS Sierra 10.12.2 
on a MacBook Pro, and have about 
10,000 pictures in my main iPhoto 

library, and a smaller library of old scanned 
images. I moved these to a NAS, which 
worked fine at first. Now the larger library 
has suddenly renamed itself, and I’m unable 
to access the smaller library at all. If I hold 
the Alt key when opening iPhoto, that 
smaller library isn’t offered as an option 
either. How can I find that missing library?
by d a v i d  P e R R y

A
Assuming you’ve checked that your 
NAS is running healthily and hasn’t 
suffered any problems which might 

have affected that library, this may well be a 
result of iPhoto’s age and remaining bugs. 
iPhoto’s photo libraries consist of a huge 

Lost iPhoto library

When you open an old iPhoto library using Photos, it’s converted to the new format, which can take a long time.



Q
I set up a Gmail account ages ago, 
and haven’t really used it, although I 
still have it set up in Mail. Whenever 

I send a message from Mail to someone with 
a Gmail address, the app defaults to sending 
it from that Gmail account. How can I stop 
that, and prevent incoming invitations 
defaulting to my Gmail calendar in the 
Calendar app?
by d u n c a n  b R a c k

A
Mail lets you change the default mail 
account for new outgoing messages, 
which may help. Open Mail’s 

Preferences, and select the Composing tool. 
Under Addressing, where it says ‘Send new 
messages from:’ select the default account 
from which you wish all new messages to be 
sent. There’s currently no setting which makes 
all outgoing messages, including replies, come 
from the same default account, though. 

Invitations coming in as email to an 

Software geniUS tiPS

account other than an iCloud mail account 
have behaviours which are controlled in the 
General section of Mail’s preferences. The only 
choice is between adding them automatically 
to Calendar, or to not add them at all. The 
Calendar app doesn’t offer any control; it tries 
to place invitations as smartly as possible.

importing JSON to Excel

Keeping clear of Gmail How to remove 
Office 2011 after 
upgrading to 365?
> You don’t have to 
remove the old version, 
as it will co-exist if you 
can cope with updates 
to both. Drag the 
Microsoft Office 2011 
folder from Applications 
to the Trash and empty. 
This leaves debris in 
Library folders, such 
as old preference files, 
but frees up the great 
majority of the storage 
space which it occupies.

How can I check 
and repair a 
Photos library?
> Ensure it’s backed up 
properly. Open a new 
window in the Finder, 
navigate to Applications, 
and locate the Photos 
app. Holding down 
the å and ç keys, 
double-click the app 
icon and it will open, 
offering to repair the 
current default library. 
To change library, first 
double-click with the å 
key held, select the new 
default library, quit, 
then repair that. 

 
How can I report 
a problem with 
Safari?
> Apple only gives 
registered developers 
access to its Radar bug 
reporting system. If you 
encounter a problem 
which could be a bug, 
contacting Apple 
Support is the only way.

Mail lets you set the default account from which to send 
new messages, but has no accessible control over replies.
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Q
What’s the best way to convert data 
I’ve obtained from websites in JSON 
format, into a format that I can 

import into Microsoft Excel?
by R i c h  d a n i e l s

A
JavaScript Object Notation (JSON) 
is an increasingly popular format 
for data obtained by querying online 

sources such as Twitter. As its name suggests, 
it’s primarily intended for use with JavaScript, 
and there are many free online services which 
will convert small amounts for you with ease.

Spreadsheets such as Excel and Numbers 
are traditional in the formats they import, 
working best with plain text separated by tabs 
or commas (CSV). Transforming JSON’s paired 

JSON editors like JSON Wizard reveal the structure of JSON data in the form of paired attributes and values, in a list.

attributes and values into lines of tab- or 
comma-delimited text isn’t easy. The free 
statistical language R has a jsonlite package to 
import from JSON data, and an xlsx package 
to export to native Excel format. Even that 
isn’t simple though, as it tends to flatten the 
data into just two rows of the spreadsheet. If 
possible, look to using JavaScript to write CSV 
text direct, or obtain the data in a different 
format which you could readily convert into 
tab- or comma-delimited lines of text.

There are also two free JSON databases, 
Apache CouchDB and MongoDB, which may 
provide suitable intermediates to help store 
and convert data, and the format home page 
at json.org has a huge list of other support 
packages too.



iOS Software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS software 
quick-fire 

questions 
Why are my 

phone number 
and region 

incompatible?
> iCloud and iMessage 

match these. If you 
have problems, correct 
your Apple ID settings 
according to support.

apple.com/en-ae/
HT201389. Check your 

Time Zone is set to 
match your Region, 

and the country code 
of your phone number 

matches. If you still see 
warnings, contact 
Apple Support to 

check your account.

How can I stop 
unwanted calls?

> Get your number put 
on the ’do not call’ 

registry. Then in 
Settings, switch on 

Do Not Disturb to only 
let through specified 

callers and block 
notifications. Also, 

consider a call blocker 
app like Truecaller or 
Hiya (see our tutorial 
in last month’s issue).

geniUS tiPS iOS Software

74 | MaCforMat | MAy 2017

Q
My wife and I have separate Apple 
IDs and different mail addresses, 
and have never used Apple’s family 

sharing feature. Suddenly, all the photos 
taken by my wife and stored in her Photos 
library have appeared in my Photos library 
on my iPhone. How can I remove them?
by m i c h a e l  s c o t t

A
This is almost certainly because 
your wife has turned iCloud Photo 
Sharing on, and you have somehow 

inadvertently subscribed to that share, 
either through Messages or in an email 
you would have received. Reversing that 
is straightforward, and should remove all 
shared photos from your library immediately.

If she can locate the shared album, she can 
go to its People tab, select you as a subscriber, 
then select Remove Subscriber. She can also 
turn off iCloud Photo Sharing in two different 
places within Settings: either tap on iCloud, 

then Photos, and disable it there, or tap on 
Photos & Camera to see it with other controls.

Once those photos have gone from your 
Photos, your wife can turn iCloud Photo 
Sharing on again when she wishes; for them 
to reappear on your iPhone, you’d have to 
accept an invitation to share with her again.

If disabling sharing does not remove them, 
and you’re sure that they’re not being shared 
from a Mac or elsewhere, you can try signing 
out of your respective iCloud accounts at 

Sudden photo sharing

Shared photos should 
only appear in your 
library if you’ve accepted 
an invitation to share 

the same time, then signing back in and 
ensuring that your account details are 
entered correctly.

If there has been some confusion in your 
accounts, you’d need to contact Apple’s iCloud 
support to check and, if necessary, fix that.

It’s quick and simple to disable iCloud Photo Sharing 
in the Photos & Camera item in Settings.
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ast month, I shaved a few minutes off 
the startup time of my Mac mini with 
some aggressive de-cluttering. This 

month, I’m going to try speeding up my wife’s 
MacBook. Alison is making do with an 11-inch, 
Late 2010 MacBook Air. She almost exclusively 
uses it for FaceBook, email, shopping and 
Skype, so it doesn’t need blistering 
performance. And since it has an SSD, it 
already boots up acceptably fast. But lately, 
Alison has complained that it feels more 
sluggish, and she blames the incremental 

bloat that comes with each OS upgrade. 
She’s currently running OS X 10.10.6 El Capitan 
and refuses to risk any more slowdown by 
upgrading to Sierra. Now, I generally believe 
the latest version is always the best, but rather 
than argue from an ideological standpoint, I’m 
going to approach this empirically. Let’s 
reinstall a few previous versions of OS X and 
see if it improves performance. And if it does, 
which version offers the best compromise 
between speed and features? Was there ever 
a perfect version, or is this just nostalgia?

L

the fastest OS X

 CLASSIC APPLE KIT FROM 1999!
The 1999 Power Mac G4, codenamed Yikes!, was the first of 

the pro-level Macs introduced after Steve Jobs returned to 
Apple. It was so powerful that it was also the first Mac to be 
classed as munitions, under US export regulations. According 
to the government definition at the time, it was classed as a 
supercomputer! The Yikes! blue and white motherboard isn’t 
perfect though. It doesn’t support AirPort and it can’t boot from 
USB drives. It will run versions of OS X up as far as 10.4 Tiger.

Inspiring ideas for 
revamping your old  

Apple devices

REUSE 
OLD KIT

Is an old MacBook Air getting 
sluggish because of OS 

upgrades?
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Hardware 
quick-fire

questions 

 How do I roll back 
to Lion or earlier?

> Apple still sells Lion 
and Snow Leopard on 

their website. Both cost 
£19.99. Snow Leopard 
comes on installation 
DVDs but Lion is only 

sold as a download 
code. If you need 

physical media, you can 
buy USB sticks with the 

Lion installer on them 
from Amazon for 

around £15.

How big does the 
external install disk 

need to be?
> The OS X installer 
will fit into 8GB, so 

you can use a thumb 
drive if you want.

 
 
 
 
 

I entered the 
Terminal command 

but my keyboard 
stopped working!
> The sudo command 
needs your password 

but Terminal won’t 
display the admin 
password on the 

screen, so it looks 
like the keyboard 

isn’t working. Just type 
it in blind and hit return.

Rolling back 
the years 
did your Mac run faster on previous OS X?

2

2GB RAM
 This is the base model. 

The RAM is soldered to the 
motherboard, so you couldn’t 
upgrade after you purchased.

6

OS X
 This Mac was originally sold 
with 10.7 Lion. It supports 

all versions from 10.6 Snow 
Leopard to 10.11 Sierra.

1

Processor
 1.4GHz Intel Core 2 Duo. The 
Late 2010 MacBook Air runs 
about a quarter the speed of 
a MacBook with an i7 chip.

5

Ports
 The slim design leaves room 
for just one USB 2 port on 
each side, plus a MagSafe 

and Mini DisplayPort.

4

5

2

1

4

SSD
 All MacBook Airs from 2010 

onward use solid-state drives 
exclusively. This one has 

128GB of storage.

3

11.6-inch screen
 The smaller screen size was 

a new option for the Late 2010 
model. The screen resolution 

is 1366 x 768.

3

6
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et’s start by benchmarking the 
MacBook running El Capitan. For 
the kind of light duties my wife Alison 

demands of her laptop, a full benchmarking 
suite feels like overkill. But if I don’t measure 
the performance, I can’t compare it. I 
eventually decided to use Geekbench 4 
(geekbench.com) because it claims to use 
tests that model real-world applications. It also 
has a free trial version. With no other apps 
running, the MacBook scores 992 using just 
one of the CPU cores and 1661 in multi-core 
tests. Next I made a bootable backup of the 
entire drive, using Super Duper! (shirtpocket.
com). It was a condition of the deal I made 
with Alison that she would have her MacBook 
returned to her in its original condition. In view 
of this, I also uploaded her entire home folder 
to cloud storage as well, just to be sure.

Now to downgrade the OS. Although the 
App Store lists all the previous versions of OS 
X you have installed, under the Purchased tab, 
you can’t just re-download an old version. OS 
X will refuse to run the installer for an older 
version than you already have. Instead I used 
a spare USB hard drive, and formatted it as 
OS X Extended (Journaled) and partitioned 
using GUID. Then in Terminal, I typed:

sudo /Applications/Install\ OS\ X\ 
Yosemite.app/Contents/Resources/

createinstallmedia --volume /Volumes/
Untitled --applicationpath /Applications/
Install\ OS\ X\ Yosemite.
app --nointeraction

This runs the createinstallmedia utility 
built into the installer for Yosemite, and tells 
it to install to the external drive instead of 
the MacBook’s own drive. It took about 20 
minutes. Next, I restarted the MacBook with 
the Option key held down and picked ‘Install 
OS X Yosemite’ from the list of bootable 
drives. Once the menu bar appeared for the 
OS X Installer, I clicked Utilities > Disk Utility 
and erased the main hard drive. After I had 

It’s vital to format the 
external disk so that you 
can boot from it before 
you wipe the internal drive.

The extensions running in the 
menu bar affect the speed of 
this Mac a lot more than the 
particular version of OS X.

L
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3Single vs multi-core
The two headline scores relate to the 

system speeds running single-threaded/
multi-threaded tasks. Multi-threaded 
tasks are able to take advantage of all 
cores on your processor. This requires 
programming from the developer though. 
OS X itself is written to take advantage 
of multiple cores, but not all apps are.

 How To Measure your performance 

Next Issue!
 Luis makes another 
attempt to get Lode 
Runner installed on 

his 1987 Mac SE, 
using some ancient 

software and an almost 
prehistoric Mac to PC 

file-transfer cable.

scored 1013 and 1699 – about 2% faster than 
El Capitan. That’s slightly better but at this 
point, I figured that I might as well do one 
more, so I went through the whole rigmarole 
one more time to downgrade another step to 
OS X 10.8 Mountain Lion. This time I saw a 
performance jump of just under 5% compared 
with Mavericks, or 7% overall.

So after a long afternoon of installing and 
reinstalling, what did I have to show for it? 7% 
performance difference isn’t something you 
can actually notice. These are synthetic 
benchmark scores testing intensive number-
crunching and graphics processing tasks. 
When I tried opening apps and loading 
webpages, it all felt about the same. And this 
performance isn’t free either – it comes at the 
expense of the Maps and iBooks apps, cloud 
syncing in Notes, window snapping to put two 
apps side-by-side – to name just a few of the 
features I’ve definitely seen my wife use. Last 
month’s tactic of simply clearing out the junk I 
don’t need and never use had a bigger effect 
on performance on my Mac than dropping 
back three versions of OS X on Alison’s. It’s 
easy to get nostalgic about previous versions, 
much like we do about previous decades but I 
am now more convinced than ever that 
nostalgia is an illusion brought on by the 
longing for lost youth. And as soon as I have 
restored Alison’s MacBook to El Capitan, I’ll 
start nagging her to upgrade to Sierra.

wiped both the drive, and the anxious sweat 
from my brow, I quit Disk Utility and returned 
to the installer to put a clean copy of Yosemite 
on the now empty drive.

Disappointing numbers
Now that Yosemite was up and running, 
I reinstalled GeekBench and took another 
sounding. The results were… underwhelming. 
Scores of 994 and 1666 were about a quarter 
of a percent faster than El Capitan. And this 
was a completely clean install. By the time I 
restored Alison’s apps and extensions, it would 
probably be slower than before. Time to roll 
back the clock again. I downloaded Mavericks, 
installed it to the external disk, wiped the 
MacBook’s internal drive and ran the installer. 
A hour later I ran GeekBench again. Mavericks 

1 Install GeekBench
Geekbench 4 (free trial version, as 

long as you’re connected to the internet, 
or £7.99, primatelabs.com). Earlier 
versions required you to upgrade in order 
to run 64-bit tests but these are available 
in the trial version now. The main screen 
just shows the same basic info that is 
available from the About This Mac menu.

Apple doesn’t believe older 
versions are better, either.

2Run the test
Select CPU and click Run CPU 

Benchmark. This runs a series of tests 
simulating the tasks the processor 
normally performs when running apps. 
Tests are calibrated against an Intel Core 
i7, which should score 4000. The score is 
proportional to the speed, so a score of 
2000 means your CPU is half as fast.
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here’s no doubt that Apple is 
a game changer. Most times, the 
innovative tech giant has set out 
with a vision of what it wants to 
change and how, but sometimes 
things can take an unexpected turn 
– and Apple ends up changing an 

entire industry without even meaning to.
Touchscreens, app stores, music downloads 

– even the modern concept of a smartphone – 
in all of these cases, Apple has innovated, and 
nearly every one of its competitors has 
scrambled to play catch up.

Where Apple goes, others follow. In this 
article, we look at five occasions the Cupertino 
giant has accidentally changed the world.
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Alex Blake looks into five 
ways in which Apple has 
transformed the tech industry

T

How Apple 
accidentally 
changed  
the world
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1.Smartphones
Apple knew it had something 

special when it launched the 
original iPhone 10 years ago. 

On stage at Macworld 2007, Steve 
Jobs recounted the times Apple had 
revolutionised the tech industry with 
the Macintosh and the iPod, and 
announced that Apple was about to 
do it again. Similarly, the company’s 
press release for the iPhone was titled 
‘Apple Reinvents the Phone with 
iPhone’, and went on to quote Jobs as 
saying: “iPhone is a revolutionary and 
magical product that is literally five 
years ahead of any other mobile 
phone.” Big talk, indeed.

But aside from its revolutionary 
physical features, it changed the 
world in a different way – it 
reconfigured the relationship 
between mobile networks, phone 
manufacturers and customers. In the 
US, the situation before the iPhone 
was skewed in favour of the network 
companies, who would use access to 
their networks as a means to exert 

influence on how phones were to be 
designed and how much they’d cost.

As Wired magazine put it not 
long after the launch of the iPhone, 
“Handsets were viewed largely as 
cheap, disposable lures, massively 
subsidised to snare subscribers and 
lock them into using the carriers’ 
proprietary services.”

High-end handsets
What the iPhone did was prove that 
phones needn’t be cheap, disposable 
afterthoughts. It proved that 
expensive phones – even those 
costing $599 as the top-end iPhone 
did at launch – could sell well. Indeed, 
market analysts UBS Research 
predicted the iPhone would sell over 
3 million units by the end of 2007, 

making it the world’s fastest-selling 
smartphone at the time. 

This flipped the status quo on its 
head. Smartphone manufacturers 
strove to create something consumers 
wanted, rather than something the 
networks wanted. This was apparent 
almost immediately – “The iPhone is 
already changing the way carriers and 
manufacturers behave,” remarked 
Michael Olson, a securities analyst 
at Piper Jaffray, less than a year 
after the iPhone came out.

Similarly, Apple shook up the 
relationship between manufacturers 
and networks in Japan. There, 
networks also had undue influence 
on what made it into finished phones, 
tinkering and adding features until 
they were bloated and complicated. 

They added TV receivers 
and e-wallets – features 
that the networks thought 
were indispensable.

Then, in July 2008, 
came the iPhone. As in the 

After 2007, manufacturers 
strove to create something 
consumers wanted
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2.App 
economy
The App Store – launched alongside the 
iPhone 3G in July 2008 – barely got a 
mention in its initial press release, which 
focused almost exclusively on the iPhone. 
In fact, Walter Isaacson’s biography of Steve 
Jobs suggests Jobs was against the entire 
idea of an App Store. But it was such an 
explosive concept that getting apps any 
other way seems unimaginable today, be 
that with an iPhone or Android phone.

Here are our favourite stats that 
illustrate the success of the App Store – 
and how it’s changed the mobile industry.

US, Steve Jobs had managed to get 
the iPhone on sale in Japan with no 
modifications from the networks. This 
was highly unusual – even in 2013, 
Japanese mobile phone expert 
Nobuyuki Hayashi commented that 
“iPhone still is about the only phone 
in Japan which is sold unmodified” – 
but it was a successful approach.

Without the bloatware and 
resulting confusion and battery drain, 
the iPhone was able to soar to success 
– so much so that less than two years 
later it had captured 72% of the 
Japanese smartphone market. 
Runner-up HTC secured a paltry 11%.

The end result is that the iPhone 
changed perceptions of what a 
smartphone could be. It needn’t be 
a cheap, throwaway item; it could be 
premium and luxurious. It needn’t be 
bloated with unnecessary features; 
it could be simple and refined. The 
whole smartphone paradigm shifted 
when Steve Jobs walked onto the 
Macworld stage in January 2007.

90  
billion
> Total number of 
app downloads on 
iOS and Android in 
2016, demonstrating 
what a phenomenal 
success app stores 
have become.

> Number of available 
apps in the Apple App 
Store as of January 
2017. It launched on the 
iPhone with 500 apps.

> Projected number 
of apps in the Apple 
App Store by 2020.

> Google’s rival app 
store, the Play Store, 
has even more apps, 
with 2.7 million in total.

2.7 
million

140 
billion

2.2  
million

million

> The total revenue generated by Apple’s App Store in Q4 2016. Google’s Play 
Store generated $3.3 billion in the same period despite having more apps, as 
a greater proportion of them are free or cheap.

> Total number 
of apps 
downloaded 
from Apple’s 
App Store by 
September 2016.

While Apple set out to create 
a safe, simple way for iPhone 
users to get new apps, it ended 
up sparking an idea that the 
whole smartphone industry went 
on to copy, to great success.

$5.4 billionThe original iPhone might look a bit retro 
these days, but at its launch in 2007 it was 
revolutionary, and transformed the market.

Five of the best APPle INNOVATIONS
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Before the debut of the 
iPhone, the smartphone 
world was dominated by 

Palm and BlackBerry handsets 
with small screens and plastic 
keyboards. They were phones for 
business people, not everyday 
users, replete with styluses and 
focused on email.

Just before he unveiled the 
iPhone, Steve Jobs blasted these 
phones on-stage as hard to use 
and lacking in functionality. You 
were stuck with a large plastic 
keyboard whether you needed it 
or not. And if the manufacturers 
came up with a new function or 
idea after the product had 
launched? Too bad, you were 
stuck with that form factor.

Apple sought to remedy all 
of that with one simple solution 
– a touchscreen.

Superior screen
The iPhone launched with 
a mediocre 2MP camera, no 
third-party apps and only 2G. It 
couldn’t record video, and you 
couldn’t search your emails. But 
all that was made irrelevant by 
the capacitive touchscreen.

The lack of a physical 
keyboard made reading on 
the iPhone a far superior 
experience, with more 
screen space devoted to 
the subject matter. Touch 
functions could change 
depending on use, with 
play/pause buttons when 
listening to music or a 
keyboard in Messages, all 
of which would disappear 
when not in use.

MacFormat editor Graham 
Barlow remembers being 
amazed when he first saw 
the touchscreen. “My abiding 
memory of the iPhone launch 
is of Steve Jobs zooming into 

a web page in Safari with an 
unpinch gesture. There were 
audible gasps from the audience 
– we’d never seen anything like 
it before,” he says.

Having such a large display 
area made it ideal for viewing 
things in landscape orientation 
as well as portrait – so Apple 
built in an accelerometer for this 
purpose. In fact, it was so good 
that Google completely shelved 
its own smartphone plans and 
started over again when its 
executives saw the iPhone 
launch. Google was originally 
going after Microsoft with a 
phone that had a physical 
keyboard and no touchscreen. 
But after seeing Jobs unveil 
Apple’s revolutionary phone, 
Google knew its own product 
simply wouldn’t be good enough.

“As a consumer I was blown 
away. I wanted one immediately,” 
remembers Google engineer 
Chris De Salvo. “What we had 
suddenly looked just so… ’90s.”

The touchscreen transformed 
phones from communication 
devices into immersive media 
viewers. Instagram, YouTube, 
Twitter – it’s a good bet that 
none of these would have taken 
off in the way that they did if the 
touchscreen hadn’t have been 

introduced. Apple didn’t mean 
for that to happen – at least 

not directly – but it all came 
about as a result of that 

design decision.

Back in 2003, the music 
industry was terrified of 
piracy. Four years after the 

first release of Napster, the online 
world must have seemed like a scary 
place to record executives.

Then along came the iTunes 
Music Store. In one fell swoop, Apple 
introduced a safe, legitimate online 
music store that satisfied consumers 
and reassured record labels (although 
they still had reservations about the 
price structure).

Digging digital 
The store allowed users to download 
songs instantly at 79p a pop when it 
launched in the UK in 2004. Compared 
to heading out to a record store, hoping 

3.Touchscreens 4. Digital  
music 
downloads 

The iTunes Music Store paved the way for 
streaming services like Netflix and Apple Music.



MAY 2017 | MACFORMAT | 87

they had the CD in stock and paying 
more for it anyway, this was a far 
better experience.

It took off in such a big way that from 
2000 to 2007, CD sales in the US fell 
from 943 million to 500 million. At the 
same time, digital music downloads went 
from almost zero to 819 million. The 
impact on CD sales was so profound that 
CNN proclaimed in 2013 that “iTunes 
singles killed the music industry”.

The iTunes Music Store expanded 
into other areas too, like TV shows, 
movies, games and more. Although it 
wasn’t a streaming service, it readied 
the ground for platforms like Netflix and 
Apple Music alike by giving people a way 
to quickly access their favourite media, 
online and direct from their devices.

Jobs wasn’t aiming for universal 
industry change, but the iTunes Music 
Store proved to be so popular that 
that’s what he got.

Apple’s position as a market 
leader and reputation for 
innovation has given it a lot 

of leeway when it comes to adopting 
new hardware standards. It knows it 
can drop a popular port in favour of 
what it thinks is the hardware of the 
future and people will still buy its 
products in droves – albeit at the 
expense of a bit of grumbling.

What’s interesting is that 
everyone else usually follows suit, 
resulting in major hardware industry 
shifts. We’ve already seen that with 
touchscreens, but it applies to the 
more modest ports and cables too.

Moving on
In hindsight, much of the fuss 
surrounding these decisions seems 
like a storm in a teacup. For example, 
when Apple dropped the 3.5-inch 
floppy drive in the iMac in 1998, 
Bloomberg quoted one angry Mac 
fan as saying the lack of the then-
standard drive would “kill this 
machine”. But the follow-up from the 
rest of the industry was so complete 

that floppy drives had been 
completely abandoned within a few 
years – and soon, manufacturing of 
the drives had ceased completely.

From VGA on Macs to the 30-pin 
port on the iPhone, Apple is ruthless 
when it comes to dropping standards 
that it perceives as archaic, and 
is very willing to adopt new, 
replacement standards that end 
up driving the industry forward. 
Ditching the floppy paved the way 
for the mainstream adoption of USB 
and CD drives, after all, with obvious 
storage and speed benefits.

The abandonment of the 
headphone jack in the iPhone 7 
is part of the same story. Apple 
forecasts a wireless future, and 
doesn’t mind making the first move.

Its revenues and popularity are 
such that it knows it can weather the 
resulting storm. How long will it be 
until the 3.5mm jack is viewed the 
same way as FireWire? Apple can’t 
tell other companies what to do, but 
in many cases, when Apple drops 
something, everyone else follows.

Like a lot of Apple 
moves, the removal of 
the headphone jack was 
controversial, but there are 
already plenty of wireless 
earbuds on the market…

The iTunes Music 
Store allowed users 
to download songs 
at 79p a pop

Five of the best APPle INNOVATIONS

5.Dropping 
standards
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 Awarded to a 
five-star product 
we believe is truly 
exceptional in its 

category. Given solely at the 
discretion of the Editor.

 Given to a 
hardware or 
software product 
that might not be 

the very best in its category, 
but is noted for affordability.

 Our group test 
winner gets this 
award for being 
the best of its 

kind when pitted against 
other comparable products.

 the MACFORMAT Awards

 Manifesto – our ratings explained
 Our reviews are totally 

independent; we’re not 
affiliated with Apple or 
anyone else, nor are we 
influenced by advertisers. 
You can trust us to give 
an honest assessment 
of a product’s worth.

The prices quoted for 
products are correct at 
the time of writing and are 

the best we can find from 
a reputable online dealer, 
excluding delivery. 

HHHHH
 A brilliant thing in all regards, 

and worth every penny

HHHHH
 Strongly recommended; any 

flaws are only minor concerns

HHHHH
 Worth considering, though 

there may be better options

HHHHH
 Fundamentally flawed; look 

at alternatives as a priority

HHHHH
 A waste of your money and 

everyone’s time; do not buy!
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 It’s a shame that Nikon 
decided to completely 

forego the ability to 
record 4K video on 

the D5600. Still, if you 
prefer fluid framerates 
to high resolutions, its 

1080p 60fps output will 
be smoother than the 

4K 30fps video on offer  
from some of its rivals.

Alex says…
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Nikon D5600
Modest updates to a great SLR

T
he D5600 is designed for those 
looking for a few more features 
and greater creative control than 

Nikon’s more entry-level cameras. Its 
resolution is a decent 24.2MP, with a native 
sensitivity range running from ISO100 to 
25,600, so it’s quite comfortable shooting 
in a range of lighting conditions.

The optical viewfinder provides coverage 
of 95% of the frame, so for some key shots you 
may want to double-check the composition 
on the rear display to ensure that nothing 
unwanted has crept into the very edges of the 
frame. Speaking of the display, there’s the 
same 3.2-inch vari-angle touchscreen display 
with a 1,037,000-dot resolution, although its 
operation has been improved. It now offers 
the frame-advance bar to speed up toggling 
through images, as well as a crop function 
for use during playback.

Another addition to the D5600 is Nikon’s 
timelapse movie function. This allows for 
timelapse movies to be captured and put 

together entirely 
in-camera, with an 
exposure smoothing 
function evening out 
variations in lighting 
as your sequence is 
captured. Other 
manufacturers are 
starting to offer 4K 
video capture as 
standard but Nikon 

Reviewed by Phil hall

 £727  from Nikon, nikon.co.uk  features 24.2 megapixels,  
3.2-inch touchscreen, SnapBridge, ISO 100-25,600, 1080p video at 60fps

has, a little disappointingly, decided to stick 
with 1080p capture here, with a choice of 
60p, 50p, 30p, 25p and 24p frame rates.

The D5600 sticks with Nikon’s proven 
39-point Multi-CAM 4800DX autofocus (AF)
system. It may be starting to show its age 
against mirrorless rivals offering ever-more 
AF points, but it’s still a solid and accurate 
system when shooting with the viewfinder. 
Both single and continuous AF modes are fast 
and accurate, locking on with ease to static 
subjects, while the AF tracking modes work 
well for moving subjects, although you don’t 
get the more advanced custom settings found 
higher up the Nikon range. We did find that 
the bundled 18-55mm kit lens struggled a 
little when light levels dropped, though.

Performance
The D5600’s Matrix metering system copes 
well with a range of lighting situations, 
although you might need to dial in some 
negative exposure compensation in high-
contrast scenes to retain highlight detail, 

We were impressed with the resolution and  
detail in shots captured by the Nikon D5600.

The included 18-55mm 
kit lens sometimes 
struggles to focus in low 
light, but is otherwise 
a good starter lens.



Nikon D5600 APPLE CHOICE

 A very capable 
mid-price DSLR, 
which delivers great 
quality images and 
polished handling. 

HHHHH
 Great image quality
 Decent AF system
 Only 1080p video
 Relatively expensive

VERDICT
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Panasonic Lumix 
G80M (body only) 
£629

sPecifications 
 from panasonic.com 
  16 megapixels
  Live MOS sensor
  ISO 100-25,600
  4K video at 30fps

ALTERnATIVE CHOICEs

and recover shadow detail in post-
processing if necessary. Alternatively, the 

Active D-Lighting system can be useful here, 
retaining more detail in both the highlights 
and shadows when shooting JPEG files.

The auto white balance system did well 
in a range of lighting conditions, rendering 
natural-looking results, although under some 
artificial lighting images can look yellowish; 
the dedicated white balance presets can help.

The burst shooting speed remains at 
5fps; some mirrorless cameras of comparable 
price and spec are offering considerably more 
speed in this area. What a mirrorless camera 
will struggle to keep up with, however, is 
the D5600’s battery life. Good for 820 shots, 
it towers over most mirrorless options.

Image quality
The results from the 24.2MP chip didn’t 
throw up any nasty surprises. As you’d 
expect, with all of those pixels packed onto 
the sensor, resolution is very good, with the 
absence of a low-pass filter allowing for 
intricate details to be recorded, while there’s 
plenty of scope for decent enlargements too.

Images captured at lower sensitivities 
appear to be very clean, with little or no noise 
present, and it’s only at ISO6400 and above 

that the D5600’s processing starts to really 
encroach on image quality.

Finally, dynamic range is impressive, 
with the potential to recover plenty of shadow 
detail in raw images shot at lower ISOs. This 
latitude does decrease as you ramp up the 
camera’s sensitivity, with ISO1600 about 
the limit at which you can expect recovered 
shadows to stand up to close scrutiny.

The D5600 is a very capable mid-range 
DSLR that delivers great images and is 
complemented by sound autofocus and solid 
controls. That said, unless you’re desperate 
for a camera with timelapse movie capture, 
the cheaper Nikon D5500 would be our pick 
until the price drops on the D5600. 

The large touchscreen on the back of the camera can 
be moved through different angles for ease of use.

Canon EOS 750D 
(body only) £549

sPecifications 
 from canon.co.uk
 24.2 megapixels
  CMOS sensor
 ISO 100-25,600
  1080p video at 30fps
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T
his drive has two 
features that are 
attractive if you 

deal with very large media 
files or have a high-end 
display setup. It sports a 
gigantic 10TB capacity and 
two Thunderbolt 3 ports.

Such a fast connection to 
your Mac might seem wasted 
on a traditional disk, which 
won’t saturate the 40Gbps 
bandwidth. The point of it, 
though, lies in the second 
Thunderbolt 3 port, which 
enables you to daisy chain 

another device – great news 
if you’re running short of 
places to plug things in to 
your Mac. That device can 
even be a 5K display.

This model also has a 
Type-C USB 3.1 port, and a 
Type-A-to-C is included for 
older Macs. Beyond that, this 
d2 looks just like other recent 
models; the friction afforded 
by the rubber-backed base is 
a particularly welcome touch 
for keeping the drive steady.

LaCie quotes speeds of up 
to 240MB/sec. As ever with 

storage, mean averages are 
lower – 220.7 and 211.5MB/
sec sequential read and write 
speeds, respectively, and 
108.2MB/sec and 95.1MB/sec 
when reading and writing 
randomly around the disk; 
the latter is likely to be a rare 
occurrence at this capacity 
and when using the drive for 
very large files that occupy 
contiguous areas of the disk.

Bear in mind that at this 
kind of capacity, a means 
of backing up gets costly. 
AlAn Stonebridge

 Sound performance, 
attractive design, 

and plenty of space 
at a reasonable  

per-gigabyte price. 

HHHHH
 Connection choices 

 You’ll need to consider 
a back-up strategy

VERDICT

Though this d2 has 
new ports, LaCie 
has reused its 
existing case 
design.

LaCie d2 
Thunderbolt 3
Fast performance, generous storage 
 £575  FroM LaCie, lacie.com 
 FeAtUreS 2x Thunderbolt 3 ports, 1x USB 3.1 (Type-C)

T
his router is 
intended for a 
situation where 

you simply can’t afford to 
be without the internet. 
If your broadband falls over, 
there’s the option to failover 
seamlessly to a 3G/4G data 
connection via a USB cellular 
modem. Your Mac won’t 
know the difference. 

The Billion supports 
all phone line broadband, 
including fibre. If you have 
a router and separate fibre 

broadband modem, the 
Billion can replace both – we 
used it to replace a BT Smart 
Hub (connected to BT 
Infinity fibre). If you have a 
cable connection, you can use 
this as an action point, but 
should probably look for 
a more standard router 
without ADSL2+ and VDSL 
(fibre) support. It supports 
both newer devices on 5GHz 
802.11ac, as well as legacy 

devices that can only access 
2.4Ghz 802.11ac. 

You can have multiple 
individual networks across 
both bands and schedule 
times – so you could give 
tenants, kids or co-workers 
access between certain 
hours. (Be aware that the 
Billion isn’t designed for 
telephony.) The best thing, 
though, is its reliability – we 
had no issues, with a robust 
Wi-Fi signal across all 
devices. dAn grAbhAM

 A supremely 
flexible all-in-one 
networking box. 

HHHHH
 Backup connectivity

 Not the most 
attractive design

VERDICT

Billion BiPAC 
8900AX-2400
A fibre-friendly gigabit router 

 £250  FroM Billion, billion.com  needS Dual-band  
802.11ac Wi-Fi, backup 3G/4G connection via USB

It’s not the best-looking 
router out there, but it 

is phenomenally robust. 
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Drobo 5C
USB-C storage that can grow 
to suit your needs and budget

 £363 (enclosure only)  FROM Drobo, drobo.com 
 FeatuRes 1x USB-C port, five bays for between 2 and 5 disks

 The 5C offers the 
usual Drobo benefits, 
but there’s room for  
a second-gen model 

to improve on it. 

HHHHH 
   Flexible for future 

storage expansion
  Excellent software

  Port is limited to 
USB 3.0 transfer rates

 No USB hub feature

VERDICT

you can 
remove one 

disk and install 
a new one 
of a larger 

capacity 
without a 
problem

Reviewed by alan stOnebRidge

The 5c is an affordable – and expandable – storage 
solution, with protection against hard drive failure.

T
he major appeal 
of Drobo’s storage 
drives is the ability 

to start with two disks 
installed and add more later to 
boost capacity whenever suits you. 
The distinguishing feature of this model 
is its USB-C port; a USB-A-to-C cable is 
included, but if your Mac has the newer kind 
of port, you’ll need to provide your own 
adaptor or replace the cable. Disappointingly, 
there’s just one USB port onboard, whereas 
some RAID drives we’ve tested before have 
included extras and worked as a hub.

Access to the disk bays requires no tools; 
the front panel is magnetically attached and 
easy to detach. The downside is there’s no way 
to lock the panel in place. A sticker on its back 
tells you about the statuses the lights on the 
front-right of the drive may take – credit 
to Drobo for putting it in a sensible place.

Drobo’s online guide walks you through 
inserting 3.5-inch SATA disks into the bays, 
installing the Drobo Dashboard on your Mac, 
and using the app to configure the drive. 
Some prebuilt RAID drives only accept disks 
from their own manufacturer; Drobo doesn’t 
make disks, and it shows no favouritism.

Getting set up took us about 10 minutes to 
complete, and then a good while longer for the 
two disks we inserted to be initialised. After 
that, you can add more disks at will; detection 
takes roughly 10 seconds. 

Some of the total capacity of your disks 
is set aside as an overhead to protect against 
a disk going bad. With the default settings, 
one can fail without enduring any data loss. 
Protection against two disk failures is an 
option, if you’re willing to sacrifice additional 
space for files. Replace a failed disk with one 
of the same or a greater capacity and the array 
is rebuilt automatically for you.

Additionally,  the dynamic nature of 
Drobo’s BeyondRAID tech enables you 
to expand on the capacity of whatever disks 
you choose to install in the first place; you 
can remove one disk and install a new one 
of a larger capacity without problem. Again, 
the drive deals with this automatically, 
saving you some worry.

Room to grow
Drobo’s capacity calculator (bit.ly/2lWT9eE) 
is helpful for checking how your particular 
combination of disks and choice of single- or 
dual-disk redundancy will affect the space 
that’s actually available for your files, ahead 
of you buying new disks.

Dashboard shows array and disk status 
info clearly, and is complemented by a menu 
bar icon that informs you of problems – a nice 
touch if you’ll put the drive somewhere that 
results in the status lights on its front being 
out of sight. As for Time Machine support, 
Dashboard provides an option to limit the 
space it can use by setting aside capacity 
on a separate volume to your other files.

The Drobo 5C is a great way to consolidate 
and grow your Mac’s storage over time. Its 
port is limited to USB 3.0 speeds, though; the 
more costly 5D has two Thunderbolt ports, 
enabling daisychaining and providing more 
bandwidth, plus it has an mSATA bay to 
further boost performance with an SSD. 
However, the 5C’s price, set-up process, and 
supporting software make it an affordable 
and flexible pick for protecting files at home.



H
aving ports on the 
back of your Mac 
desktop makes it 

look good, but it’s not the 
most convenient thing. 
This hub borrows the styling 
of Apple’s Magic Trackpad 
and Keyboard (although, 
slightly awkwardly, the last 
generation of these devices, 
rather than the current style), 
and gives you three USB 3.0 
ports, an SD card reader, and 
a microSD card reader, with 
a single USB Type-A cable 

that connects to your Mac. 
The idea is to save you 
having to fumble behind 
your Mac to plug things in.

Mostly, it works great. 
With two drives connected 
through it, data rates were 
almost exactly the same as 
with the drives connected 
to the Mac directly. It also 
pushes through enough 
power to charge an iPad. 

However, if you connect 
too many of your devices at 
once, you may overload its 
power capabilities – our two 
drives stopped transferring 
once we connected the iPad! 
(Your Mac will warn you if 
this is the case.)

We’d have liked a fourth 
USB slot over the microSD 
reader ourselves, but it’s 
still great. Matt Bolton

 An excellent, useful 
USB hub. It’s fast, 

looks good, and 
is a great price. 

HHHHH
 Fast connectivity 

  microSD reader

VERDICT

You get three USB 3.0 ports, 
but one more wouldn’t hurt.

APPLE CHOICE iOS/Mac Hardware
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There’s no battery, so 
Gamevice draws power 

from your iPhone.Gamevice  
for iPhone
The iPhone’s Nintendo Switch

 £79.95  FRoM Gamevice, gamevice.com  
 FEatURES Lightning connector and passthrough port, 3.5mm headphone jack

L  et’s be honest: 
playing games on 
iOS can be a faff. 

It’s rare to find a game where 
your thumb doesn’t end up 
obscuring the action. Add in 
clumsy controls and you 
have a recipe for frustration. 
Gamevice circumvents this 
issue completely – it’s a 
controller housing for your 
iPhone with physical buttons 
and joysticks. At the time of 
writing it was compatible 
with 940 App Store games, 

including big names like 
Assassin’s Creed and Call of 
Duty, and the manufacturers 
promise to add more. 

And it works very well. 
There’s no noticeable latency 
and it feels firm and sturdy. 
It transforms gaming on iOS 
into an experience not unlike 
the Nintendo Switch. You 
can adjust the fit for your 
phone, and there’s also a 
Lightning passthrough port 
and a headphone jack too. 
The Lightning adaptor is a 

two-sided coin. 
If you buy an Android phone 
(or Apple changes the 
connection in the future), 
you may find the Gamevice 
no longer fits. But the other 
option (Bluetooth) may have 
had its own set of issues, 
such as signal interference in 
busy areas, or high latency.

Gamevice is also a 
sizeable investment for a bit 
of fun, so you have to be sure 
it’s worth it for you before 
you shell out. alEx BlakE

 Far better than 
playing your iOS 

games with clumsy 
on-screen controls.

HHHHH
 Light and comfortable

 Quite expensive

VERDICT

More ports for your Mac

 £33.99  FRoM Satechi, satechi.net  
 FEatURES 3 x USB 3.0 ports, 2-slot card reader, plug-and-play

Satechi Aluminum USB 
3.0 Hub & Card Reader
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 An impressive outside security camera 
– providing you can get it fitted; the camera 

itself is solid and the app can be customised. 

HHHHH

 Lovely design, but you’ll need access to 
a socket. The app has a lot to offer including 
live video, but you’ll have to pay to store video.

HHHHH

> £179 > FROM Nest nest.com/uk > FEATURES 130-degree 
FOV, 1080p HD video, speaker, weatherproof, infrared

Features HHHHH 
The Netatmo Presence detects in real time whether 

someone's in front of your house. An integrated smart 
floodlight switches on when needed as an added deterrent. 

Design HHHHH  
Constructed from aluminium, the Presence is a tough 

looking piece of kit. The major design drawback is that 
most people will need a professional to fit it, as it will 
either replace an existing external light or need to be 

cabled up as a new one – there’s no mains plug or USB.

Ease of use HHHHH 
There’s consistent upload of full HD video to a 16GB 

microSD card (or to Dropbox or FTP should you wish). 
You can set specific zones for alerts. The app (iOS 9 or 

later) can distinguish between people, cars and animals, 
and you can customise notifications accordingly.

Price HHHHH 
This camera is expensive but, as mentioned, the tech 

is housed in substantial material. As well as the sturdy 
(and weighty at 1kg) casing, there’s also a mount kit and 

wall bracket. You also get an included microSD card.

Features HHHHH 
With a wider degree of view than the Presence, the Nest 
Cam Outdoor also includes a speaker – so, you can use 
Nest’s iOS app to talk to someone outside. There is, 
however, no way to store video footage locally, or a light.

Design HHHHH 
The Nest Cam Outdoor has a nifty appearance, but it 
comes with a standard three-pin UK plug. You can either 
plug it into a socket inside and get the flat cable through 
the wall, place it beside a door, or plug it into a 
weatherproof outdoor socket. 

Ease of use HHHHH 
Nest is owned by Google and the app (iOS 8 or later) is 
simple; you can zoom, enhance, get person alerts, create 
clips and timelapses, and share live streams. 

Price HHHHH 
The camera price is good, but to access your video history 
you’ll need to subscribe to Nest Aware. This costs from 
£8 per month or £80 per year (you get a free month’s 
trial). Watching live video is free, and you can also 
view snapshots from the last three hours. 
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Nest Cam 
Outdoor

Netatmo 
Presence

 £249  FROM Netatmo netatmo.com  FEATURES 
100-degree FOV, 1080p HD video, weatherproof, light, infrared

Security cameras come with 
many extras, such as a floodlight 

or a speaker. Here, we put two 
top cameras to the test…

Security cameras
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Reviewed by tim hardwick

Y
ou may have heard that Apple’s 
latest iPhones don’t have a 
headphone jack. The decision to 

remove it wasn’t exactly widely applauded, 
but we’ve seen Apple do this before – drag 
its customers, not to mention the entire 
technology industry, kicking 
and screaming into the 
future. Events usually 
proceed in the following 
sequence: 1) Apple kills a 
universal standard; 2) Cue 
collective outrage; 3) The 
long-term benefits gradually 
sink in; 4) The industry 
follows suit and the majority 
of users wonder what all the 
fuss was about. 

Granted, we’re not quite there yet with the 
jack, mainly due to its abiding presence on a 
wide range of home audio equipment, plus 

Apple hasn’t quite mustered the ‘courage’ to 
remove it from its notebooks (yet). But that 
hasn’t slowed the embracing of wireless 
technology among audio accessory companies 
eager to cater for smartphone users. Concerns 
about Bluetooth’s ability to deliver decent 

sound quality still get bandied 
around, but the truth is that given 
the choice, many mobile users 
favour the convenience of wireless 
headsets over wired ones, 
knowing that they can always 
enjoy their music without 
compromise using their hi-fi and 
a wired connection at home.

Jack-free judgement
Over the next few pages, we’ll 

be comparing some of the most promising 
cord-free solutions in the headphone market 
and highlighting their unique features, 
relative merits, as well as any drawbacks. 
Notably, we’ll also be seeing how the rival 
brands stack up against AirPods, Apple’s 
own ‘truly wireless’ offering. So join us as we 
step into a jack-free future. Let’s get listening.

How we 
tested
 Each headset was 

tested in various 
typical usage scenarios, 
such as wearing while 
walking or jogging, and 
listening on a noisy 
commute. We also 
tested for everyday 
wear and tear, taking 
into consideration 
weather conditions. 
An iPhone 7 or a 
2015 MacBook Pro was 
the connected audio 
source for the vast 
majority of cases.

Audio accessory companies 
are embracing wireless tech 
to cater for smartphone users

We test five Bluetooth in-ear headphones 
that offer the freedom of wireless listening

Apple 
AIRpODS
RIVAlS TeSTeD

wIReleSS buDS   
  Apple AirPods £159
  Bose SoundSport  
Pulse £149
  Bragi The Headphone 
£145
 KEF Motion One £220
 Jabra Elite Sport £229

Apple CHOICe Group Test
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…or lower?
 Syllable D900 Mini 

This pair of ‘virtually 
wireless’ buds has a 
selection of silicone tips 
and a charging case that 
can hold between four 
and six charges. £40

1  audio quality
Do the earphones provide decent sonic 

reproduction in the lows, mids, and highs? Is 
the bass overpowering or well balanced? Do 
certain genres sound muddy or vibrantly clear? 

2  Earbud fit
Are the earbuds comfortable to wear? 

Don’t forget, the real test comes with prolonged 
use. Also, do they isolate you from the 
commotion of the outside world, or let 
in a pile of sound pollution? 

3  Bluetooth connection
Some wireless devices cause all sorts 

of connectivity issues. Regular drop-outs are 
particularly frustrating if they happen when 
you’re listening to an album or a podcast. 
Solid Bluetooth pairing is a must.

4  Battery life
How long do the earphones last on a 

single charge? Do they take an age to recharge 
from empty? Also, is there any kind of battery 
backup if you’re away from a power outlet?

5  water resistance
A headset’s ability to withstand rain and 

moisture is a crucial feature for outdoor use. 
Also, ears tend to get sweaty during exercise, 
so decent water resistance is important.

6  wearing style
How conspicuous (or inconspicuous) 

are the earpieces during use? Do they look 
weird sticking out of your ears, or would 
onlookers even know you were wearing any? 
If fashion is a big factor in your get-up, it’s 
something to consider.

Everything you need to know 
before getting started

Things to 
consider…

Higher…
 bose QuietControl 
30 wireless 
headphones A wire 
connects the two ear 
buds, but you can set 
your own level of noise 
cancellation. £260
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 The AirPods case is small but holds 
24 hours’ charge for topping up the 
pods, which receive two hours of 
extra juice after 15 minutes inside. A 
Lightning cable is included to charge 
the case. Jabra includes an on-the-go 
charging case with six hours’ backup 
power and a USB charging cable, as 

well as six pairs of eartips and three pairs of earwings.
The Bragi come with three eartip sizes and a carry case, but 

it must be connected to a power source via the supplied USB 
cable to charge the buds. The Bose earphones come with two 
spare pairs of winged tips and a soft case, while a micro-USB 
charging cable attaches directly to one bud. KEF supplies two 
spare tip sizes, an airport adaptor, a soft leather pouch for the 
earbuds and a hard case for the neckband, a micro-USB 
charging cable, and a spare lead for optional wired listening.

 The one-size-fits-all AirPods are 
very comfy. The open-air design 
is feather-light; the balancing stem 
means they ‘hang’ in your ear, but 
don’t fall out, even when exercising. 
The magnetic case design is great, 
too. The magnetised KEF buds 
feel good in-ear, but the corded 

‘neckband’ looks weird and bounces around when running. 
It doesn’t fit in a pocket either.

The Jabra have a solid, discreet look, and the wings mean 
they sit securely in the ear, but pressing the buttons can push 
the buds further into your lugs, which isn’t nice. The Bragi 
buds suffer the same issue, and though they look similar to the 
Jabra, they don’t feel quite as robust. The Bose buds are well 
built and the connecting cord feels strong, but the winged 
earpieces, while comfy, do stick out of your ears a bit. 

 Tonally, the AirPods sound very 
clear and well balanced for open-air 
earphones; the drawback is they do 
virtually nothing to isolate external 
noise. The story’s the reverse with the 
Bragi: their passive noise cancellation 
is impressive, but the audio quality is 
less so – instrumental music sounds 

particularly muddy and the bass can be overpowering. The 
Jabra on the other hand hit the audio quality/noise-cancelling 
sweet spot; music and spoken word sounds decent across the 
board, with clearer lows thanks to the buds’ isolating seal. The 
Bose buds are too ‘open’ to provide any real isolation and the 
volume level feels capped, but the buds offer decent sound in 
the low and mid range, albeit with a touch of harshness in the 
treble. Generally, the KEF sound excellent, especially for 
earbuds – and keep external noise at bay pretty well too. 

 The AirPods auto-connect to an 
iPhone when you open the case, and 
eschew buttons in favour of touch-
sensitive taps – a double tap invokes 
Siri (to change volume or track, for 
example) but the same gesture can 
be configured to pause/play. The 
Bragi on-bud buttons can also be 

used to control Audio Transparency to allow in ambient sound. 
They also pause music when removed and resume playback 
when re-inserted. Apart from onboard playback/volume 
buttons, the Jabra buds also include heart-rate tracking and 
real-time voice coaching, with an app to manage your training. 
The Bose buds have inline volume and playback controls on 
the connecting cable; the KEF set has them integrated into the 
neckband which is not a convenient solution, and you lose 
the controls when you detach the cable for wired listening.

TeST ReSulTS

TeST ReSulTS TeST ReSulTS

TeST ReSulTS

Test 1 Design

Test 3 Sound Test 4 Controls

Test 2 Accessories
How do they look and feel in-ear?

Audio quality versus noise pollution Interacting with your buds

Included tips, cables and cases

Apple AirPods  HHHHH

Bose SoundSport Pulse HHHHH

Bragi The Headphone  HHHHH

KEF Motion One  HHHHH

Jabra Elite Sport HHHHH

Apple AirPods  HHHHH

Bose SoundSport Pulse HHHHH

Bragi The Headphone  HHHHH

KEF Motion One  HHHHH

Jabra Elite Sport HHHHH

Apple AirPods  HHHHH

Bose SoundSport Pulse HHHHH

Bragi The Headphone  HHHHH

KEF Motion One  HHHHH

Jabra Elite Sport HHHHH

Apple AirPods  HHHHH

Bose SoundSport Pulse HHHHH

Bragi The Headphone  HHHHH

KEF Motion One  HHHHH

Jabra Elite Sport HHHHH
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>THE SPECS > Apple AirPods > Bose SoundSport > Bragi The Headphone > KEF Motion One > Jabra Elite Sport

Website apple.com bose.co.uk bragi.com uk.kef.com jabra.co.uk

Price £159 £149 £145 £220 £229

On-the-go charging Yes (24 hr capacity) No No No Yes (6 hr capacity)

Battery Life Up to 5 hours Up to 6 hours Up to 6 hours Up to 10 hours Up to 3 hours

Earbud type Open ear Open ear Isolating in-ear Pivoted open ear Isolating in-ear

Accessories Charging case,  
Lightning cable

2x spare winged tips,  
soft case, USB cable

Charging case, 3x spare  
tips, USB cable

2x spare tips, airport 
adaptor, earbud pouch, 
neckband case and 
charging cable

Charging case, 3x spare  
tips, 3x earwings

Waterpoofing Waterproof (unofficial) Sweat resistant Sweat resistant Water-resistant; IPX5 Water resistant; IP67

 DESign & ComforT HHHHH HHHHH HHHHH HHHHH HHHHH

 ACCESSoriES HHHHH HHHHH HHHHH HHHHH HHHHH

  SounD & iSolATion HHHHH HHHHH HHHHH HHHHH HHHHH

  fEATurES & ConTrolS HHHHH HHHHH HHHHH HHHHH HHHHH

 finAl vErDiCT HHHHH HHHHH HHHHH HHHHH HHHHH
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T
he Bose SoundSport are an all-round 
decent pair of buds, but the sound 
quality isn’t quite what it should be 

at this price, while the Bragi The Headphone 
buds lack flair both materially and in terms 

of audio. The KEF sound fantastic, but 
they’re just too awkward and expensive 
to recommend. In the end, it comes down 
to Apple and Jabra, the only two waterproof 
sets with on-the-go charging cases. 

If you’re looking for fine-sounding 
isolating buds for use during workouts, the 
Jabra Elite Sport headphones have all the 
practical benefits. But with instant pairing, 
balanced sound, and great comfort, the 
AirPods embody Apple at its best.

thE winnEr APPLE AIRPODS
On-the-go charging with great sound and comfort

They don’t isolate 
much, but the AirPods 
are a fine example 
of considered Apple 
design. 

It comes down to the two 
waterproof sets with on- 
the-go charging cases

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

 How 
do they 
compare?

 Apple kicked up a huge 
fuss when it unveiled its 
wireless AirPods, with 
claims flying around 
that they were ugly and 
easy to lose. But it looks 
like they’re the real deal 
here, with a winning 
combination of great 
sound quality and 
classic Apple ease 
of use. We love them.

Graham says…
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Spark
Making email fun again

W
e’re always on 
the lookout for 
the perfect email 

app. Our wish list includes 
support for Gmail aliases, 
smart inboxes, the ability 
to snooze messages for set 
periods and easy, automated 
responses to things we don’t 
have time for. Several email 
apps offer those features, but 
few do it with Spark’s style.

Spark’s good-looking 
design supports the new 
MacBook Pro’s Touch Bar, so 
you can easily sort or snooze 
messages with a tap, and you 
can use Swipe gestures on 
your trackpad to switch 

O
ne thing Windows 
still does better 
than macOS is 

shortcuts that quickly 
snap windows to preset 
areas of the desktop. 
Magnet adds a similar kind 
of feature to your Mac, so you 
can make a window fill a half 
or a quarter of the screen by 
dragging it to a screen edge 
or corner. This version lets 
you snap your windows to 
columnar thirds, too.

A grey overlay indicates 
the area a window should 
fill when you let go of it. If it 
needs more space, an overlay, 
like macOS’s one for volume 

signatures before you send.
New emails are classified 

as personal, notifications or 
newsletters, and you can pin 
important messages so they 
don’t disappear until you’re 
done with them. The Smart 
Inbox shows only important, 
unread messages and pinned 
ones, and you can use the 
Snooze option to hide emails 
for a specified period of time. 
There’s an excellent natural 
language search engine, too.

changes, tells you why. 
Minimum widths required 
by some apps can make 
snapping to a third of the 
screen’s width more useful 
on large desktops than on a 
MacBook, where these apps 
may not fit in the allocated 
space. Unfortunately, there’s 
no way to divide the screen 
into a finer grid, as rival apps 
Divvy and Moom can.

Helpfully though, Magnet 
memorises the previous 

 Free  FROM Readdle, sparkmailapp.com  
 NEEDS OS X 10.11 or later

Our only real complaint 
is that you can’t do much 
about the user interface, like 
changing text sizes. You can 
customise everything else, 
however, including what 
appears in the Smart Inbox, 
how long the Snooze feature 
holds your emails for, and 
what Quick Replies contain.

Spark fits our wish list 
almost perfectly – it really 
takes much of the pain out 
of email. GaRy MaRShall

dimensions of a window 
and restores them when 
you drag a window away 
from its snapped position.

One thing we’d like to 
be refined is the ability to 
fill the desktop by dragging 
toward the screen’s top edge; 
there are only a few rows of 
pixels between triggering 
that or macOS’s shortcut 
into Mission Control, which 
can be a tad frustrating. 
alaN StONEbRiDGE

 Spark puts the fun 
into function; it’s 

very capable and an 
absolute joy to use.

HHHHH
 Excellent email search

 Inflexible interface

VERDICT

 Despite more 
powerful options, this 

is a natural-feeling 
macOS enhancement. 

HHHHH
 Simple and intuitive

 Mission Control clash

VERDICT

Magnet 2
Wonderful window-snapping
 £4.99  FROM CrowdCafé, magnet.crowdcafe.com  
 NEEDS OS X 10.9 or later

Spark’s minimal interface takes cues 
from its excellent iOS companion app.

Magnet displays a grey box to show 
where your window will snap.
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Photolemur
The machines are coming 
(to edit your photos)

 £28.99  FROM Photolemur, photolemur.com  
 needs OS X 10.10.5 or later

P
hotolemur is a photo editor 
with a difference; it uses 
subject recognition and 

applies adjustments automatically. 
Rather than applying specific filters or 
fixes, it identifies features such as faces, 
trees, skies, and landscapes to make 
enhancements that are specific to the subject 
and image. What’s more, it learns as it goes, 
so it should get better the more it’s used.

Photolemur looks at image colours, 
exposure, contrast and white balance, and 
analyses an image on a pixel-by-pixel basis 
before making adjustments to enhance each 
shot individually. If you save an image, it’s 
added to the ‘success’ list, but if you don’t 
it’s added to the ‘blacklist’, thus helping 
the app learn what you like to see.

Automagic adjustments
Photolemur couldn’t be easier to use. Click 
Load Photo to upload an image or a selection 
of images, or drag a collection of files to the 

 Photolemur’s effects 
are often subtle 

and work well in a 
variety of situations. 

HHHHH 
  Easy to use

 Automatic 
adjustments

 Effective results
 Limited control

VERDICT

It works 
especially well 

with dark 
images, 

bringing them 
to life

Reviewed by AnGeLA nICHOLsOn

main screen. It then starts processing the 
images before revealing the first image, with 
a line dividing it into before and after views. 

You can drag the line left or right to reveal 
more or less of the adjusted version. A sliding 
control under the preview lets you alter the 
adjustment on a scale from Realistic to Vivid. 
In most cases we found that the default effect 
was fine, but it’s nice to be able to make the 
occasional tweak to your image.

Varying effects
The only other control is a crop/rotate tool 
accessed via the scissors icon. This can be 
used as a click-and-drag tool, but you can also 
enter a specific angle of rotation if you like. It’s 
also possible to set an aspect ratio for the crop, 
which is useful if you have a specific output 
in mind (such as Facebook or Twitter).

If you upload more than one image in the 
app, all of the unopened images are visible 
in the collapsible browser bar underneath 
the central preview screen. Simply click 
any of the images to see the adjusted version.

Photolemur is extremely easy to use 
and works very well. We applied a variety 
of adjustments – all to varying degrees – to 
a selection of different images, and it handled 
them well in each case. Sometimes the 
automatic adjustment can be very subtle, 
whereas other images may have a more 
dramatic edit applied. It works especially 
well with dull or dark images, bringing 
them to life by brightening them selectively, 
boosting the local contrast to bring out details, 
and also increasing the colour saturation.

For an app that works almost entirely 
automatically, Photolemur’s results are 
impressive. It’s a worthy investment.

Photolemur is particularly effective with dark photos, 
where its changes help bring out details and colour.
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Weather Line
Graphs make everything better!

Y
ou may wonder 
why you’d need 
a third-party 

weather app in the first 
place. As it turns out, there 
are lots of reasons: maybe 
you do a lot of work on your 
iPad – and the default Apple 
Weather app isn’t available 
for the iPad; maybe you want 
something that shows a lot of 
information in a small space. 
Whatever the reason, this 
app has a lot to offer.

The app is really easy to 
use; its sleek interface can 
be read at a glance. Weather 
Line shows information on a 
plain white background for 

D
arkr is a photo 
app designed 
to emulate the 

feeling of working in a real 
darkroom. It hopes this will 
help you take better pictures 
as you learn the darkroom 
process. The app only shoots 
images in black and white, 
but the results are so striking 
that we don’t mind.

Getting to know Darkr is 
a bit intense. There are a few 
different camera options to 
try out, each offering varying 
amounts of control. These 
allow you to manually control 
focus and exposure, as well 
as set the contrast in the 

optimum visibility, and the 
simple, infographic-style 
presentation of data gives 
you everything you need 
to know front and centre.

You’ll be able to see the 
weather throughout your 
day, as well as the projection 
for the week, and there’s a 
smart feature that allows you 
to see averages for specific 
months of the year. Worried 
about precipitation? Check 
out what sort of rainfall-

darkroom. The idea is that 
if you have to slow down 
the process, you’ll be more 
mindful of the photographs 
you’re taking, and thus take 
better photo. We’re inclined 
to agree, were very pleased 
with the results from the 
virtual lab.

We suggest you take the 
time to read the tutorials. 
While they may seem a little 
excessive at first, you will get 
a far better result than if you 

 £3.99  FROM Off Coast, weatherlineapp.com  
 NEEDS iOS 10 or later

related weather you’ll be in 
for over the next hour, from 
clear skies to heavy rain and 
everything else in between.

Weather Line is a great 
improvement over Apple's 
Weather app, especially for 
those who like to plan their 
events according to weather 
projections. Not won over by 
rival apps like Dark Sky? 
Weather Line is a worthy 
alternative, and deserves 
high praise. AMbER NEEly

were to go in completely 
blind. If you forget how 
to use a feature or create 
a particular effect, Darkr 
allows you to go back and 
view the tutorials again.

If you’re looking to 
improve your photography, 
Darkr will help you create 
stunning results while also 
teaching you how to properly 
compose photographs. Who 
says darkroom photos are 
dead? AMbER NEEly

 Both functionally and 
aesthetically pleasing, 

this is a brilliantly 
designed app.

HHHHH
 Clear information

 Weekly charts

VERDICT

 Daunting at first, 
Darkr quickly teaches 

you how to take 
better photographs. 

HHHHH
 Learn photo skills

 Hard without tutorials

VERDICT

Darkr
Relive the days of analogue photos
 Free (£2.99 IAP for Pro version)  FROM Marcus Carlsson,  

miliam.net/support  NEEDS iOS 8.1 or later

Weather watchers can pore over 
monthly and yearly information.

Darkr details how the app 
functions as it works, including 
an explanation of analogue tech.
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Astropad  
Studio
Draw on your Mac 
with an iPad Pro

 £7.49/month, £60.99/year  FROM Astropad, astropad.com 
 needs OS X 10.10 or later, iPad Pro, Apple Pencil

A
stropad is an app that links your 
iPad and Mac together: the iPad 
displays the app you’re running 

on your Mac, and whatever you draw 
with a stylus on your iPad appears on 
your Mac. Last year’s Astropad Standard 
app enabled you to do this with a variety 
of iPad models and any stylus you owned. 
Studio, however, works only with iPad Pro 
and the Apple Pencil. Another important 
difference is that Standard costs a one-off 
payment of £28.99, but Studio is only available 
through a monthly or annual subscription, 
managed through an online account. It’s clear 
that Studio is a professional solution, aimed 
at working artists and designers who expect 
to be drawing for hours every day.

Perfect partners
Setting everything up is a chore, simply 
because of the number of components you’re 
working with. First, create your Astropad 
Studio account and set up your subscription. 
Next, download and install the Astropad app 
on your Mac and the Astropad Studio app on 

 State of the art, but 
you might prefer the 

Standard edition’s 
pricing if you’re a 

more casual sketcher. 

HHHHH 
 Reliable to use
 Fluid gestures

 This version only 
works with iPad Pro

 Subscription-only

VERDICT

It’s aimed at 
working artists 
and designers  
who expect to 

be drawing 
for hours 
every day

Reviewed by RichaRd hill

your iPad Pro. Now run both apps: as long 
as your Mac and your tablet are on the same 
network, they’ll recognise each other and 
your Mac screen will be reproduced on your 
iPad Pro. Of course, all this only needs to be 
done once, but it’s still not exactly fun.

The combination of iPad Pro and Mac 
works well in practice. If you link your iPad 
and Mac with your iPad charging cable, the 
connection between the two screens feels 
instantaneous. If you decouple the iPad and 
link through Wi-Fi instead, you might notice 
a lag between the Mac screen changing and 
the iPad screen updating, depending on the 
speed of your wireless network. But we were 
never excessively bothered by the time lag.

The exclusive use of iPad Pro and Apple 
Pencil means that Astropad Studio has 
several extra features compared with 
Standard. For example, Studio’s Magic 
Gestures feature enables you to combine 
finger tap and Pencil gestures to trigger 
responses, including simulating a ≈-click 
or switching between tools. You’ll have to 
consider if that’s worth the subscription.

You can combine finger touches with Pencil movement 
to trigger shortcuts such as simulating a ≈-click. 

For the best experience, connect your iPad Pro directly 
to your Mac rather than over Wi-Fi.

With Astropad, sketches with your Apple Pencil on your iPad Pro appear on your Mac.
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 Apple debuted the new MacBook Pro 
in October with an OLED strip of app-
specific controls called the Touch Bar. 
This replaces the function keys with a 
row of context-sensitive shortcuts.

The Force Touch trackpad was 
made larger to provide more room for 
gestures, and the keyboard was also 
updated with a second-generation 
version of the butterfly keys found in the 
12-inch MacBook. Memory speed in all 
models except the entry-level 13-inch 
was upgraded to 2133MHz, and all new 
models are thinner and lighter.

The ports saw substantive changes, 
too. You’ll now get either two or four 
Thunderbolt 3 ports (depending on the 
model), which are also compatible with 
USB-C devices, and through which you 
charge the MacBook Pro. The 13-inch 
and 15-inch sizes remain, although the 
entry-level 13-inch lacks a Touch Bar.

 Model  Key specifications  price

13-inch 
2.0GHz  
dual-core  
intel core i5

MEMORY 8GB of 
1866MHz lpddr3
GPu intel iris 540
STORAGE 256GB ssd
Touch Bar no

£1,449

13-inch 
2.9GHz  
quad-core  
intel core i5

MEMORY 8GB of  
2133MHz lpddr3
GPu intel iris 550
STORAGE 256GB ssd
Touch Bar yes

£1,749

15-inch 
2.6GHz  
quad-core  
intel core i7

MEMORY 16GB of 
2133MHz lpddr3
GPu radeon pro 450
STORAGE 256GB ssd
Touch Bar yes

£2,349

 MacBook Pro

 Choose a MacBook Pro

  Inside your buying guide…

 Who’s it for?
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W
elcome to MacFormat’s 
Store Guide, the place to 
go to find out about all the 

Apple kit that matters, whether 
you’re looking for your next iPhone 
or a powerful new desktop Mac. 

We’ve highlighted the model of 
each product that’s ideally suited to 
your needs, whether you’re a recent 

convert or a seasoned Apple user. 
So be sure to check our handy tables 
to see which Mac, iPad or iPhone is 
best for you.

We’ve also highlighted the gold 
standard in audio, storage, cameras, 
and many other categories, helping 
you complement your Mac or iOS 
device with the best accessories.

Your complete guide to the best Apple 
hardware and third-party accessories

EditEd bY AlEx BlAkE 
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 Model  Key specifications  price

21.5-inch 
2.8GHz  
quad-core  
intel core i5

MEMORY 8GB of 1867MHz lpddr3
GRAPhicS intel iris pro Graphics 6200
STORAGE 1tB (5,400rpm) hard drive
DiSPLAY 1920x1080 (ips, srGB gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,249

21.5-inch 
3.1GHz  
quad-core  
intel core i5

MEMORY 8GB of 1867MHz lpddr3
GRAPhicS intel iris pro Graphics 6200
STORAGE 1tB (5,400rpm) hard drive 
DiSPLAY retina 4K (ips, p3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,449

27-inch 
3.3GHz  
quad-core  
intel core i5

MEMORY 8GB of 1867MHz ddr3
GRAPhicS aMd radeon r9 M395
STORAGE 2tB fusion drive 
DiSPLAY retina 5K (ips, p3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£2,249
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UpDATED
OCT 2016

ExpECTED
OCT 2017

HIGH END >
 apple is your life. you prize quality and 

want the best that money can buy.

ENTRY LEVEL >
 you’re just getting started in the world of 

apple and need to know where to begin.

UPGRADER >
 a firm apple user, you’re ready to move 

on and get even more from your tech.

= retina display
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 The baby of Apple’s laptop family, 
the MacBook was updated in early 2016 
with slightly improved specs and a new 
rose Gold colour. Weighing in at just 
0.92kg, it’s Apple’s most lightweight 
laptop but still packs in a 226ppi pixel 
density in its 12-inch retina display.

The MacBook is powered by an Intel 
Core M processor (at 1.1GHz, 1.2GHz or 
1.3GHz), which doesn’t require a fan to 
keep cool, so the MacBook runs silently. 
It also features a Force Touch trackpad, 
which can trigger different responses 
as you apply more pressure. All models 
of the MacBook come with 8GB of 
1866MHz memory, with no option to 
add more, and Intel HD Graphics 515 – 
that’s 25% faster than the previous 
iteration – and there are 256GB or 
512GB flash storage options. There are  
four colour options: Silver, Space Grey, 
Gold, and the new rose Gold.

 Apple’s MacBook Air has felt a bit 
neglected, with its place as the light, 
portable laptop for use on the go having 
been usurped by the 12-inch MacBook.

Still, it has the longest-lasting battery 
of all of Apple’s MacBooks, going strong 
for 12 hours of wireless web browsing. 
It’s also the most affordable MacBook, 
starting at £949. It has 8GB of memory, 
and flash storage includes 128GB, 256GB 
and 512GB options. There’s a 1.6GHz 
processor, configurable to 2.2GHz.

That said, it’s difficult to recommend. 
While it is the cheapest MacBook, we 
think it’s likely this will only be the case 
until prices drop for the MacBook and 
MacBook Pro, at which point Apple will 
probably phase out the Air range.

It also lacks a retina display, and 
feels a bit stuck between Apple’s other 
laptops. This is one MacBook whose time 
is severely limited.

 If you need power – and we mean 
serious power – this is the computer 
for you. Even the entry-level model 
comes with 12GB of memory, a quad-
core 3.7GHz processor, 256GB of speedy 
PCIe flash storage and dual AMD FIrePro 
D300 graphics cards. But with a high 
cost, last being updated in 2013, and 
Thunderbolt 3 in the new MacBook Pro, 
it’s worth waiting for the next version, 
which could finally come out in 2017. 

 A welcome update in 2014 brought a 
£100 price drop to the most affordable 
Mac, but rises in late 2016 added £80 
back on. The mini comes with some 
interesting talking points: the entry-level 
model has a 1.4GHz dual-core Intel Core 
i5 CPU and 4GB of memory, making it 
one of the lowest-spec Macs around, 
with a 500GB hard drive and no display. 
Higher end models come with 1TB 
storage (Fusion Drive and SSD options 
are available), 8GB of memory, a better 
graphics processor and either a 2.6GHz 
or 2.8GHz Intel Core i5 for £679 and 
£949. Those models can be upgraded to 
a Core i7, but there aren’t any quad-core 
options available at the moment. 

 Model  Key specifications  price

12-inch 1.1GHz  
dual-core  
intel core m3

MEMORY 8GB of 
1866MHz lpddr3
GRAPhicS intel Hd 
Graphics 515
STORAGE 256GB ssd

£1,249

12-inch 1.2GHz  
dual-core  
intel core m5

MEMORY 8GB of 
1866MHz lpddr3
GRAPhicS intel Hd 
Graphics 515
STORAGE 512GB ssd

£1,549

12-inch 1.3GHz  
dual-core  
intel core m7

MEMORY 8GB of 
1866MHz lpddr3
GRAPhicS intel Hd 
Graphics 515
STORAGE 512GB ssd

£1,684

 Model  Key specifications  price

13-inch 
1.6GHz  
dual-core  
intel core i5

MEMORY 8GB of 
1600MHz lpddr3
GPu intel Hd 
Graphics 6000
STORAGE 128GB ssd

£949

13-inch 
1.6GHz  
dual-core  
intel core i5

MEMORY 8GB of  
1600MHz lpddr3
GPu intel Hd 
Graphics 6000
STORAGE 512GB ssd

£1,279

13-inch 
2.2GHz  
quad-core  
intel core i5

MEMORY 8GB of  
1600MHz lpddr3
GPu intel Hd 
Graphics 6000
STORAGE 512GB ssd

£1,409

 MacBook  MacBook Air  Mac Pro

 Mac mini
 Choose a MacBook  Choose a MacBook Air
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From 
£2,999

From 
£479

UpDATED
DEC 2013

ExpECTED
2017

UpDATED
ApR 2016

ExpECTED
TBC

UpDATED
ApR 2016

ExpECTED
2017

UpDATED
OCT 2014

ExpECTED
EARly 2017
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In FOCUS:

Apple’s flagship desktop computer  
is a potent mix of beauty and power

E
ver since the famous Bondi 
Blue iMac debuted way back in 
August 1998, Apple’s all-in-

one desktop computer has been setting 
standards in gorgeous design and 
powerful performance. Apple’s spirit of 
innovation was as clear back then as it is 
today – the iMac was the first Macintosh 
to abandon the floppy disk in favour of 
USB ports, and its bright, colourful 
aesthetic set it apart as a playful 
pretender in a world of staid beige boxes.

With the Mac Pro conspicuous by its 
absence in recent Apple keynotes, the 
iMac is the desktop of choice if you’re in 
the market for a powerful, capable 
desktop computer.

And it’s not just a great computer 
on the inside – the iMac looks absolutely 
stunning too. With an amazingly thin 
frame and sleek, minimalist touches, 

it’s vintage Apple design that 
masks its raw power.

Apple last updated the iMac 
range in October 2015, so we’re 
hopeful of seeing some newer 
models making a splash in 2017. 
With better graphics cards and 
faster processors (likely from 
Intel’s Kaby Lake range) in the 
offing, this iMac update could 
represent a significant boost.

5K phenomenon
As with the original iMac, Apple 
is again pushing boundaries with its 
desktop beauty, blessing all of its 27-inch 
models with the one of the best displays 
on the market, with a massive 5K 
(5120x2880) resolution and a wider 
colour gamut than previous models. Add 
in a quad-core Intel Core i5 processor 

(configurable from 3.2GHz up to a 
formidable i7 running at 4.0GHz), 
16GB of memory, a fast and 
capacious Fusion Drive, and 
a powerful AMD radeon r9 
graphics processor, and the large 
iMac is the desktop system to own.  
Be sure to check out our preferred 
configurations on the left to find 
the iMac best suited to your needs.

If you want something that’s 
kinder on the wallet, you won’t 
miss out on a beautiful display – 
the smaller 21.5-inch iMacs are 
available with a brilliant 4K display.

iMac

 Model  Key specifications  price

21.5-inch 
2.8GHz  
quad-core  
intel core i5

MEMORY 8GB of 1867MHz lpddr3
GRAPhicS intel iris pro Graphics 6200
STORAGE 1tB (5,400rpm) hard drive
DiSPLAY 1920x1080 (ips, srGB gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,249

21.5-inch 
3.1GHz  
quad-core  
intel core i5

MEMORY 16GB of 1867MHz lpddr3
GRAPhicS intel iris pro Graphics 6200
STORAGE 1tB (5,400rpm) hard drive 
DiSPLAY retina 4K (ips, p3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,629

27-inch 
4.0GHz  
quad-core  
intel core i7

MEMORY 16GB of 1867MHz ddr3
GRAPhicS aMd radeon r9 M395
STORAGE 2tB fusion drive 
DiSPLAY retina 5K (ips, p3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£2,654
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Display resolution
 These days iMacs come in 1080p, 4K 

and 5K flavours, with each resolution 
being a significant step up from the 
one before it. If you do a lot of photo 
or video editing work, the additional 
screen space afforded by the higher 
resolution will be a real boon.

Four things  
to consider >

UpDATED
OCT 2015

ExpECTED
2017
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2

Processor power
 Every iMac comes with 

an Intel i5 CPU by default, 
configurable to an i7 in 
the 4K and most of the 5K 
models. In short, an i7 will 
perform better in tasks 
such as video encoding 
and, at 4.0GHz, it also has 
a faster clock speed than 
the i5 processors.

3

Do you need a 
discrete GPU?
 All 5K iMacs have a 

dedicated graphics card, 
whereas all other models 
rely on the processor to 
handle graphics. Discrete 
GPUs help with the higher 
resolution, but are also 
better if you want to 
dabble in a bit of gaming. 

4

Storage situation
 Apple offers a baffling 

array of storage options 
with its iMacs. The default 
is a hard drive – large but 
fairly slow. At the other 
end is flash storage, which 
is lightning fast but more 
expensive. Fusion Drives 
are a blend of the two, and 
a good mid-range choice.

 I know it’s expensive, 
but opting for flash 
storage can make a 
world of difference. It’s 
just so much faster than 
a hard drive. Installing 
one is the best way to 
speed up a old Mac, so 
going for one in a new 
iMac is absolutely worth 
it if you can stomach the 
premium Apple tax.

Graham says…
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 The iPhone 7 represents a big update, 
no doubt about it. Apple introduced an 
amazing dual-camera setup in the Plus 
model, which allows for 2x optical zoom 
and on-the-fly depth of field effects.

Both sizes feature the improved A10 
Fusion chip, a redesigned Home button 
with haptic feedback, better battery life, 
Lightning EarPods, and storage ranging 
from 32GB to 256GB.

The iPhone 6s and 6s Plus are still 
available, and are great devices in their 
own right. With 3D Touch giving you a 
greater range of interactions with apps, 
plus a 12MP rear camera with 4K video 
recording and Live Photos, consider 
these if the iPhone 7 is too expensive.

And let’s not forget the iPhone SE. 
Updated with 32GB and 128GB storage 
options, it packs in an A9 chip and M9 
motion coprocessor, and has a bright, 
crisp and compact 4-inch screen.

 Apple shifted the iPad range around in 
March 2017, replacing the iPad Air 2 with 
a 9.7-inch model simply called ‘iPad’. The 
entire Air range has been phased out, 
but the iPad mini 4 is still available.

The 9.7-inch iPad features an A9 CPU 
and M9 motion coprocessor, and comes 
in 32GB and 128GB storage flavours. The 
retina display has been made brighter 
compared to the Air 2, but the new iPad 
is slightly thicker and heavier. It’s also 
got an 8MP rear camera and a 1.2MP 
front-facing camera.

On the software side, the iPad adds 
multitasking features, which are a boon 
for productivity. You can slide a second 
app over the right side of the one you’re 
working in, then dismiss it to get back to 
work. Picture in Picture enables you to 
watch video in a corner of the screen. 
There’s also Split View, which lets you 
work on two apps side by side.

 Model  Key specifications  price

iphone se 
(4-inch 
display)

cAPAciTY: 128GB
PROcESSOR: a9
3D TOuch no
cAMERA 12Mp photos,  
4K video recording

£479

iphone 6s 
(4.7-inch 
display)

cAPAciTY: 128GB
PROcESSOR: a9
3D TOuch yes
cAMERA 12Mp photos,  
4K video recording

£599

iphone 7 
plus  
(5.5-inch 
display)

cAPAciTY: 128GB
PROcESSOR: a10 fusion
3D TOuch yes
cAMERA 12Mp photos 
(dual-camera), 4K video

£819

 Model  Key specifications  price

7.9-inch 
ipad mini 4

cAPAciTY 128GB 
PROcESSOR a8
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOuch iD yes

£419

9.7-inch ipad cAPAciTY 128GB
PROcESSOR a9
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOuch iD yes

£429

12.9-inch 
ipad pro

cAPAciTY 128GB
PROcESSOR a9X
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOuch iD yes

£819

 iPhone  iPad

 Choose an iPhone  Choose an iPad
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 The iPad Pro comes in 9.7-inch and 
12.9-inch sizes, packed with either 32GB, 
128GB or 256GB of storage. All models 
except the 32GB 12.9-inch one are 
available with the option of mobile 
network connectivity. The Pro’s A9X chip 
is the most powerful in any iOS device, 
and it has an impressive four-speaker 
sound system, too. Adding the pressure-
sensitive Apple Pencil makes it an 
accomplished drawing tool.

 The Watch has already 
made Apple the second 
biggest watchmaker in 
the world. Apple is continuing this push 
with Apple Watch Series 2, which sees 
a big update to the Watch. It’s water-
resistant to 50 metres so you can take 
it for a swim, it has a faster dual-core 
processor and GPU, and a brighter 
display. There’s also built-in GPS, which 
can measure routes, pace and distance 
when you’re out on a run or hike without 
needing an iPhone.

Apple also introduced a ceramic 
model to replace the gold Edition, and 
has partnered with nike to create the 
Apple Watch nike+, a range of runner-
oriented models. The Hermès straps 
come in new colours and designs, too.

 iPad Pro

 Watch

From 
£549

From £269

UpDATED
MAR 2017

ExpECTED
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UpDATED
MAR 2016
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UpDATED
SEpT 2016
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lATE 2017

UpDATED
SEpT 2016

ExpECTED
2017
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best buys… Curated picks of third-party kit 

 MOnITOR

 If you’re not fussed 
about 4K but still want 
exceptional image quality, 
this IPS display is truly 
superb. It offers 99% 
coverage of the Adobe 

rGB colour space, 10-bit colour and a 
2560x1440-pixel resolution. It has HDMI 
1.4, DVI and Mini DisplayPort connections, 
and four USB 3.0 ports for expansion.

ViewSonic VP2772 
£650
viewsonic.com

 pRInTER

 This versatile laser 
printer got the nod in 
MF300’s group test. 
Its light design, feature 
list, and impressive print 
quality make it a great 

choice for home office users. AirPrint and 
Wi-Fi connectivity means it plays nice with 
your iOS devices. It’s not great for printing 
photos, but is a winner at everything else.

Brother HL-3150CDW 
£108
brother.co.uk

 UlTRA hD MOnITOR

 We love this display. At 
32 inches diagonally it’s 
big enough to make its  
4K resolution worthwhile, 
and its colour rendering is 
excellent – 100% of srGB, 

93% of Adobe rGB and 97% of the P3 
gamut that Apple’s new MacBook Pro 
uses. It’s big, bold, beautiful and superb 
for productivity and colour work alike.

Philips 328P6VJEB 
£573
philips.co.uk

 ThUnDERBOlT DOCk

 Our MF297 group test 
winner got the nod for its 
beautifully compact form 
and superb menu bar 
tool, which lets you eject 
individual drives as you 

please (something its rivals failed to offer). 
It’s not the most laden with ports, but has 
everything that most people will need, 
and comes in at a great price point.

CalDigit Thunderbolt 
Station 2 £210
caldigit.com/uk

 MACBOOk BAG

 Deceptively spacious 
inside, the Hanson is full 
of well padded pockets 
to protect your precious 
portables. It’s extremely 
comfortable, distributing 

weight well so your shoulders don’t feel 
the strain, and is rather good looking, but 
remains subtle enough not to attract the 
attention of light-fingered thieves.

Knomo Hanson
£90
knomobags.com

 wIRElESS ROUTER

 Being a tri-band router, 
this blows every other 
router we’ve seen out of 
the water when it comes 
to speed. We saw speeds 
of 600Mbps between two 

Macs in the same room. Wi-Fi speeds hit 
up to 3.2Gbps, so its three channels mean 
it’s no slouch there either. It’s costly, but is 
a worthy investment if speed is your thing.

D-Link AC3200  
(DIr-890L) £209
dlink.com

 nETwORk STORAGE

 We know a good nAS 
drive when we see one, 
which is why the 6TB 
TS-251+ won MF302’s 
group test. It’s one of the 

quickest nAS drives we’ve seen lately, with 
transfer rates of over 105MB/sec for large 
files. It has an HDMI port and a remote 
control for watching your media directly 
on your TV set. Four USB ports top it off.

QnAP TS-251+ 6TB
£480
qnap.com

nEw!  Ip CAMERA

 The netatmo Presence 
is an impressive outdoor 
security camera. Set in a 
sturdy housing, it’s built 
to defy the elements. It 
has a built-in floodlight to 

deter intruders, and a 100° field of view 
recorded in 1080p. There’s also an SD 
card included, making it easy to store 
and access your footage.

netatmo Presence
£250
netatmo.com

 ExTERnAl SSD

 Most USB SSDs we’ve 
tested have peaked at 
about 440MB/sec, but 
not this 500GB one; it 
peaked at 496.1MB/sec 
for write speeds and 

534.7MB/sec when reading, very close to 
the claimed 540MB/sec. It lagged a bit in 
our random read test, but for copying big 
files over USB-C, this is the drive to pick.

G-Technology G-Drive 
Slim SSD USB-C £157
g-technology.co.uk
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 pORTABlE BATTERy pACk

Apple iPhone 7 Smart 
Battery Case £89
apple.com/uk

 Despite that silly-looking 
hump on its back, the 
official battery case for 
the iPhone 7 is rather 
impressive. It’s easy to 
fit, the buttons feel great, 

and the soft inner lining protects against 
scratches. It isn’t the largest capacity case, 
yet it has more than enough juice for busy 
days, and the bump is surprisingly comfy.

 macformat.com  @macformat

 wIRElESS SpEAkER

 This airship-inspired 
speaker is certainly 
striking, but it’s more than 
just a looker, with crisp, 
clear treble and refined 
bass output over previous 

Zeppelin models. Support for Bluetooth, 
Spotify Connect and AirPlay makes for 
plenty of connectivity, and dynamic EQ 
ensures controlled bass at all volumes.

Bowers & Wilkins 
Zeppelin Wireless £499
bowers-wilkins.co.uk

 On-EAR hEADphOnES

 We love these wireless 
cans. They’re comfortable 
and lightweight, and their 
long-lasting battery keeps 
them going for 22 hours. 
Sound quality is amazing: 

wide, rich and detailed, with plenty of bass, 
too. The controls take some getting used 
to, but active noise cancellation is superb 
and the EQ allows plenty of customisation.

Sennheiser PXC 550 
Wireless £330
sennheiser.com

 In-EAR hEADphOnES

 Apple’s answer to 
dropping the 3.5mm jack 
is the AirPods; we tested 
them against four rivals 
this issue (see p96) and 
they cleared the pack. 

With instant iPhone pairing, balanced 
sound and a comfortable fit (even when 
exercising), the AirPods are classic Apple. 
They’re even reasonably priced.

Apple AirPods 
£159
apple.com/uk

 MICROphOnE

 Don’t be fooled by this 
mic’s small form factor; it 
punches hugely above its 
weight. Its close-up sound 
is intimate and bassy, and 
brings out the best in any 

voice. no matter whether you’re recording 
an interview, creating a podcast or just 
jamming with your band, its clarity and 
depth makes it easy to recommend.

Blue Microphones 
raspberry £204
bluemic.com

 pORTABlE SpEAkER

 Want a multiroom audio 
system in your home? 
This is your best option, 
hands down. It cleaned 
up in MF309’s group test, 
scoring five stars in every 

test category. From top-notch sound to 
tons of great features, the Zipp is a superb 
choice. It even boasts AirPlay for great 
integration with Macs and iOS devices.

Libratone Zipp
£144
libratone.com

 ACTIOn CAMERA

 We looked at GoPro’s 
new flagship action cam 
this issue, and it coloured 
us impressed. GoPro has 
finally improved its cam’s 
usability, and its a cinch to 

get started with the Hero5 Black. Add in 
superb 4K video quality plus a great range 
of shooting options and you’ve got a 
hugely powerful camera on your hands.

GoPro Hero5 Black  
£349
gopro.com

 BlUETOOTh TRACkER

 The little tracking device 
that won us over in issue 
299 has been made even 
smaller with the new Slim 
model. It’s now far more 
portable than before, and 

easily slips into your wallet as it’s about as 
thick as two credit cards. With a great app 
and a loud alarm, your valuables will be 
kept safer than ever with this little beauty.

Tile Slim
From £23
thetileapp.com

nEw!

 FITnESS SMARTwATCh

 Packed full of tracking 
features for a host of 
sports, and filled with 
genuinely insightful 
metrics, this is a fitness 
smartwatch for nearly 

any occasion. Its battery will last you days, 
perfect for the odd weekend hiking trip. 
With all this, it’s not hard to see why it  
won MF308’s group test. 

Garmin Vivoactive Hr 
£184
garmin.com
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Shot of the month PHOTO STream

Covet that cover! 
b y  g e l _ o u s

mac memOrieS  
MacFormat’s Apple G4 
Cube cover, Sept 2000  

Thanks so much to gel_ous 
for having a bit of a clearout, 

and stumbling across a 
vintage issue of Britain’s 

best-selling Apple magazine! 
This G4 Cube cover dates 

back to September 2000 – the 
millennial year when Apple 

released its “coolest computer 
ever”. A year later? Ahem, 

Apple decided to put the cool 
computer “on ice”…

Share your pics with us using 
the hashtag #MacFormat on 

Instagram. In each issue 
we’ll pick our favourites 
to feature on this page. 

GeT On inSTaGram

 Share your images with us by using the 
hashtag #MacFormat and we’ll print the 
best here in the magazine. While you’re 
there, follow @MacFormat (Twitter) and 
@MacFormatUK (Instagram).

What  
to do! 

  1 Open an Instagram account.
 2  Follow @macFormatUK (of course).

 3 Take a picture of, or with, your Apple kit.
 4 Share it on instagram or Twitter.

 5 Use the hashtag #MacFormat.
 6 Feel the warm glow of an  

appreciative apple community.
 7 See if you made it onto the  
pages of this very magazine!

 8 repeat.
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The history of OS X
We roll back the years on classic Apple tech

next issue On sALe  
Tuesday 9 May 2017

Big cats
 The first public beta 

of Mac OS X had the 
codename Kodiak, 
but the first official 
release of Mac OS X 
10.0 was called 
Cheetah, starting 
a trend for a range 
of big cat names, 
cumulating in OS X 
10.8 Mountain Lion 
in 2012, after which 
Apple switched to 
using Californian 
landmarks.

The Intel 
transition 
 Unknown to most 

Mac users, Mac OS X 
was living a double life 
from its inception, 
running on both 
PowerPC and Intel 
processors, but it 
wasn’t until 2005  
that it was revealed 
that Mac OS X worked 
on both systems and 
Intel Macs were 
released in 2006. It 
was the final change 
that Apple needed to 
spur on widespread 
Mac adoption.

Aqua user 
interface
 Mac OS X’s most 

recognisable feature, 
and most radical 
departure from Mac 
OS 9, was the Aqua 
interface, which 
contained soft, 
water-like elements. 
After the initial splash 
(sorry) at the launch  
of Mac OS X, Aqua got 
toned down and by 
2014’s OS X Yosemite 
started a new trend 
towards a flatter ‘2D’ 
interface that went 
hand-in-hand with  
the latest iOS look  
and feel. 

March 2001

 Mac OS X 10.0 
Cheetah launches, 
succeeding the 
‘Classic’ Mac OS 
introduced in 1984.

september 2001

 Hot on the paws of 
the buggy Cheetah 
came Puma, with 
improved stability. August 2002

 Jaguar saw great 
performance 

increases, and the 
introduction of iChat 

and Address Book. 

October 2003

 Panther ushered in 
the era of brush metal 
interfaces and added 
Mac staples like Safari, 
Exposé and Font Book.

August 2009

 Snow Leopard was 
the first Intel-only 

edition of Mac OS X 
to be released. 

Mac OS X launched with 
a splash, thanks to Aqua.

2006’s MacBook Pro and 
iMac were both Intel Macs.

M ac OS X was, arguably, the product that 
got Steve Jobs back into Apple. Apple 
acquired NeXT Computer in 1997, 

bringing Steve back on board, to get its Unix-
based NeXTSTEP operating system which evolved 
into Mac OS X and replaced the aging Mac OS 9.

July 2011

 Lion saw the arrival 
of Launchpad and 
even more use of 

multitouch gestures.

July 2012

 Mountain Lion 
changed the naming 
convention of OS X, and 
was the final big cat 
version to be released. 
The OS featured more 
iCloud integration. 

April 2005

 Tiger had more new 
features than most 
Mac OS X releases, 
including Spotlight, 

Dashboard and 
Smart Folders.

October 2007

 Leopard added even 
more new features 
than Tiger, including 
Time Machine, Spaces 
and support for 64-bit 
applications.

October 2013

 Mavericks was 
Apple’s first free OS 

upgrade, adding 
Maps and iBooks. 

June 2015

 El Capitan was a 
smaller update with 
few visible changes. 

september 2016

 In 2016 Apple 
dropped the OS X 

name altogether with 
the release of today’s 

macOS 10.12 Sierra.

October 2014

Yosemite matched the 
iOS 7 flat design and 
introduced Handoff. 
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